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Using This Book

Audience

The features of SAS Visual Analytics are designed for the following users:

n Persons needing to explore data in support of ad hoc business questions.

n Persons responsible for designing and creating reports for their enterprise. 

n Persons responsible for analyzing report data and making decisions based on that 
data.

Persons responsible for managing SAS servers and managing the SAS Visual Analytics 
environment should refer to SAS Visual Analytics: Administration Guide.

Prerequisites

Here are the prerequisites for using SAS Visual Analytics:

n A user ID and password for logging on to SAS Visual Analytics.

n A supported web browser installed on your desktop client.

n A supported version of the Adobe Flash player installed on your desktop client.

n Access to data sources that can be used to obtain data for exploration or reports.

If you have questions about whether you are ready to use SAS Visual Analytics, contact 
your system administrator.
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Whatʼs New

What’s New in SAS Visual Analytics 6.2

SAS Visual Analytics Home Page

New and enhanced features on the home page include:

n SAS tables appear in the My Content and Other Content sections.

n You can refine your search results to include additional SAS types (for example, 
tables).

n The Manage Content section has been enhanced. For example, you can add 
collections or specify which collections you want to see. A collection is a virtual file 
system, which enables users to group content such as explorations, reports, and 
tables without actually moving them.

n The object inspector has been enhanced. For example, you can see collections.

n If you have the Theme Designer for Flex: Administration role in SAS 
Management Console, then you can access the SAS Theme Designer for Flex from 
the home page.
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SAS Visual Data Builder

New and enhanced features in SAS Visual Data Builder include:

Enhancements to Working with Data

n You can use in-memory tables from SAS LASR Analytic Server as input tables for a 
query.

n You can join tables from more than one library.

n You can import a SAS Information Map into a query. Maps that are based on tables 
are supported. Maps based on OLAP cubes are not supported.

n For deployments that use Greenplum Data Computing Appliance, the generated 
SAS statements use the HPDS2 procedure to distribute data for staging tables. This 
enhancement is an efficient method for distributing data.

Enhancements to Importing Data

The import local data feature is enhanced as follows:

n You can preview a spreadsheet or delimited file before you import it.

n When you import a delimited file, you can specify the encoding to use for reading the 
file.

n You can import a SAS data set from your desktop.

n You can import files up to 2 GB in size. The application reads the data in blocks and 
transfers them to the server.

Note: Support for creating a single output table when importing multiple worksheets 
from a workbook is no longer available. You can import multiple worksheets during a 
single import: each worksheet is imported into a separate table. You can perform 
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additional data preparation of these tables using select, join, and append functions after 
the tables are loaded.

You can import remote data by browsing for SAS data sets that are available to your 
SAS Application Server and load them to SAS LASR Analytic Server.

Enhancements to Customizing Code

n You can add preprocessing and postprocessing SAS statements to your query.

n You can view all the code for the query, including the SQL procedure statements 
and LIBNAME statements.

n You can customize the code for the entire query when you unlock the code. In the 
previous release, you could modify the SELECT statement only.

SAS Visual Analytics Explorer

Enhancement for Visualizations and 
Analytics

n The new Decision Tree visualization type enables you to perform decision tree 
analysis.

n Forecasting has been enhanced to support underlying factors and scenario analysis.

n New advanced filters enable you to create filters that use multiple data items.

n You can create ranks to select the top (greatest) and bottom (least) aggregated 
values for a category.

n The new Manage Visualizations window enables you to arrange, filter, and sort your 
visualizations.

n Crosstab visualizations now support an indented display mode.

Enhancement for Visualizations and Analytics xvii



n Correlation matrix visualizations now enable you to compare two sets of measures 
and sort by the correlation value.

n The geo map visualization has a new colored regions overlay.

n You can customize data ranges and color gradients for some visualization types. 
Customized data ranges can be shared between visualizations.

n For visualizations that contain hierarchy data, you can click values on the 
visualization axis to drill down the hierarchy.

Enhancements for Data Management

n New data source filters enable you to subset the entire data source for the 
exploration.

n You can calculate measures by using aggregated data.

n You can sort and group your data items in the Data pane.

n You can create Percent of Total data items to display the percentage of the total 
value for a measure.

n You can derive hierarchies from date, time, or datetime data items.

n Changing the data source for an exploration has been enhanced. The new data 
source is no longer required to include all of the same data items as the current data 
source.

SAS Visual Analytics Designer

Enhanced User Interface for the Designer

n The left pane has four tabs (Objects, Data, Imports, and Shared Rules) at the 
same level. (Previously, the Data tab appeared below the Objects tab.) By default, 
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only the Objects and Data tabs appear. To display the Imports and Shared Rules 
tabs, click  after the last tab name or use the View menu.

n The Data tab handles tables with a large number of data items. You can sort and 
group data items on the Data tab.

n The Properties tab (in the right pane) for all of the report objects has been 
enhanced. For example, the alignment has been updated to improve readability. 
There is more consistency between the property names in the designer and in the 
explorer.

n The user interface for display rules has been enhanced.

n You can change report themes.

n If you have the Theme Designer for Flex: Administration role in SAS 
Management Console, then you can access the SAS Theme Designer for Flex from 
the Styles tab.

Enhanced Report Objects

n List tables have been enhanced. For example, you can change the text alignment for 
column headings, change the text and background color for totals, hide vertical and 
horizontal lines, and add and remove alternating row colors. You can remove 
column headings. You can drag and drop multiple data items onto list tables.

n Crosstabs have been enhanced. For example, you can change the text and 
background color for subtotals. You can change font styles and add a percentage of 
subtotals.

n Report objects can be duplicated using the pop-up menu. All properties, filters, 
ranks, display rules, roles, and styles are copied. However, interactions are not 
copied.

n A new geo region map (also known as a choropleth map) is available.

n Geo bubble maps and geo region maps retain zoom and pan settings.
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n Objects in vertical containers have a height property and objects in horizontal 
containers have a width property.

n Graphs have a hyperlink axis when a hierarchical data item is used. When you click 
on the hyperlinked label, you drill down on the graph, just as if you had double-
clicked the label.

n For time series report objects, you can specify units of time.

n Gauges (KPIs) support high cardinality.

n The slider gauge supports dates (which are continuous) and numeric categories.

n Controls have been enhanced. The drop-down list, list, button bar, and text input 
controls support a brush interaction and sorting.

n You can add and remove data items by right-clicking on a graph.

n You can include or exclude missing values when filtering based on discrete values 
using a range slider control.

Enhanced Imported Report Objects

n You can change the data source for report objects that are imported from the 
explorer.

n You can import heat maps, box plots, and forecasts from the explorer.

Enhanced Data Items

n You can create a new aggregated calculated item for tables and graphs.

n You can create ranks to select the top (greatest) or bottom (least) values for 
category values. You can choose whether other values or ties are included.

n You can rank based on the frequency data item.

n Advanced filters enable you to filter using multiple data items.
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n You can sort on formatted data. You can sort on unformatted data only when the 
user-defined formats that have an underlying numeric value.

n You can calculate measures by using aggregated data.

n You can create Percent of Total data items to display the percentage of the total 
value for a measure.

n You can derive hierarchies from date, time, or datetime data items.

Enhanced Linking

n You can create a link from a report object, text, or image to another report.

n You can create links to different sections in a report.

n You can specify a link to an external URL from report objects (including text objects).

SAS Visual Analytics Viewer

New and enhanced features in SAS Visual Analytics Viewer include:

n You can view a link to a specific section in a target report. You can also view links 
from a report object, text, or image to another report.

n Comments can be added for individual objects in a report.

n If you have the Create Reports capability, then you can use the Edit Report button 
to open SAS Visual Analytics Designer and edit the current report.

n Prompt values can be changed for prompted stored processes.
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SAS Visual Analytics Administration

SAS Visual Analytics Administrator

n You can register tables.

n You can set permissions on libraries.

n You can delete tables from metadata.

n You can delete physical tables from HDFS (if you are using the SAS High-
Performance Deployment of Hadoop).

n You can use an interactive editor to create permission conditions for row-level 
security.

n You can manage mobile devices either by blacklisting or whitelisting.

n You can more efficiently stage and load data, because the user interfaces for these 
tasks are simplified and provide pre-populated values where possible.

n A gauge that indicates available memory in a distributed SAS LASR Analytic Server 
is visible in multiple locations in the user interface.

n You can add new metadata folders from certain secondary windows (such as the 
Choose a Location window).

n You can access concise instructions for selected tasks by selecting Help  How to 
from the main menu.

Other Enhancements in Administration

n You can make it easy for registered users to use their own data in SAS Visual 
Analytics. With the new automated data loading feature, users place tables in a 
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designated host folder that is periodically scanned by a scheduled task. When the 
task discovers a table that is not already loaded, it loads that table to memory.

n A new predefined server (the Public LASR Analytic Server) and library (the Visual 
Analytics Public LASR library) provide broad access and support the new automated 
data loading feature. 

n In the Search Interface to SAS Content, log4j logging is enabled for the index 
loading script (loadindex.sh).

n In the metadata definition for a SAS LASR Analytic Server, you can set memory-
based constraints on the availability of certain tasks. This causes a distributed server 
to reject certain requests (for example, loading additional data) when the server’s 
available physical memory falls below a certain level.

n To simplify metadata-layer permission requirements, the Create permission is no 
longer used. Instead, the Write permission controls actions that were previously 
controlled by the Create permission.

n You can promote SAS Visual Analytics objects from one 6.2 environment to another 
6.2 environment. You can promote objects from one metadata server to another 
metadata server or within a metadata server. 

n Changes and enhancements to capabilities and roles include the following: 

o A new suite-level capability, Create Collections, enables users to create groups 
of bookmarks that point to objects such as reports and explorations.

o A new administrative capability, Monitor LASR Analytic Server, controls the 
availability of the Resource Monitor and Process Monitor tabs.

o The Email capability and the Print as PDF capability are now at the suite level.

o The View Comments capability (now named Add or View Comments) provides 
the ability to add comments. In the initial configuration, all of the SAS Visual 
Analytics roles provide this capability.

o The Require Passcode on Mobile Devices capability is now supported.

o The Manage Custom Lists capability is now named Customize Hub.
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Documentation Enhancements

With the exception of what’s new and accessibility information, content about SAS 
Visual Analytics Administrator has been removed from this book. SAS Visual Analytics 
Administrator functionality is now documented in the SAS Visual Analytics: 
Administration Guide. Cross-references are provided.
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Accessibility

Accessibility Features of SAS Visual 
Analytics

Overview

SAS Visual Analytics has been tested with assistive technology tools. It includes 
accessibility and compatibility features that improve the usability of the product for users 
with disabilities. (Some accessibility issues remain and are noted below.) These 
features are related to accessibility standards for electronic information technology that 
were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act 
of 1973 (2008 draft proposal initiative update). Applications are also tested against Web 
Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative 
(WAI) of the Worldwide Web Consortium (W3C). For detailed information about the 
accessibility of this product, send e-mail to accessibility@sas.com or call SAS 
Technical Support.

Documentation Format

Please contact accessibility@sas.com if you need this document in an alternative 
digital format.
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Landmarks

Landmarks are references to the primary areas of an application’s user interface. They 
provide a quick and easy way for keyboard users to navigate to these areas of the 
application.

To access the list of landmarks that are available for a specific context, press Ctrl+F6 to 
open the Landmarks window. Use the arrow keys to select a landmark, and then press 
Enter to navigate to that area of the application.

User Interface Layout

SAS Visual Analytics contains the following interfaces:

n The SAS Visual Analytics home page contains three main sections:

o The top of the home page contains the menu bar, which contains menus, a 
Search field, and a Log Off button.

o The center of the home page contains the workspace. In the workspace, you can 
create content, view your content, or view content created by other users.

o The right side of the home page contains a Common Actions pane, which 
provides an alternate way to create reports, explore data, and manage your 
environment or favorites. The Links pane links you to the introductory video for 
SAS Visual Analytics or to other pages that you have bookmarked. The SAS 
Resources pane links you to resources on the SAS website and to social media.

n SAS Visual Data Builder enables you to perform analytic data preparation 
operations. The application window contains four main sections:

o The top of the window contains the application name and an application bar that 
includes a menu bar and a Log Off button.
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o The left side of the window contains a collapsible navigation pane. This pane 
contains a view of the SAS Folders tree. You can navigate the tree to select a 
table (one table at a time) for use in preparing data for analysis.

o The center of the window (the workspace) contains tabs that you use for 
designing queries. Each query is designed on a tab.

o The bottom of the window contains a series of tabs that you use for creating 
calculated columns and for filtering data.

o The right side of the window contains a Properties tab that you use for 
managing the properties of queries and tables. The information is dynamic and 
shows the properties of the item that is selected in the workspace.

n SAS Visual Analytics Explorer enables you to explore data. The application window 
contains four main sections:

o The top of the window contains the Home bar, the menu bar, and the toolbar. 
The Home bar contains a Home button that enables you to return to the SAS 
Visual Analytics home page. The menu bar contains menus and a Log Off 
button. The toolbar contains icons that enable you to manage your explorations 
and visualizations.

o The left side of the window contains the data pane. The data pane contains all of 
the data items in your visual exploration. A table at the bottom of the data pane 
enables you to modify the properties of the data item that is currently selected.

o The center of the window (the workspace) contains the visualizations (charts, 
tables, histograms, and maps) for your visual exploration. A dock bar at the 
bottom of the workspace enables you to manage your visualizations.

o The right side of the window contains the Roles, Filters, Ranks, Properties, and 
Comments tabs. The Roles tab enables you to manage data roles for the 
current visualization. The Filters tab enables you to create filters to subset your 
data. The Ranks tab enables you to create ranks to select data based on the 
greatest or least aggregated values for a category. The Properties tab enables 
you to manage properties for the current visualization. The Comments tab 
enables you to view and create comments for the current visualization.

User Interface Layout xxvii



n SAS Visual Analytics Designer provides a framework for working with data and 
reports. The application window contains four main sections:

o The top of the window contains the Home bar and the menu bar. The Home bar 
contains a Home button that enables you to return to the SAS Visual Analytics 
home page. The menu bar contains menus and a Log Off button.

o The left side of the window contains the Objects, Data, Imports, and Shared 
Rules tabs. These tabs enable you to select report objects, to select data 
sources, or to import other reports or report objects. A table at the bottom of the 
Data tab enables you to modify the properties of the data item that is currently 
selected. The Shared Rules tab enables you to create a new display rule for a 
gauge, which is used by other gauges to designate intervals and colors for 
ranges.

o The center of the window is the canvas on which you design reports. Above the 
canvas, there is an area where you can drop a filter control and a category data 
item to create section prompts.

o The right side of the window contains a pane with multiple tabs. The Properties 
tab enables you to manage the properties for the currently selected report object. 
The Styles tab enables you to specify styles for the data, frame, and text, and to 
specify colors for the data. The Display Rules tab enables you to populate or 
add intervals for the report object that is currently selected in the canvas. The 
Comments tab enables you to view and create comments for the report after you 
save it. The Filters tab enables you to create filters for the selected report object. 
The Ranks tab enables you to add rankings to report objects. The Interactions 
tab enables you to create or update filter or brush interactions for the report 
objects in a section. The Roles tab enables you to manage data role 
assignments for the selected report object.

To customize the application window and its features, select File  Preferences. On 
the SAS Visual Analytics home page, click either  or Edit Preferences to open the 
Preferences window. For more information about the layout and features of SAS Visual 
Analytics, see “Your First Look at the SAS Visual Analytics Home Page” on page 
12.
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Themes

An application’s theme is the collection of colors, graphics, and fonts that appear in the 
application. The following themes are provided with this application: SAS Corporate, 
SAS Blue Steel, SAS Light, and SAS Dark. To change the theme for the application, 
select File  Preferences and go to the Global Preferences page. On the SAS Visual 
Analytics home page, click either  or Edit Preferences to open the Preferences 
window. For more information about the layout and features of SAS Visual Analytics, 
see “Your First Look at the SAS Visual Analytics Home Page” on page 12.

You can use keyboard shortcuts to magnify the contents of the browser window or to 
invert the application colors. For more information, see “Keyboard Shortcuts” on page 
xxix.

Note: If you have special requirements for your themes, then contact your system 
administrator or visual designer about using the SAS Theme Designer for Flex 
application to build custom themes. SAS Theme Designer for Flex is installed with SAS 
themes. For more information about this tool, see SAS Theme Designer for Flex: User's 
Guide.

Custom report themes are now automatically created when a coordinating custom 
application theme is created in SAS Theme Designer for Flex. These custom report 
themes can then be used in SAS Visual Analytics reports.

Keyboard Shortcuts

The following table contains the keyboard shortcuts for the application. In the user 
interface, the shortcuts are displayed within parentheses in tooltips and menu labels.

Note: Some application-level keyboard shortcuts do not work when you first open an 
application. When that happens, press Tab to place the focus on the application, and 
then try the keyboard shortcut again.

Note: When you use a keyboard shortcut to activate a button, first give the focus to the 
field or section that the button is associated with before you use the keyboard shortcut. 
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For example, if a table has an associated  button, you must first move the focus to the 
table before you press Ctrl+?.

Keyboard Shortcuts

Task Keyboard Shortcut

Open a Help pop-up window from the 
button.

Ctrl+?
Note: This shortcut does not work on some 
keyboards (for example, the Italian keyboard).

Zoom in. Ctrl+plus sign

Zoom out. Ctrl+minus sign

Reset the zoom state. Ctrl+0

Maximize view (collapses the category pane 
and the tile pane, and hides the status bar 
and the application bar, which includes the 
menu bar and the workspace bar).
or
Exit maximized view (expands the category 
pane and the tile pane, and shows the status 
bar and the application bar).

Ctrl+Alt+Shift+M
Note: This keyboard shortcut does not work 
when the focus is on the workspace bar.

Open a pop-up menu. Shift+F9 (if a menu is available in that 
context)
Note: If you use Shift+F9 to display the pop-
up menu, then it is always displayed in the 
top left corner of the user interface control 
that you are using.

Open the Landmarks window. Ctrl+F6

Temporarily invert or revert application colors 
(for the current session only).
Note: You can set the Invert application 
colors preference in the Preferences window 
if you want the color change to persist across 
sessions.

Ctrl+~

xxx Accessibility / Accessibility Features



Task Keyboard Shortcut

Rename the selected tab. Make sure that focus is on the tab. Press F2 
and specify the new name. To commit your 
changes, press Enter. To cancel your 
changes, press Esc.

Close the selected tab. Make sure that focus is on the tab, and then 
press Delete.
Note: Some tabs cannot be closed.

Switch in and out of Edit mode for a table cell. To enter Edit mode, select a cell and press 
F2.
To exit Edit mode, press Esc.

Navigate between table headings and table 
content.

For a two-dimensional table, first make sure 
that focus is on the table and that you are not 
in Edit mode. Press Ctrl+F8 to switch focus 
between column headings and table cells. 
Use the arrow keys to navigate from heading 
to heading.
For a multidimensional table, first make sure 
that focus is on a table cell and that you are 
not in Edit mode. Press Ctrl+F8 to switch 
focus between column headings, row 
headings, and table cells. Use the arrow keys 
to navigate from heading to heading.

Navigate the content rows of a table. When table cells are in Edit mode:
n Press Tab and Shift+Tab to move from cell 

to cell horizontally across columns.
n Press Enter and Shift+Enter to move from 

cell to cell vertically across rows.
When table cells are not in Edit mode, use 
the arrow keys to move from cell to cell.
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Task Keyboard Shortcut

Sort columns in a table. To sort a single column, navigate to the 
column heading of the column that you want 
to sort. Press spacebar to sort the column.
To sort additional columns, navigate to the 
column heading of each additional column 
that you want to sort. Press Ctrl+spacebar.

Exceptions to Accessibility Standards

Exceptions to accessibility standards are documented in the following table.

Note: The JAWS issues occur when JAWS is used with Internet Explorer. Other 
browsers were not tested with JAWS, unless noted.

Exceptions to Accessibility Standards

Accessibility Issue Workaround

Sometimes, you cannot use the keyboard to 
sequentially navigate through the interface 
and move the focus in a meaningful order.

No workaround is available.

The SAS High Contrast theme has a few 
unresolved focus and contrast issues.

For contrast issues, select a different theme 
and then press Ctrl+~ to invert the colors.

The SAS Light theme and SAS Dark theme 
might not provide sufficient color contrast for 
some users.

Use the SAS Corporate theme or the SAS 
High Contrast theme.

JAWS cannot read some of the controls in the 
application, such as images, icons, and 
buttons.

No workaround is available.

JAWS cannot read the tooltips of items in 
trees, lists, and menus.

No workaround is available.
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Accessibility Issue Workaround

JAWS refers to table controls as list boxes. When JAWS reports that a control is a list 
box, keep in mind that it might actually be a 
table.

JAWS can sometimes read controls that have 
been disabled.

No workaround is available.

Sometimes, JAWS does not correctly work 
with the controls in the Preferences window.

While you are in Virtual PC cursor mode, 
traverse the entire window to familiarize 
yourself with its contents before you change 
any of the settings. You might need to switch 
between Forms mode and Virtual PC cursor 
mode to access all of the controls.

JAWS does not correctly read the states in a 
tri-state check box tree if JAWS is not in 
Forms mode.

Disable the JAWS Virtual PC cursor when 
you work with the check box tree. Tab to the 
tree, and press Insert+Z to disable the Virtual 
PC cursor. When you finish interacting with 
the tree, press Insert+Z to re-enable the 
Virtual PC cursor.

The keyboard shortcuts that are used to 
interact with editable tables can conflict with 
keyboard shortcuts for the JAWS forms 
mode.

As a best practice, disable the JAWS Virtual 
PC cursor when you work with tables. Tab to 
the table, and press Insert+Z to disable the 
Virtual PC cursor. When you finish interacting 
with the table, press Insert+Z to re-enable the 
Virtual PC cursor.

JAWS cannot read two-column property 
tables.

No workaround is available.
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Accessibility Issue Workaround

JAWS does not correctly read the information 
in a table:
n JAWS cannot read the column headings of 

a table.
n When table cells are not editable and the 

focus is on the body of the table, JAWS 
reads an entire row at a time instead of cell 
by cell.

n When table cells are editable, and the 
focus is on the body of the table, JAWS 
reads only the first row of the table. If you 
use the arrow keys to select a cell or row, 
then JAWS does not read anything. If you 
press Enter to edit a cell, then JAWS reads 
the row that contains the edited cell.

No workaround is available.

When you are in a table cell, if you press 
Home, End, Page Up, or Page Down, the 
selected cell will change to be one in the first 
column of the currently displayed columns for 
the table.

Use the arrow keys to navigate through the 
cells of the table.

You cannot use the keyboard to scroll to the 
left and the right in some tables.

No workaround is available.

You cannot use the keyboard to activate the 
links within how-to topics and Help pop-up 
windows.

Use the Help menu to access the linked 
documents.

You cannot use Shift+F10 to open a pop-up 
menu.

Use Shift+F9 to open pop-up menus that are 
created for the SAS application. The generic 
menu that is provided by the Flash player 
cannot be opened by Shift+F9.
Note: If you press Shift+F10 in Internet 
Explorer and no context menu is available, 
the browser will move the focus to the File 
menu for the browser tab. To return focus to 
the application area of the browser window, 
press Esc.
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Accessibility Issue Workaround

You cannot use the keyboard to access the 
close (x) button that is in the top right corner 
of a tab.

Make sure that the focus is on the tab, and 
then press Delete to close the tab.

You cannot use the keyboard to access the 
close (x) button that is in the top right corner 
of a tile in the tile pane.

Make sure that the focus is on the tile, and 
then press Delete to close the tile. (The object 
that is displayed in the tile is not deleted.)

Visual focus for the menu bar is indicated with 
an outline around the entire menu bar instead 
of around individual menus.

To select individual menus, use the left or 
right arrow key.

Sometimes, you cannot use the Tab key to 
move the focus to the application area of a 
web browser (that is, the part of the browser 
window that is controlled by the Flash player).

The following workaround is applicable to 
Internet Explorer only.
Press Ctrl+number, where number is the 
ordinal position of the application’s tab in the 
set of tabs that are open in your browser 
window. Then press Tab to move the focus 
into the application area.

You cannot use the Tab key to move the 
focus outside of a code or expression editor. 
Pressing Tab within the editor only inserts 
tabs.

For Internet Explorer, press Shift+F10 and 
then press Esc to move the focus outside of 
the editor.
For Firefox, press Alt+Tab to switch to 
another application. When you switch back, 
the focus will be outside of the editor.

You cannot use Ctrl+Alt+Shift+M to minimize 
or maximize the view if the focus is on the 
workspace bar.

No workaround is available.

If you tab to an item that is partially or entirely 
off-screen, the item is not automatically 
scrolled back into view.

Sometimes, you can use the arrow keys or 
the Tab key to scroll the item back into view.

When you use the Ctrl+plus sign keyboard 
shortcut to zoom in, some portions of the 
interface can become hidden from view.

Use the keyboard to access the hidden parts 
of the interface.
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Accessibility Issue Workaround

The Ctrl+plus sign and Ctrl+minus sign 
keyboard shortcuts for zooming in and out do 
not work on some menus unless the menus 
are first opened.

Open the menu before you use the keyboard 
shortcut.

The Ctrl+plus sign and Ctrl+minus sign 
keyboard shortcuts for zooming in and out do 
not work on all elements in the application 
window (for example, tooltips and button 
labels).

No workaround is available.

If you maximize a tile in the Home workspace 
and then use the Tab key to navigate, the 
focus appears to be lost after you tab away 
from the Log Off button.

After you maximize the tile, press the Tab key 
10 to 25 times, and eventually, the focus will 
return to the maximized tile.

You cannot use the keyboard to navigate in 
the Layout section because it is a Read-Only 
interface that is used for the visual verification 
of the elements that have been created.

Use the test button that is in the Layout 
section to preview your elements in a 
secondary window. The items that are 
displayed in the secondary window are 
identical to the items that are displayed in the 
Layout section, but unlike the items in the 
Read-Only Layout section, you can interact 
with the items in the secondary window.
Note: After the application opens the 
secondary window, press Tab to place the 
focus in the window.

JAWS cannot read the labels for the Red, 
Green, and Blue fields in the Custom Colors 
window.

No workaround is available.

You cannot use the keyboard to access the 
color blocks in the Recently used section of 
the color selection control.

No workaround is available.

JAWS does not explain how to open a drop-
down menu or drop-down list.

Press Ctrl+down arrow to open the control.
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Accessibility Issue Workaround

When JAWS reads the control names in a 
breadcrumb, it does not distinguish between 
the breadcrumb buttons that contain drop-
down menus and those that do not.

Check for a drop-down menu by pressing Ctrl
+down arrow on a breadcrumb button. A 
drop-down menu will open if one exists for 
that button.

When you use the down arrow to scroll 
through the items in a "combo box," any item 
that opens a secondary window will do so 
when you arrow down to it and will prevent 
you from navigating to items that are farther 
down in the drop-down list.

Press Ctrl+down arrow to scroll through the 
items in the drop-down list and then press 
Enter or Tab to make a selection.

When you add a date value to the predefined 
list for a date element, you cannot use the 
keyboard to access the date-selection button 
in the table cells in the Customize Data 
window for the predefined list.

Enter the date value in the field that is next to 
the date-selection button.

JAWS cannot read the contents of a tree 
table (that is, a table that contains a tree) 
unless the table is in Edit mode.

Make sure that the focus is in the tree table, 
and press F2 to enter Edit mode.

JAWS cannot read the content selection tree. No workaround is available.

Sometimes, after you close a tab to hide it 
from view, you can still use the keyboard to 
access the contents of the tab.

No workaround is available.

Accessibility Workarounds for SAS 
Visual Analytics Explorer

Exceptions to accessibility standards for SAS Visual Analytics Explorer (the explorer) 
are documented in the following table:
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Exceptions to Accessibility Standards for the Explorer

Accessibility Issue Workaround

JAWS cannot read the diagram in the 
decision tree visualization.

No workaround is available.

JAWS cannot read values for a visual filter in 
the Filters tab.

No workaround is available.

Accessibility Workarounds for SAS 
Visual Analytics Designer

Exceptions to accessibility standards for SAS Visual Analytics Designer (the designer) 
are documented in the following table:

Exceptions to Accessibility Standards for the Designer

Accessibility Issue Workaround

You cannot access the list of tabs in the right 
panel of the designer using only the 
keyboard.

Use the View menu to give focus to the tabs 
in the right panel. You can select the 
Comments, Display Rules, Filters, 
Interactions, Properties, Ranks, Rules, or 
Styles tab.

When JAWS is running, the Page Up and 
Page Down keys do not switch tabs properly.

No workaround is available.

The drop-down lists in the designer do not 
have labels. They are read by the screen 
reader as “combo box.”

No workaround is available.

JAWS does not read the labels for collapse 
and expand panes correctly. They are read 
by the screen reader as “splitter button zero.”

Use the View menu to select either Maximize 
View or Exit Maximized View.
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Accessibility Issue Workaround

You cannot re-position a report object on the 
canvas in the tiled report layout.

Use the precision report layout and then use 
the Properties tab to adjust the size and 
position of the report objects. Under the Size 
and Position heading, you can adjust the 
Left, Top, Depth, Width, and Height 
properties.

JAWS cannot read the diagram for creating 
filter and brush interactions in the interactions 
view.

No workaround is available.

Accessibility Workarounds for SAS 
Visual Analytics Viewer

Exceptions to accessibility standards for SAS Visual Analytics Viewer (the viewer) are 
documented in the following table:

Exceptions to Accessibility Standards for the Viewer

Accessibility Issue Workaround

You cannot access links in reports using only 
the keyboard.

No workaround is available.

Accessibility Workarounds for SAS 
Visual Data Builder

Exceptions to accessibility standards for SAS Visual Data Builder (the data builder) are 
documented in the following table:

Accessibility Workarounds for SAS Visual Data Builder xxxix



Exceptions to Accessibility Standards for the Data Builder

Accessibility Issue Workaround

When you use the keyboard to view the table 
properties from the Properties tab, the 
application loses focus and you can no longer 
navigate using the keyboard only.

No workaround is available.

When you use the keyboard to select a check 
box on the Properties tab, the application 
loses focus and you can no longer navigate 
using the keyboard only.

No workaround is available.

When the application prompts you for a user 
ID and password to access data, you cannot 
navigate to the window using the keyboard 
only.

No workaround is available.

When you schedule a query, and tab to the 
Select one or more triggers for this query 
radio button, the New Time Event does not 
become enabled. You cannot schedule a new 
query using only the keyboard.

No workaround is available.

When you schedule a query, you cannot tab 
to the radio buttons in the Grouping 
conditions area.

Press the Tab key to move forward to the OK 
button, and then press Shift+Tab to move 
backward to the Grouping conditions radio 
buttons.

When you schedule a query, and specify a 
new time event, you cannot use the Tab key 
to access all of the radio buttons.

No workaround is available.

JAWS cannot read the diagram for building 
queries.

No workaround is available.
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What Is SAS Visual Analytics?

SAS Visual Analytics is an easy-to-use, web-based product that leverages SAS high-
performance analytic technologies. SAS Visual Analytics empowers organizations to 
explore huge volumes of data very quickly in order patterns and trends and to identify 
opportunities for further analysis. SAS Visual Data Builder enables users to summarize 
data, join data, and enhance the predictive power of their data. Users can prepare data 
for exploration and mining quickly and easily. The highly visual, drag-and-drop data 
interface of SAS Visual Analytics Explorer (the explorer), combined with the speed of 
the SAS LASR Analytic Server, accelerate analytic computations and enable 
organizations to derive value from massive amounts of data. This creates an 
unprecedented ability to solve difficult problems, improve business performance, and 
mitigate risk rapidly and confidently. SAS Visual Analytics Designer (the designer) 
enables users to quickly create reports or dashboards, which can be viewed on a 
mobile device or on the web.

SAS Visual Analytics empowers business users, business analysts, and IT 
administrators to accomplish tasks from an integrated suite of applications that are 
accessed from a home page. The central entry point for SAS Visual Analytics enables 
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users to perform a wide variety of tasks such as preparing data sources, exploring data, 
designing reports, as well as analyzing and interpreting data. Most important, reports 
can be displayed on a mobile device or in the SAS Visual Analytics Viewer (the viewer).

Benefits of Using SAS Visual Analytics

Using SAS Visual Analytics, users can enhance the analytic power of their data, explore 
new data sources, investigate them, and create visualizations to uncover relevant 
patterns. Users can then easily share those visualizations in reports. Traditional 
reporting is prescriptive. That is, you know what you are looking at and what you need 
to convey. However, data discovery invites you to plumb the data, its characteristics, 
and its relationships. Then, when useful visualizations are created, you can incorporate 
those visualizations into reports that are available on a mobile device or in the viewer.

SAS Visual Analytics provides users with the following benefits:

n enables users to apply the power of SAS analytics to massive amounts of data

n empowers users to visually explore data, based on any variety of measures, at 
amazingly fast speeds

n enables users to share insights with anyone, anywhere, via the web or a mobile 
device

How Does SAS Visual Analytics Work?

You can use SAS Visual Analytics to explore and view data, interact with and create 
reports, and display reports on a mobile device or on the web. You can explore your 
data by using interactive visualizations such as charts, histograms, and tables. Report 
authors can easily point and click to query central sources of data. You can add filters 
and design the layout using tables, graphs, and gauges. You can use drag and drop to 
create a well-formatted report.
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The following figure illustrates how the different pieces of SAS Visual Analytics work 
together. It shows how users interact with the different interfaces.

Figure 1.1 Overview of SAS Visual Analytics
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Overview of SAS Visual Analytics Capabilities . . . . . . . . . . . . . . . . . . . . . . 7

Log On to SAS Visual Analytics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Log Off from SAS Visual Analytics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Overview of SAS Visual Analytics 
Capabilities

Users might have access to different functionality, depending on their assigned roles. 
Roles are mapped to capabilities. A capability, also known as an application action, 
defines the operations a user can perform.

SAS Visual Analytics provides four predefined roles—Report Viewing, Analysis, Data 
Building, and Administration. A predefined set of capabilities is available for each role. A 
system administrator can modify these roles and specify the capabilities for each role 
that meet the guidelines for your company. They can also define new roles. If you have 
questions about your assigned role, contact your system administrator. For more 
information about the roles and the capabilities that are available, see the SAS Visual 
Analytics: Administration Guide.

Note: This user's guide discusses tasks that you might be able to perform, depending 
on your role.
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Log On to SAS Visual Analytics

SAS Visual Analytics uses the standard Log On window for SAS applications.

1 To display the SAS Visual Analytics Log On window, click on the URL that is 
supplied by your system administrator or paste it into the address field of your 
browser. For example, you might enter:

http://<serverName>:<portNumber>/SASVisualAnalyticsHub

Display 2.1 Log On Window for SAS Visual Analytics

2 To log on to SAS Visual Analytics:

a In the User ID field, enter your user ID.

b In the Password field, enter the password for the user ID.

c Click Log On.

The SAS Visual Analytics home page is displayed. For more information, see “Your 
First Look at the SAS Visual Analytics Home Page” on page 12.
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Note:  Your password is case sensitive. Your user ID might be case sensitive, 
depending on the operating system that hosts the web application server.

Log Off from SAS Visual Analytics

To log off from SAS Visual Analytics, click Log Off in the upper right corner of the user 
interface.

Note: When you click Log Off, you are logged off from all environments.

If you are prompted about unsaved changes, click Log Off to exit without saving or click 
Continue to return to SAS Visual Analytics and keep working.

If you lose your connection to SAS Visual Analytics (for example, your session times 
out), then you are prompted to click Return to Application. By default, if there is no 
activity for several hours, then SAS Visual Analytics automatically logs you off and 
displays the logon window. If you are logged off automatically, then you must begin 
again at the point at which you last saved your work.

Your system administrator can change the inactivity period. He or she can also specify 
that SAS Visual Analytics automatically logs you off and displays the logon window 
instead of the Return to Application button. As a best practice, save your work 
frequently.

Log Off from SAS Visual Analytics 9



The following example shows the message that appears after your session has timed 
out.

Display 2.2 Session Timed Out Message for SAS Visual Analytics
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Your First Look at the SAS Visual 
Analytics Home Page

After you log on to SAS Visual Analytics using the standard Log On window for SAS 
applications, you will see the home page. The home page enables you to create new 
content in SAS Visual Analytics. In addition, it enables you to access content that you 
and others have created.

Here are the features of the home page:

Figure 3.1 The Home Page

1 The menu bar enables you to access task options, such as creating reports, 
exploring data, managing your environment or favorites, setting your view, and 
getting help on using SAS Visual Analytics. You can search all SAS content from the 
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menu bar, and you can log off from SAS Visual Analytics. For more information 
about searching, see “About Searching from the Home Page” on page 29.

2 The Create Content area provides icons to let you quickly create a new report, 
explore data, or prepare data, depending on your role and the associated 
capabilities. Other installed SAS applications might add actions to the Create 
Content area.

3 The My Content area lists any explorations, reports, queries, tables, or stored 
processes that you have opened or created recently. It also lists any content that 
you have marked as a favorite or as part of a collection. Click Browse to explore 
folders to find a report, exploration, stored process, or table.

Note: All tables are displayed because the home page does not distinguish 
between LASR tables and other tables.

4 The Other Content area displays lists of explorations, reports, stored processes, 
queries, or tables that your system administrator has added for you. If your system 
administrator has not created any lists, then you will not see any content in the 
Other Content area. The heading is still displayed. If you have an Administration 
role, then you will also see a Manage link that enables you to manage lists.

5 The Common Actions pane provides an alternate way for you to create reports, 
explore data, and manage your environment or favorites. If you have an 
Administration role, then you will also see a Prepare Data link. Other installed SAS 
applications might add actions to the Common Actions pane.

6 The Links pane provides a link to the introductory video for SAS Visual Analytics 
and links to other pages that you have bookmarked. You might also see links to 
other SAS products, such as SAS Theme Designer for Flex, depending on your role 
and the SAS licenses that your site has.

Position your mouse pointer over the Links heading to activate the , which opens 
the Add Link window. Click  to open the Manage Links window, where you can 
add, delete, re-order, and hide links.

7 The SAS Resources pane provides links to resources on the SAS website and to 
social media.

Your First Look at the SAS Visual Analytics Home Page 13



If you have the Theme Designer for Flex: Administration role in SAS Management 
Console, you can access the SAS Theme Designer for Flex from the More Actions 
item on the menu bar.

Here is an example of the menu bar with the More Actions item.

Display 3.1 Home Page Menu Bar with the More Actions Item

Once you start using the home page, thumbnails enable you to open explorations, 
reports, stored processes, tables, queries, and folders that you have created or opened. 
The default view is secure, generic thumbnails that represent the content. Your system 
administrator can set a property that specifies the use of thumbnails that are shared and 
unique to each object. Shared thumbnails are unique for each individual report object, 
so each report looks different from other reports, and each exploration looks different 
from other explorations.

Generic thumbnails are distinguished by content type only. All reports look the same, 
but they appear different from explorations. Here are examples of the generic 
thumbnails that you might see on the home page:

Display 3.2 Generic Thumbnails for an Exploration, a Report, and a Stored Process

You can choose to view the content on the home page as a list. To change your view, 
click  on the menu bar, and then select Thumbnail or List. The default is Thumbnail.
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Here is an example of the list view for the home page:

Display 3.3  List View

For more information about other parts of the SAS Visual Analytics interface, see the 
following topics:

n “Your First Look at SAS Visual Data Builder” on page 39.

n “Your First Look at the Explorer” on page 124.

n “Your First Look at the Designer” on page 272.

About the Availability of Menus and 
Menu Selections in SAS Visual 
Analytics

All of the following conditions influence whether a SAS Visual Analytics menu or menu 
selection is available to use:

n your role and the associated capabilities. For example, you must have a Data 
Building role to prepare data.

n your location in SAS Visual Analytics. For example, some application features are 
available only if you are designing a report.
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n the currently selected report object. For example, ranges are not available for list 
tables.

n whether the data for a report has been defined. For example, if the data has not 
been selected, then you cannot create a filter.

For more information about roles and capabilities, see the SAS Visual Analytics: 
Administration Guide.

Specifying Your Preferences

About Preferences

All of your preferences persist between sessions.

Specifying Global Preferences

You can specify global preferences that are applied to all SAS web applications that are 
displayed with the Adobe Flash player. These preferences are set by each user.

To specify global preferences:

1 Click either  or Edit Preferences on the home page. The Preferences window is 
displayed.

Note: If you are in the data builder, the explorer, the designer, or the viewer, then 
select File  Preferences to open the Preferences window.

2 Click Global Preferences in the left pane.

3 Select a User locale to specify your language and geographic region.

Select a Theme to change the color scheme and other visual settings for all of your 
SAS web applications.

Select Invert application colors to invert all of the colors in your SAS web 
applications.
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Select Override settings for focus indicator to change the color, thickness, and 
opacity of the focus in your SAS web applications.

Display 3.4 Global Preferences in the Preferences Window

4 Click OK to apply your changes.

5 If you changed the User locale, then you must log off and log back on to SAS Visual 
Analytics for the change to take effect.

Specifying the SAS Visual Analytics General 
Preferences

Using the SAS Visual Analytics home page, you can specify your general preferences 
for SAS Visual Analytics.

To specify your general preferences:

1 Click either  or Edit Preferences to open the Preferences window.

2 Click General in the left pane.
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3 Specify a value for Show this number of recent items. There is a minimum of one 
item and a maximum of 16 items. The default setting is 9 items.

Click Clear History to reset your history.

Display 3.5 General Preferences Window for SAS Visual Analytics

4 Click OK to apply your changes.

Specifying Your Initial Screen Preference

You can specify the initial screen that you want to see after you log on to SAS Visual 
Analytics.

To specify the initial screen preference using the home page:

1 Click either  or Edit Preferences to open the Preferences window.

2 Click Home in the left pane.

3 Select an option from the Initial screen drop-down list.
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The following options are available:

n Home

n Where user logged off most recently

n Create Report

n Explore Data

n Prepare Data

n A Specific Object

If you select A Specific Object, then you can specify only one of these content 
types (for example, reports, explorations, tables, stored processes, and so on) for 
your initial screen. The content types depend on the SAS products that your site has 
licensed and how they are configured.

Display 3.6 Home Preference in the Preferences Window

4 Click OK to apply your changes.
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Specifying Other Preferences

You can specify other preferences in SAS Visual Analytics:

n For information about SAS Visual Data Builder preferences, see “Specifying Your 
Preferences for SAS Visual Data Builder” on page 43.

n For information about SAS Visual Analytics Explorer preferences, see “Specify 
Preferences That Are Specific to SAS Visual Analytics Explorer” on page 127.

n For information about SAS Visual Analytics Designer preferences, see “Specifying 
Your Preferences for the Designer” on page 281.

Managing Content on the Home Page

The home page displays recent reports, explorations, stored processes, tables, and 
queries, as well as favorites under the My Content heading on the home page. To 
manage your content, click Manage to the right of the My Content heading. The 
Manage My Content window is displayed.

Display 3.7 Manage My Content Window
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The following icons are available in the Manage My Content window:

Icon Description

Creates a new folder for your reports, explorations, stored processes, tables, and 
queries.

Adds a report, exploration, stored process, query, or table to your list of favorites. 
You can also create or add a collection of favorites.

Options Enables you to select either Clear Recent History or Clear Favorites.

Enables you to delete favorite or recent content, one at a time. You can delete 
multiple items by pressing the Ctrl key. For a collection, you will have a choice of 
permanently deleting the collection or simply removing it under the My Content 
heading on the home page.

Enables you to move favorites content up in the list to change what is displayed 
under the My Content heading on the home page.

Enables you to move favorite content down in the list to change what is displayed 
under the My Content heading on the home page.

When you select a report, exploration, stored process, or table in the Manage My 
Content window, the details such as the name and location of that item are displayed. 
Favorite groups are displayed only in the tree on the left side of the Manage My Content 
window.

Discovering Details Using the Object 
Inspector on the Home Page

The home page provides an object inspector that enables you to quickly find more 
information about an object when you click it. You can see a description of the report, 
exploration, stored process, table, query, folder, or collection; the location of the 
selected object; the author; and when the object was modified. A small toolbar lets you 
add the object to your favorites or set it as your initial screen. When you set a favorite or 
specify that an object should be set as your initial screen, the  icon turns yellow ( ).
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Your role and capabilities determine the availability of actions on the toolbar (such as 
viewing, editing, or opening) in the object inspector. For more information about roles 
and capabilities, see the SAS Visual Analytics: Administration Guide.

Here is an example of what you might see for a report that has been viewed:

Display 3.8 The Object Inspector on the Home Page

If you have the Report Viewing role and the View Report and Stored Process capability, 
then the toolbar enables you to open a report in the viewer by clicking Open.

If you have the Visual Analytics: Analysis, Visual Analytics: Data Building, or 
Visual Analytics: Administration role and the Create Report capability, Explore Data 
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capability, or both, then the toolbar in the object inspector enables you to do the 
following:

n Edit a report, which opens the report in the designer so that you can edit or change 
the objects in the report.

n View a report, which opens the report in the viewer.

n Open an exploration, which displays the explorer. The Open link is also available for 
stored processes, queries, and folders.

n Create Report for a table, which displays the designer.

n Explore Data for a table, which displays the explorer.

n Click Collections to select an existing collection or to create a new collection. For 
more information, see “Managing Collections” on page 23.

n Click  to add the object to your list of favorites. When the star icon is yellow, click 
 to remove the object from your list of favorites.

n Click  to set the report or exploration as the initial screen when you start SAS 
Visual Analytics. There is a yellow box around the  to indicate when the object is 
set as the initial screen. Click the icon to remove the initial screen setting.

Any user who has the Add or View Comments capability can add comments to any 
report, exploration, stored process, table, or query. They view existing comments about 
any report, exploration, stored process, table, or query using the Comments link in the 
lower right of the object inspector. You cannot comment on folders, favorite groups, or 
collections.

For more information, see “Adding Comments to Objects on the Home Page” on page 
25.

Managing Collections

You can create a collection that points to your favorite reports, explorations, stored 
processes, tables, queries, folders, and favorite groups. A collection is like a group of 
bookmarks.
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To create a new collection:

1 Do one of the following:

n On the home page, click Manage to the right of the My Content heading. The 
Manage My Content window is displayed.

Click  to open the menu, and then select Create a Collection. The Create a 
Collection window is displayed.

Display 3.9 Create a Collection Window

n In the object inspector, click Collections. Then, select Create a Collection. The 
Create a Collection window is displayed.

Display 3.10 Create a Collection Window for the Object Inspector

2 Enter a Name for the collection.
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3 Click Browse to select a Location for the collection. The Choose a Location window 
is displayed.

Select an existing folder or create a new one. You can also select an existing 
collection. Click OK to return to the Create a Collection window.

Note: When you create a new collection, you can add items to it only from within the 
Manage My Content window if the collection is a root collection in My Collections. 
For example, if you create Collection B, and add it to Collection A, then Collection B 
appears on the right side of the Manage My Content window and you cannot add 
items to it.

4 (Optional) If you opened the Create a Collection window from the object inspector, 
then you can clear the Add the new collection to My Content check box. This 
means the new collection to will not be displayed on the home page next to the 
Favorites link.

5 Click Add. The new collection will appear on the left in the Manage My Content 
window.

To rename a collection, right-click on the name of the collection in the Manage My 
Content window. Then, select Rename. Type a new name and then press Enter.

To permanently delete a collection, right-click on the name of the collection in the 
Manage My Content window. Then, select Delete. Click OK in the confirmation 
message that is displayed.

To remove a collection under the My Content heading on the home page, right-click on 
the name of the collection in the Manage My Content window. Then, select Remove 
from My Content. Click Remove in the confirmation message that is displayed.

Adding Comments to Objects on the 
Home Page

If you have the Add or View Comments capability, then you can use the object inspector 
on the home page to add (or view) comments to objects on the home page. You can 
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add comments to reports, explorations, stored processes, tables and queries. You can 
also respond to existing comments or edit your own comments. You cannot comment 
on folders, favorite groups, or collections. You cannot see visualization-level comments 
on the home page.

To add a comment:

1 Click on a report, exploration, stored process, tables, or query to open the object 
inspector.

2 Click Comments in the lower right corner to expand the object inspector.

Display 3.11 Comments in the Object Inspector

3 Enter a topic name and a comment.
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Here is an example:

Display 3.12 Adding a Comment

Click Post to add your comment. The Comments link in the object inspector will 
update to show that there is a comment.

4 (Optional) Click  to attach a file or an image to your comment.

To respond to an existing comment:

1 Click on a report, exploration, stored process, tables, or query to open the object 
inspector.

2 Click Comments in the lower right corner to expand the object inspector.

3 Select an existing comment. Then, enter a reply.

4 (Optional) Click  to attach a file or image to your reply.

5 Click Post to add your comment. The Comments link in the object inspector will 
update to show that there is a comment.
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Note: To edit another user’s comments or to delete comments, you must belong to the 
predefined role Comments:Administrator. This role includes the capabilities of editing 
or deleting comments.

To search for a comment:

1 Enter the word or phrase that you want to search for in the search field. Press Enter.

2 (Optional) To clear your search, click . Then, you can enter another word or 
phrase in the search field.
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About Searching from the Home Page

You can search all reports, explorations, stored processes, tables, and queries that are 
on the metadata server from the menu bar on the home page. The list of items that you 
can search for depends on the SAS products that your site has licensed.

Display 4.1 Search Field on the Menu Bar

The search field on the menu bar supports the following types of searches:

n single word

n multiple word

n in-word wildcards

n spaces in strings that use quotation marks

n plus (+) and minus (-) syntax
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The plus (+) sign and minus (-) sign are prefix operators. This means that the 
operator precedes the search term that is required or excluded, rather than following 
it. For example:

o Specifying 2011 2012 2013 matches documents that contain any of the three 
terms.

o Specifying +2011 +2012 +2013 matches only documents that contain all three 
terms.

o Specifying 2011 2012 -2013 matches documents that contain 2011 or 2012, 
but only if they do not contain 2013.

Note: Single- and multiple-word searches that are plain text have a wildcard appended 
to them. For example, if you search for the word sample, then it is converted to 
sample*. This means that you get different results than if you entered “sample”, 
+sample, or *sample*.

The search is not case sensitive.

Up to 5000 items can be returned in a single search. If your search results exceed 5000 
items, then the first 5000 items appear, and a message is displayed at the top of the 
Search Results window. The message tells you how many results matched your search 
and how many have been displayed. Narrowing your search using the search field 
enables the relevant search results to be displayed. When you submit a new search that 
returns in fewer than 5000 items, you can see all the search results.

Search results on the home page are not ranked. In the workspace, you can use the 
Sort by drop-down list to specify that you want the list of items to sort by Alphabetical 
ascending, Alphabetical descending, Date ascending, or Date descending. The 
default is Alphabetical ascending.
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Suppose that you search for the word sample. All items that contain the word sample 
are displayed in the workspace. Here is an example of the search results:

Display 4.2 Search Results on the Home Page

Refining Your Search Results

You can refine your search results using your original search on the metadata server. 
After you enter your original search using the menu bar on the home page, the search 
results are displayed in the workspace. Note that when you refine your search results, 
the initial 5000 item subset is not affected.

The refine search feature is dependent on your locale. The search is not case sensitive. 
No special characters are recognized except spaces and quotation marks.

You can refine the search results displayed in the workspace using the Search within 
results field in the left pane. When you enter a term or terms, you can use quotation 
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marks and spaces when you are searching within your results. Only the items that 
match your refined search appear in your workspace. Each search term that you enter 
must appear at least once in the object name, the description, or the author name in the 
metadata.

You can also refine your search results by selecting (or clearing) check boxes in the left 
pane. Note that the totals in the parentheses in any panel are dependent on what has 
been selected in the other two panels.

The following panels are available:

n The Type panel shows the available object types. In SAS Visual Analytics, you can 
search for SAS report (2G), Table, Stored process, Visual data query, orVisual 
exploration. Depending on the SAS products that you have licensed at your site, 
other SAS object types might appear in the Type panel. The default is All object 
types.

The available types are determined by the capabilities that your system 
administrator has assigned. For example, you might see only the All, SAS report 
(2G), Table, and Stored process check boxes in the Type panel.

If you select all of the check boxes for the individual types, then the check boxes 
clear, and the All check box is selected automatically. If you clear the check boxes 
for all of the types, then the All check box is selected automatically.

Note: If your role permits you to see only one type, then you will not see the Type 
panel.

n The Author panel enables you to search for a specific author, or to select one or 
more authors by name.

The number in parentheses beside the author’s name identifies the number of 
objects that the author has created using the filters that have been selected in the 
other panels.

If you select all of the check boxes for the authors in the list, then the check boxes 
clear, and the All check box is selected automatically. If you clear the check boxes 
for all of the authors, then the All check box is selected automatically.
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n The Date Modified panel lists the dates that the objects that were last modified. You 
can refine the search to a specific date range by specifying a From date, a To date, 
or both.

The dates are time zone dependent. If your company has offices in multiple time 
zones, then the date modified time stamp on the object reflects the time at which it 
was saved using the current user’s time zone. For example, if a report was modified 
by a user on January 3 at 2:00 a.m. in New York, another user in California sees that 
it was modified on January 2 at 11:00 p.m.

At the top of the workspace, you can see the breadcrumbs for the selections that you 
have made to refine your search. Breadcrumbs change as you modify the selections in 
the Type, Author, and Date Modified panels. The breadcrumbs also show any search 
strings that you entered in the Search within results field.

The appearance of the left panel is saved across sessions of SAS Visual Analytics. For 
example, if you collapse the Type panel, and then change the width of the Refine 
Results section, when you log off and log back on, the Type panel remains collapsed, 
and the Refine Results section has the new width. This is important to remember if you 
close the Refine Results section. Your Refine Results selections are not retained 
across sessions or primary searches in SAS Visual Analytics.
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Suppose that you search for the word sample. Then, you refine the search results by 
selecting Stored process for Type. All stored processes that contain the word sample 
are displayed in the workspace. Here is an example of the refined search results:

Display 4.3 Refined Search Results on the Home Page
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What Is SAS Visual Data Builder?

SAS Visual Data Builder enables analysts and data administrators to perform data 
preparation for analytics. You can design queries to perform joins, add calculated 
columns, and subset and sort data. Several productivity features speed the creation of 
columns based on common aggregation functions.

Once you design your queries, you can reuse them as subqueries for more 
sophisticated queries, export them as jobs for scheduling, or schedule them directly 
from the user interface.

The application has data import features that enable you to access data from 
spreadsheets, delimited files, and SAS data sets. Once you import the data, you can 
prepare it for analysis or join it with existing data.
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The application provides a series of features that are used in deployments that include 
SAS LASR Analytic Server. You can load an existing table directly into memory, load 
the results of a query into memory, or append rows to an in-memory table on a server.

Accessing SAS Visual Data Builder

You can access SAS Visual Data Builder by using any of the following methods:

n On the SAS Visual Analytics home page, select a query. In the details view, click 
Edit. Or you can double-click the query to open it in SAS Visual Data Builder.

n On the Visual Analytics home page, click Prepare Data to open SAS Visual Data 
Builder.

n Follow a web link or enter the URL to access SAS Visual Data Builder directly. For 
example, you might enter http://hostname.example.com/
SASVisualDataBuilder.
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Your First Look at SAS Visual Data 
Builder

The SAS Visual Data Builder interface contains the following elements:

2

3

1

4

5 76

1 The application bar enables you to return to the home page.

2 The menu bar contains menus that enable you to perform tasks.

3 The navigation pane displays a tree of tables and queries.

4 The lower pane contains tabs that enable you to specify column expressions and 
subset data.

5 The toolbar contains icons that enable you to develop and manage your queries.

6 The workspace enables you to design queries.
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7 The properties panel enables you to manage the properties of the item that is 
selected in the workspace.

About Access to DBMS Data

SAS Visual Data Builder can be used to read source tables from third-party vendor 
databases and to write tables to them as well. The SAS/ACCESS Interface products 
provide this feature. The user ID and password that you use to log on to SAS Visual 
Data Builder might not be valid for a third-party vendor database. If this is the case, then 
you are prompted for credentials to the DBMS when you access the database with a 
Read or a Write operation. As an alternative to being prompted, you can store a login in 
metadata that has valid DBMS credentials. For more information, see "How to Store 
Passwords for a Third-Party Server" in SAS Intelligence Platform: Security 
Administration Guide.

If you are prompted for credentials and supply an invalid user ID or password, you are 
denied access to the data. In this case, you can select File  Clear Credentials Cache 
to remove the invalid credentials from your session. The next time you access the data 
source, you are prompted again.

Third-party databases are often more restrictive about column names or length than 
SAS. For more information, see "DBMS-Specific Naming Conventions" in 
SAS/ACCESS for Relational Databases: Reference.

Working with User-Defined Formats

The preferred method for making user-defined formats available to a SAS Application 
Server is to name the format catalog formats.sas7bcat and to place it in SAS-config-
dir/Lev1/SASApp/SASEnvironment/SASFormats. For more information about 
using user-defined formats, see SAS Intelligence Platform: Data Administration Guide.
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SAS Visual Data Builder can use existing user-defined formats. The Format column 
displays the user-defined format name. However, if you change the format, then you 
cannot restore the original user-defined format.
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6
Specifying Preferences for SAS Visual 
Data Builder

Specifying Global and General Preferences . . . . . . . . . . . . . . . . . . . . . . . . 43

Specifying Your Preferences for SAS Visual Data Builder . . . . . . . 43

Specifying Global and General 
Preferences

To specify global SAS preferences, see “Specifying Global Preferences” on page 16. To 
specify general preferences, see “Specifying the SAS Visual Analytics General 
Preferences” on page 17.

Specifying Your Preferences for SAS 
Visual Data Builder

To specify preferences that are specific to SAS Visual Data Builder:

1 Select File  Preferences to open the Preferences dialog box.

2 Select SAS Visual Data Builder  General.

Select a default SAS Application Server to use from Default application server. If 
you have added SAS Application Server instances to your deployment, make sure 
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that the Job Execution Service has been configured to use the application server. 
For more information, see SAS Intelligence Platform: Middle-Tier Administration 
Guide.

3 Select SAS Visual Data Builder  Scheduling.

Specify a default scheduling server, batch server, and deployment directory. For 
more information, see “Scheduling Preferences” on page 107.

4 Click OK to apply your changes.
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What Is a Query?

A query is a metadata object that manages the references to input tables, output tables, 
staging tables, joins, and summarizations from a SAS Visual Data Builder session. You 
can save queries and open them later to edit the data preparation operations that are 
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performed in the query. You can use saved queries as subqueries when you design a 
new query.

About Designing Queries

You can use SAS Visual Data Builder to design queries that perform analytic data 
preparation. You can use a query to subset, sort, join, and add calculated columns to 
tables.

As you design your query, you can click  to validate your query. Use the  button to 
preview or run the query.

The preview option uses a temporary table for the results. You can run the query after 
you specify an output table for the query and then save the query.

Creating a New Query

You can create a new query by clicking  from the navigation pane.

Saving Your Query

To save your current query, click , and enter a name and select a location.

When you save the query, you clear the undo and redo history.
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Saving a Query as a New Query

Open an existing query from the SAS Folders tree that closely matches the query that 
you want to create. Click , and then enter a new name and select a location. Perform 
any customizations.

Note: If the existing query has output properties (table, location, library, and partition 
by), then the new query is saved with the same output properties as the existing query. 
If you do not want to use the existing output table, clear the output table information, 
and specify a new table.

See Also

“Output Tables” on page 55

Using the Design Tab

The Design tab is the default view for working with queries. This tab provides an easy-
to-use interface for designing a query. You can perform the following tasks with the 
Design tab:

n Drag and drop tables or queries from the SAS Folders tree onto the workspace.

n Join tables by using your pointer to select the source column, and then drag the 
pointer to the corresponding column in the joined table.

n Add columns to the Column Editor tab by clicking the column name from the table 
in the workspace or by right-clicking on the table and selecting Add All Columns.

n Use the Column Editor tab to specify column expressions, aggregations, and sort. 
You can set the attributes for a column, such as the type, format, and label.
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n View the Output Columns tab to see the number of output columns and attributes. 
When you specify aggregations and pivot by columns, the number of output columns 
can increase dramatically.

n Click  to check that the query is valid.

n Check the Messages tab for information about warnings and errors such as invalid 
column expressions.

n Check the Log tab to view the SAS log. A SAS log is generated when you preview, 
run, or validate a query.

n Use the Properties tab in the right pane to specify output table information.

See Also

n “Working with Tables” on page 53

n “Working with Columns” on page 62

n “Working with Query Filters” on page 73

n “Working with Joins” on page 77

Adding a Data Source to a Query

Adding a Table

To add a table to a query, use the SAS Folders tree to locate the table ( ) and then 
drag and drop the table onto the workspace.

TIP You can also click  and search for the table by name and location.
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Adding a Subquery

After you have designed a query and saved it, it can be used as an input data source to 
a new query. To add a subquery to a query, use the SAS Folders tree to locate the 
query ( ), and then drag and drop the query onto the workspace.

The subquery is represented in the workspace by the structure of the output table.

Best Practices for Adding Data Sources

When you plan to join data sources (tables or queries), the order in which you add the 
data sources to the workspace matters. The first data source that is added to the 
workspace is automatically assigned as the left table for any joins that you add to the 
query.

If you are designing a query that uses a fact table and dimension tables, drag and drop 
the fact table onto the workspace first. You can perform left, right, or full joins with the 
dimension tables faster because you need to specify the join type only. However, if you 
drag and drop a dimension table first, you can easily use the  button on the Joins tab 
to switch the left and right tables in the join.

If you are not using a fact table or dimension tables, then the sequence for adding 
tables to the workspace might not be very important. Just remember that the first table 
dropped onto the workspace is assigned as the left table, and you can switch the left 
table and right table on the Joins tab.SAS Visual Data Builder takes advantage of 
vendor-specific features in SQL processing whenever possible. If the source tables are 
from a third-party vendor database, the SAS/ACCESS Interface engine can optimize the 
performance of the query by passing the SQL statements through to the database.

Removing a Data Source from a Query

To remove a data source from a query, select the item in the workspace, right-click, and 
select Remove Table. This action applies to tables and subqueries.
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Tips for Appending Data

The following list includes some strategies for appending data:

n Design a query to load the baseline data to the output table and run it.

n Modify the query, or use Save As to create an identical query and modify that one.

n Select the Append data check box.

n Add a filter on the Where or Having tab to select the changed data.

n Schedule the query.

Specifying Properties for a Query

On the Properties tab, you can specify the following properties:

Name
displays the name for the query.

Location
displays the metadata folder location for the query object.

Description
specifies a description of the query.

Unique values
specifies whether the SQL keyword DISTINCT is applied to the SELECT statement 
that is used to generate the result set for the query.

Append data
specifies whether the result set for the query is appended to the output table. If a 
staging table is used, then the staging table is replaced with the result set before 
appending to the output table.
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Manual code
specifies that the query uses the SQL that is written by the user on the Code tab 
when the check box is selected. For more information, see “Customizing Code” on 
page 101.

Table
specifies the table name for either the staging output or the final output.

Location
specifies the metadata folder location to use for registering the staging table or 
output table metadata.

Library
specifies the library to use for the staging table or output table.

Partition by
specifies the column to use for partitioning the output table. This property applies 
when the output table is in a SAS LASR Analytic Server library or SAS Data in 
HDFS library only. For more information, see “Partitioning Tables” on page 87.

See Also

“Specifying Properties for a Source Table” on page 54
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Source Tables

SAS Visual Data Builder supports using tables and queries as input data for a query. 
When you drop a table onto the workspace, SAS Visual Data Builder connects to the 
SAS Metadata Server to determine the column names and data types for the table. 
When you drop a subquery onto the workspace, the data builder makes the same 
request, but determines the column names and data types for the output table of the 
subquery.

Because SAS Visual Data Builder uses metadata for source tables, you must register 
the table metadata before you can access the data. Source tables can be registered in 
metadata with SAS Visual Analytics Administrator or SAS Management Console.
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See Also

n “Adding a Data Source to a Query” on page 48

n SAS Visual Analytics: Administration Guide

n SAS Intelligence Platform: Data Administration Guide 

Specifying Properties for a Source 
Table

When a table is selected in the workspace, or when you select it from the Properties 
menu, you can specify the following:

Alias
displays the SAS table name that is stored in metadata. You can specify a new 
value to use as a table alias. The alias name is stored with the query, and it does not 
affect the metadata information for the table.

Name
displays the metadata object name. You can change the metadata object name in 
the SAS Folders tree by using Rename.

Location
displays the table's metadata folder.

Library
displays the table's library.

Auto-aggregate
specifies whether to apply aggregations to the columns for this table when the 
columns are added to the query.

Functions
specifies the aggregations to apply to the columns for this table when the columns 
are added to the query.
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See Also

“Using the Auto-Aggregate Functions” on page 69

Output Tables

About Output Tables

When you design a query, you specify an output table on the Properties tab. When you 
save the query, the output table is registered (or updated) in the metadata. When you 
run the query, the physical output table is created. The metadata that is created when 
you save the query enables you to use the table as a source table for another query or 
another SAS application.

Specifying the Output Table

Every query must have an output table in order to run it. How you specify the output 
table affects whether metadata is updated or created.

The following table shows the different ways to specify an output table.

Action How To

Create a new output table *. Click Clear, and specify a table name, 
location, and library. If the query was already 
saved with an output table, that table is not 
changed and is no longer associated with the 
query.

Reuse an existing table. Select a metadata table . If the query was 
already saved with an output table, that table 
is not changed and is no longer associated 
with the query.
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Action How To

Change the name of the output table *. Enter the new name in the Table field, and 
save the query. This changes both the name 
and physical name in metadata in order to 
make them the same. All queries, reports, 
explorations, and so on, still reference the 
same table object.

* If you replace the default table name, OutputTable, with another name before you save the query, the 
data builder registers a new output table and uses it with the query.

To specify an output table:

1 Select the top-level query object from the Properties tab.

2 Specify an output table name, location, and library. For SAS libraries, use 32 
characters or less, and do not include spaces or special characters. Third-party 
vendor databases can have restrictions as well.

If you select a SAS LASR Analytic Server or SAS Data in HDFS library, the Partition by 
menu becomes available. After the settings for the output table are specified, the 
Staging section becomes available.
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The following display shows an example of the Output and Staging properties.

Display 8.1 Output and Staging Properties
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Staging Tables

About Staging Tables

SAS Visual Data Builder supports staging data. Staging data is a best practice because 
you can use SAS Visual Data Builder to access and transfer data from operational 
systems once, rather than frequently interfere with the operational systems and reduce 
their performance. Using SAS Visual Data Builder to stage data can provide the 
advantage of adding calculated columns when you stage the data. Like the output table, 
the staging table is registered in metadata when you save the query. The physical table 
for the staging table is created when you run the query. The physical table is always 
replaced with the results of the query.

You cannot specify the name for a staging table. The name of the output table is used, 
and an __STG (with two underscores) suffix is applied to the name. The suffix is used 
for the table name in metadata. The physical name of the staging table does not include 
the suffix.

Specifying a Staging Table

To use a staging table:

1 Select the top-level query object from the Properties tab.

2 The settings in the Output section must be set.

3 Expand the Staging section, and select the Use a staging table check box.

4 Specify a library.
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Output and Staging Table Interactions

The following table identifies the supported combinations for output tables and staging 
tables. In addition, whether you can append data to tables is indicated.

Table 8.1 Output Table and Staging Table Interactions

Output Table Staging Table Append Data

SAS or DBMS * None Supported

SAS Data in HDFS None Not supported

Teradata or Greenplum ** None Supported

SAS LASR Analytic Server None Supported

SAS or DBMS * SAS or DBMS * Supported

SAS LASR Analytic Server SAS or DBMS * Supported ***

SAS LASR Analytic Server SAS Data in HDFS
Note: SAS LASR Analytic 
Server is the only supported 
output.

Not supported

SAS LASR Analytic Server Teradata or Greenplum ** Supported ***
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Output Table Staging Table Append Data

Any SAS LASR Analytic Server
Note: SAS LASR Analytic 
Server libraries are not 
supported for staging tables.

Not supported

* The SAS or DBMS value represents data stored in SAS data sets or a third-party vendor database, 
respectively.

** The Teradata or Greenplum value represents deployments that use a third-party vendor appliance as 
a co-located data provider for SAS LASR Analytic Server.

*** Appending data is performed by the SAS LASR Analytic Server engine. Appends are not performed 
by having the server read data in parallel.

See Also

“Working with SAS LASR Analytic Server” on page 83
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Adding Columns to a Query

Understanding How SAS Visual Data Builder 
Works with Columns

When you add a data source (a table or subquery) to the workspace, the columns from 
the data source are not automatically added as output columns to the query.

You need to add the columns to the query that you want to use as input. After the 
columns are added, you can specify column expressions and aggregations and use the 
sort and pivot by features.

Note: As an exception, the auto-aggregate feature requires that you set the default 
aggregations for the table before they are added to the query.

When a data source is dropped onto the workspace, the column types are represented 
by the following icons:

Table 9.1 Icons for Data Types

Icon Description

This icon represents numeric data.

This icon represents character data.
Note: Date, time, and datetime data use this icon. After the column is 
added, the Type and Format columns are updated with information 
about the new column.
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Adding All of the Columns from a Table

To add all of the columns from a table to a query, select the table in the workspace, 
right-click, and select Add All Columns.

Display 9.1 Add All Columns

Adding a Single Column from a Table

To add one column from a table to a query, select the column name with your pointer.

Display 9.2 Add One Column
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TIP If you select the column name an additional time, the column is added to the 
query again. This can be helpful if you want to use a column for both numeric and 
character data. When you add a column more than once, a number is added to the 
column name. If you change the column name, make sure that you do not have more 
than one column with the same name.

Adding a New Column Manually

To add a new column manually:

1 Click the Column Editor tab.

2 Click  at the bottom of the table.

3 Specify values for the Column Name, Expression, and Type fields. The remaining 
fields are optional.

Removing Columns

To remove a column from a query:

1 Click the Column Editor tab.

2 Select the column to remove, right-click, and select Remove Column.
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Display 9.3 Removing a Column

TIP Hold down the Shift key or Ctrl key and click to select multiple columns.

Specifying a Column Expression

To specify a column expression:

1 On the Column Editor tab, select table-name.column-name from the Expression 
column. If you added a new column manually, then you need to make sure that you 
specified a table name and a column name.

2 Click  to open the expression builder. The table name and column name are 
added automatically as the default SQL expression.

3 On the Fields tab, select columns from the source tables that you have added to the 
query.

TIP You can begin entering the table name and column name in the SQL 
expression area to use the autocomplete feature.

4 On the Functions tab, select the functions to apply to the source column.
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5 Enter arithmetic operators and expressions such as CASE statements directly in the 
SQL expression area.

6 Click Apply to save the column expression.

Specifying Aggregations

To specify an aggregation for a column:

1 On the Column Editor tab, place your pointer in the Aggregations cell for the 
column and click. Click the ellipsis button to select the aggregations to use.

2 In the Choose Aggregations dialog box, select the Aggregate functions radio 
button.

Display 9.4 Choose Aggregations Dialog Box

3 Select the check boxes for the aggregate functions to use. Click Apply.
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If you want to apply a common set of aggregate functions to a group of columns, hold 
down the Ctrl key, select the columns on the Column Editor tab, right-click, and select 
Choose Aggregations.

Display 9.5 Choose Aggregations Menu Item
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The following display shows how adding aggregations results in additional output 
columns. The aggregate function is appended to the column name.

Display 9.6 Output Columns Tab with Aggregations

Removing All Aggregations

To remove all the aggregate functions and group by settings:

1 On the Column Editor tab, select all the columns.

2 Right-click, and select Remove Aggregations.

TIP This menu option is available only when all of the columns are selected.
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Using Group By Variables

When you add an aggregation to a column, the remaining columns are automatically 
used as group by variables. The Aggregations column displays GROUP BY for these 
variables.

You can use a column as a group by variable by following the steps in “Specifying 
Aggregations” and selecting the Group by radio button.

Using the Auto-Aggregate Functions

The auto-aggregate feature is a productivity feature that enables you to specify a set of 
aggregations to apply as default aggregations to numeric columns for a specific table. A 
typical use is to automatically aggregate some of the columns in a fact table.

To use the auto-aggregate feature:

1 Select a table on the Design tab. On the Properties tab, the table properties are 
displayed.

2 Select Enable for Auto-Aggregate.

3 Click the ellipsis button next to Functions to open the Choose Aggregations 
window.

4 Select the check boxes for the aggregate functions that you want to apply, and then 
click Apply.

Whenever you add a column to the query, the selected aggregate functions are 
automatically applied.

Using the Auto-Aggregate Functions 69



Using the Pivot By Feature

The pivot by feature provides an easy and powerful way to summarize data for 
analytics. You can specify a column to use as a categorical variable and the unique 
values to use. When the query is run, the output table is summarized with the 
aggregations that you apply.

To use the pivot by feature:

1 On the Column Editor tab, place your pointer in the Pivot By cell for the column to 
use as the pivot column. Click the ellipsis button to select the pivot column and 
values.

2 In the Pivot Values dialog box, select the pivot by column. You can enter search 
criteria in Filter fields to filter the column names.
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The following display shows an example of pivoting by three values in the 
Product_Category column.

Display 9.7 Pivot Values

3 After the unique values for the column are loaded, select the check boxes for the 
values to use in the summarization. Click Apply.

The following display shows an example of the Column Editor tab when a pivot by 
column is used. The minimum and maximum Total_Retail_Price are calculated for each 
Customer_ID and are then pivoted by (transposed by) three values of the 
Product_Category column.

Display 9.8 Column Editor Tab with a Pivot By Column
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TIP  TRP is specified as a label for the Total_Retail_Price column. Look at the next 
display to see how the label is used to create labels for the new columns.

The following display shows how pivoting the Customer_ID column by three values of 
the Product_Category column results in additional output columns. A substring of the 
pivot by values is used as a prefix to each column name and the aggregate function is 
used as a suffix. The pivot by column label and aggregate function are used in the 
output column label.

Display 9.9 Output Columns Tab with Pivot By Values
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About Filtering Data

You can use the Where and Having tabs to filter data in SAS Visual Data Builder.

The SQL expression on the Where tab is applied to the input data. This SQL expression 
is often used to subset data on the columns in the source tables.

The SQL expression on the Having tab can be applied to either the input data or the 
calculated columns. This SQL expression is typically used to subset data on calculated 
columns in the output table.

Specifying a WHERE Clause

To add a WHERE clause to a query:

1 Click the Where tab.
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2 On the Fields tab, expand the table node, and select the column to use for filtering 
data.

TIP You can type in Filter fields to locate the column.

3 Double-click the column or drag and drop it in the SQL expression area.

4 (Optional) You can click the Functions tab and select the functions to use with 
filtering.

5 For character variables, you can click Unique Values to load the unique values of 
the column. Select the check boxes to specify the unique values to include in the 
filter.

Click Apply to add the unique values to the SQL expression area.

6 Edit the WHERE clause in the SQL expression area as follows:

Number of Values Edit Example

A single character value Add an equal sign between 
the column name and the 
unique value.

CARS.Make = 'Acura'

More than one character 
value

Specify an IN operator and 
enclose the unique values in 
parentheses.

CARS.Make IN (
'Acura', 'Audi')

Numeric comparison Specify a numeric operator 
and a constant, or specify a 
numeric operator and 
another column name.

CARS.Cylinders >= 6

PRDSALE.Actual > PRDSALE.Estimate

7 Click  to save the filter with the query.
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Specifying a HAVING Clause

To add a HAVING clause to a query:

1 Click the Having tab.

2 On the Fields tab, expand the table node, and select the column to use for filtering 
data. The Output Columns node includes the calculated columns.

TIP You can type in Filter fields to locate the column.

3 Double-click the column or drag and drop it in the SQL expression area.

4 (Optional) You can click the Functions tab and select the functions to use with 
filtering.

5 For character variables, you can click Unique Values to load the unique values of 
the column. Select the check boxes to specify the unique values to include in the 
filter.

Click Apply to add the unique values to the SQL expression area.

6 Edit the HAVING clause in the SQL expression area as follows:

Number of Values Edit Example

A single character value Add an equal sign between 
the column name and the 
unique value.

CARS.Make = 'Acura'

More than one character 
value

Specify an IN operator and 
enclose the unique values in 
parentheses.

CARS.Make IN (
'Acura', 'Audi')
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Number of Values Edit Example

Numeric comparison Specify a numeric operator 
and a constant, or specify a 
numeric operator and 
another column name.

AVG(CARS.Horsepower) >= 165

PRDSALE.Actual > PRDSALE.Estimate

7 Click  to save the filter with the query.

Best Practices for Filters

SAS Visual Data Builder provides the Where and Having tabs for filtering data. Follow 
these best practices:

n Filter on the Where tab first because the WHERE clause reduces the rows to 
consider for further subsetting.

n When you specify a filter on a column that is an index or primary key, avoid using a 
function whenever it is possible. Using a function, such as CAST(order_id as 
DOUBLE), risks performing a full-table scan rather than using the index.

n Filter on the table that has the smallest number of rows first.

n If you need to remove a table that is used on the Where or Having tabs, then 
remove the reference to the table from the filters before you remove the table from 
the query. Otherwise, if you remove a table that is referenced in a filter, then all of 
the filtering conditions are cleared.
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About Joins

SAS Visual Data Builder supports joins for tables and subqueries. You can join tables to 
each other, including self joins. You can join subqueries to tables and join subqueries to 
subqueries. When you use a subquery in a join, the join condition is made against the 
output table for the subquery. The data builder supports joining up to 256 tables.

When you drop a table or subquery onto the workspace, the data builder attempts to 
determine a join condition automatically. When the data builder creates a join 
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automatically using foreign keys or by matching columns, the join is added as an inner 
join. The data builder also supports left, right, and full joins. You need to specify the join 
type manually if you do not want an inner join.

In addition to easily adding joins to a query, SAS Visual Data Builder generates an SQL 
statement with all of the joins declared explicitly. For example, you can specify an inner 
join in a WHERE clause, such as WHERE t1.order_id=t2.order_id. However, 
mixing inner joins in a WHERE clause and outer join types in a single query can be 
complex to read and understand.

SAS Visual Data Builder always generates an SQL statement with inner joins declared 
explicitly. For example, see the following code sample:

LEFT JOIN
        LIB1.TRANSACTION_TYPE_DIM TRANSACTION_TYPE_DIM 
            ON CASH_FLOW_FACT.TRANSACTION_TYPE_KEY = 
                TRANSACTION_TYPE_DIM.TRANSACTION_TYPE_KEY 
    INNER JOIN
        LIB1.TRANSACTION_DIM TRANSACTION_DIM 
            ON PARTY_DIM.SEGMENT_ID = TRANSACTION_DIM.SEGMENT_ID 
            AND PARTY_DIM.TRANSACTION_KEY = TRANSACTION_DIM.TRANSACTION_KEY

How Does the Automatic Join Feature 
Work?

Feature Overview

SAS Visual Data Builder attempts to join tables and queries automatically as you add 
them to the workspace. When you drag and drop a table or query onto the workspace, 
information about the table or query is retrieved from the SAS Metadata Server. For 
subqueries, the metadata for the output table is retrieved.

Using Foreign and Primary Keys

If primary key or foreign key information is registered in the metadata for the table that 
you drag and drop onto the workspace, then the data builder retrieves the foreign key 
and primary key information.
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The data builder then iterates over each of the tables that are already in the workspace 
in the same sequence in which they were added to the workspace. The data builder 
retrieves the foreign key and primary key information for the table, and compares the 
length, type, and name with the key columns for the newly added table. If a match is 
found, then the tables are used in the join, and the columns are added as a join 
condition. The data builder continues to search for matches between the two tables, and 
it adds join conditions when possible. After a set of join tables is identified, the data 
builder does not continue iterating over the tables that are already in the workspace.

Matching by Name

If there is no foreign key or primary key information for the table that is dragged and 
dropped onto the workspace, then the data builder does not use foreign key or primary 
key information for the tables already in the workspace.

The data builder retrieves the column information for all of the columns in the newly 
added table. The data builder then iterates over each of the tables that are already in 
the workspace in the same sequence in which they were added to the workspace. The 
data builder compares the length, type, and name for each column with each column in 
the newly added table. If a match is found, then the tables are used in the join, and the 
columns are added as a join condition. The data builder does not continue to search for 
matches between the two tables, and it does not continue iterating over the tables that 
are already in the workspace.

Selecting the Join Type

When the data builder finds the first set of matching columns by comparing keys or 
matching names, it sets the join type for the two tables. The data builder checks the 
metadata for the columns to determine whether the columns are nullable. The data 
builder performs the following steps to set the join type:

1 If the column for the existing table is not nullable, but the column for the newly added 
table is nullable, the tables use a left join.

2 If the column for the existing table is nullable, but the column for the newly added 
table is not nullable, the tables use a right join.
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3 If both columns for the existing table and newly added table are nullable, the tables 
use a full join.

4 If none of the previous conditions are met, the tables use an inner join.

You can specify the join type by right-clicking on the join icon, and selecting the join 
type from the menu.

Adding a Join

Dragging and Dropping Join Lines

To add a join by selecting a column name and dragging your pointer to another column:

1 Place your pointer on one of the columns in a table to use, and then click and drag 
your pointer to a column in the other table to use in the join.

2 If you want a join type other than an inner join, select the join, right-click, and then 
select the join type.

TIP The first table that is added to the workspace is always set as the left table. You 
can switch the right table and left table by using the Joins tab.

Using the Joins Tab

To add a join condition by specifying the join properties:

1 Click the Joins tab.

2 Click .

3 Use the menus to replace Not Selected with the table names to use in the join. Click 
Save.
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4 The default join type is an inner join. Use the menu in the Join Type column to 
select a different join type.

5 Click  in the Join conditions area.

6 Use the menus to replace Not Selected with the column names to use in the join 
condition. Click Save.

7 Click  to save the join condition with the query.

Removing a Join

You can remove a join by using either of the following methods:

n Select the join in the workspace, right-click, and select Remove Join Condition.

n Click the Joins tab, select the row in the table, and click .

Managing Joins in a Query

Once a join is added to a query, you can change the join by selecting it in the 
workspace, right-clicking, and changing the join type or removing the join condition.

You can also change a join by clicking the Joins tab, and then selecting the row in the 
table. You can make the following changes:

n add and remove tables from the join list

n reorder the sequence of joins by moving them up or down

n switch the left table and right table assignments for a join

n add, remove, and change the columns that are used in the join condition

The Joins tab shows the join condition for the entire query. Make sure that you select a 
row in the upper table to set the columns in the Join conditions area.
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The workspace shows a link between the tables that are used in a join. If you specify a 
left join or right join, the Venn diagram icon reflects which table provides the bulk of the 
data. If you rearrange the tables in the workspace (switching the left table and right 
table), the Venn diagram icon continues to reflect which table provides the bulk of the 
data. In order to change the data relationship, use either of the following methods:

n Switch the left table and right table by selecting a row from the table, and clicking .

n Change the join type from left to right or from right to left.

Best Practices for Managing Joins

In most cases, the sequence in which joins are specified on the Joins tab does not 
matter. However, it is possible that the query optimizer for the data source can perform 
the joins in a sequence that reduces performance. In these rare cases, you can change 
the sequence in which joins are specified on the Joins tab by selecting the join in the 
list, and clicking  or . This join sequence is still determined by the query optimizer, 
but you can control how the SQL for the join is presented to the query optimizer.
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Understanding Co-Located Data

One of the most powerful benefits of SAS LASR Analytic Server is the ability to read 
data in parallel from a co-located data provider. In this configuration, the SAS LASR 
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Analytic Server software is installed on the same hardware as the data provider. The 
currently supported data providers are the following:

n SAS High-Performance Deployment of Hadoop

n Teradata Data Warehouse Appliance

n Greenplum Data Computing Appliance

SAS Visual Data Builder excels at accessing data from a variety of data sources, 
performing analytic data preparation, and then staging the prepared data with a co-
located data provider. After the data is staged, the server can load the data to memory 
for exploration with SAS Visual Analytics Explorer.

The SAS Deployment Wizard registers a default library for the SAS LASR Analytic 
Server and a library for the co-located data provider. For the third-party vendor 
products, the default library name and location are as follows:

Teradata Data Warehouse Appliance
/Products/SAS Visual Analytics High-Performance Configuration/
Visual Analytics Teradata

Greenplum Data Computing Appliance
/Products/SAS Visual Analytics High-Performance Configuration/
Visual Analytics Greenplum

Using SAS Data in HDFS Libraries

Default Library

When your deployment includes SAS High-Performance Deployment of Hadoop, the 
SAS Deployment Wizard registers a library for it. This library is available for use in the 
SAS Folders tree, and it is located in /Products/SAS Visual Analytics High-
Performance Configuration/Visual Analytics HDFS.
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Staging Library

You can specify a SAS Data in HDFS library as a staging library. This is a common use 
because the rows for the output table are distributed among the machines in the cluster. 
The server can then read the data in parallel when it loads the table to memory.

You must specify a SAS LASR Analytic Server library for the output library when you 
use a SAS Data in HDFS library for staging.

Output Library

You can specify a SAS Data in HDFS library as an output library. The engine distributes 
the rows for the table to the machines in the cluster. Afterward, you can select the table 
from the SAS Folders tree, right-click, and select Load a Table. This menu option loads 
the table from HDFS to memory on a SAS LASR Analytic Server.

You can partition SAS Data in HDFS tables when they are used in an output library. 
You can select a column to use from the Partition by menu. Partitioning the table 
ensures that all of the rows with the same formatted value as the selected column are 
distributed to one machine in the cluster. The rows are also placed in the same HDFS 
block. When you load a partitioned table to memory, the partitioning information is 
retained, and the result is a partitioned in-memory table.

See Also
“Partitioning Tables” on page 87

Restrictions

The following restrictions apply to using SAS Data in HDFS libraries with SAS Visual 
Data Builder:

n You cannot specify a SAS Data in HDFS library as an input library because the SAS 
Data in HDFS engine is a Write-only engine.

n The Append data check box on the Properties tab is disabled. The SAS Data in 
HDFS engine does not support appending data.
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n If you specify a SAS Data in HDFS library as an output library, you cannot view the 
results on the Results tab because the SAS Data in HDFS engine is a Write-only 
engine.

Using SAS LASR Analytic Server 
Libraries

Default Library

During installation, the SAS Deployment Wizard registers a library for SAS LASR 
Analytic Server. This library is available for use in the SAS Folders tree, and it is located 
in /Products/SAS Visual Analytics Administrator/Visual Analytics 
LASR.

Input Libraries

When you select a SAS LASR Analytic Server table as an input table, be aware of the 
following best practices if the table is large. If the table is not large, then using it for input 
requires no special considerations.

Here are the considerations for using a large SAS LASR Analytic Server table as an 
input table:

n A WHERE clause is processed in memory by the server if no aggregations or joins 
are used. Specify a filter on the Where tab so that you use only the rows that you 
want.

n If you want to join the table, then design one query that copies the data to the same 
library as the table that you want to join it with. Specify a filter on the Where tab, if 
applicable. Then, design another query that performs the join.
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Output Libraries

Using a SAS LASR Analytic Server library for output is common for SAS Visual Data 
Builder. When you run the query, you can click  Explore Results to automatically 
select the table and explore it in SAS Visual Analytics Explorer.

You can use the Append data check box on the Properties tab to add rows to an in-
memory table. However, this option is not available if you use a SAS Data in HDFS 
library as a staging library.

Partitioning Tables

When you specify a SAS LASR Analytic Server or SAS Data in HDFS library as an 
output library, you can specify a partition key for the table. You can select a column to 
use from the Partition by menu.

Partitioning uses the formatted values of the partition key to group rows that have the 
same value for the key. All of the rows that have the same value for the key are loaded 
to a single machine in the cluster. For SAS LASR Analytic Server libraries, this means 
that the rows that have the same value for the key are in memory on one machine. For 
SAS Data in HDFS libraries, all of the rows that have the same value for the key are 
written to a single file block on one machine. (The block is replicated to other machines 
for redundancy.) When the partitioned table is loaded onto a server, the partitioning 
remains when it is in memory.

If you select a partition key and also specify sort options for columns on the Column 
Editor tab, the sort options are passed to the engine in an ORDERBY= option. This 
enhancement applies to SAS LASR Analytic Server and SAS Data in HDFS libraries 
and can improve performance once the data is in memory.

When you specify a partition key, avoid using a variable that has few unique values. For 
example, partitioning by a flag column that is Boolean results in all rows on two 
machines because only two values are available. At the other end of the spectrum, 
partitioning large tables by a nearly unique key results in many partitions that have few 
rows.
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Determining the optimal partition key can be a challenging task. However, as an 
example, if you tend to access data based on a customer ID, then you might improve 
performance by partitioning the data by customer.

See Also
SAS LASR Analytic Server: Administration Guide

Exploring Results

When you design a query that uses a SAS LASR Analytic Server library for the output 
table, and you run the query, the  Explore Results button becomes available. Click 
the button to access SAS Visual Analytics Explorer and the results of the query.

Loading a Table to SAS LASR Analytic 
Server

To load a table into memory on a SAS LASR Analytic Server:

1 Use the SAS Folders tree to locate the table.

TIP You can also click , and search for the table by name and location.

2 Select the table, right-click, and select Load a Table.
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Display 12.1 Load a Table Dialog Box

3 The fields in the Source Table section are filled automatically.

Specify the following settings in the dialog box:

Table 12.1 Load a Table Dialog Box Properties

Field Description

Name Enter the name to use for the table. This 
name is registered in metadata with the 
SAS LASR Analytic Server library.

Loading a Table to SAS LASR Analytic Server 89



Field Description

Description Enter a description of the data. This 
description is displayed by SAS clients such 
as SAS Visual Analytics Explorer.

Location Click Browse, and select a folder to use for 
the table metadata.

Library Click Browse, and select the SAS LASR 
Analytic Server library to use with the table.

4 Click Submit.

Monitoring Memory Usage

For deployments that use a distributed SAS LASR Analytic Server, a memory gauge is 
visible on multiple windows. You can use the gauge to make sure that you do not 
overload the server or the hardware. An example of the gauge is shown in Display 12.1 
on page 89.

The server rejects requests to add tables or append rows when 80% or more of the 
memory is used. (The default value for the server is 75%. SAS Visual Analytics 
deployments set the value at 80%.) System administrators can specify the value for the 
server with SAS Management Console.

See Also
SAS Visual Analytics: Administration Guide
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About the Import Data Features

Why Use the Import Data Features?

The import data features enable you to perform self-service, ad hoc data analysis. You 
can take a Microsoft Excel spreadsheet, delimited text file, or SAS data set from your 
desktop and transfer it to SAS LASR Analytic Server. Or, you can add the data as a 
SAS data set, a database table, or SAS Data in HDFS table.

If you have SAS data sets that are stored remotely with a SAS Application Server, you 
can load them to memory on SAS LASR Analytic Server.

The imported data can be used to enrich existing data that is already available in your 
SAS deployment. You can import data directly to memory on a SAS LASR Analytic 
Server.
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After the data is in memory, you can explore the data and create visualizations with 
SAS Visual Analytics Explorer. You can use the powerful reporting capabilities of SAS 
Visual Analytics Designer.

What is Local Data and Remote Data?

To understand the difference between local data and remote data, consider the 
following:

local data
is available from the file systems on your desktop. This includes local file systems 
such as C:\ on Windows machines and paths such as /home/$USER on UNIX 
machines. Network file systems and shares are also included, such as UNC paths 
like \\nas\spreadsheets.

remote data
is not available from the file systems on your desktop. You can direct the SAS 
Application Server to access the data that is available through file systems on the 
remote machine.

Default Values

The import data features for both local data and remote data are configured with default 
values to load data to SAS LASR Analytic Server.

If you want to use a library other than the default SAS LASR Analytic Server library, you 
can specify different values in the Advanced section of the import windows. You can 
specify a different SAS LASR Analytic Server library, a different library type (for 
imported local data only, imported remote data is restricted to SAS LASR Analytic 
Server libraries), and a different location for the table.

Importing Large Local Data Files

When you import local data (spreadsheets, SAS data sets, or delimited text files), 
memory on the client PC is used to access the data files. For data files that are larger 
than 1G, make sure that the client machine meets the following requirements:
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n The client machine should have at least 4G RAM. 8G is recommended.

n The client machine should use a 64-bit web browser and Adobe Flash Player.

Note: For a list of supported browsers, see http://support.sas.com/resources/
thirdpartysupport/v94/browsers.html.

When using a 64-bit web browser and Adobe Flash Player, the theoretical limit for 
importing local data files is 2G.

Note: Be aware that importing large local data files can require a long time to transfer 
and process the data. A progress indicator is provided to help you track the import.

Working with Spreadsheets

Multiple Worksheets

When you import a spreadsheet (from your PC) that has multiple worksheets, the data 
builder offers to append the worksheets into a single table. SAS no longer supports this 
feature in SAS Visual Analytics 6.2 because rows with column names on subsequent 
worksheets cause all of the variables to be read as character data.

If you have more than one worksheet, clear the Append worksheets together check 
box so that each worksheet is imported as a separate table. You can then create a 
query for each of the tables to append all table content to a single table and achieve the 
same outcome.

TIP When you append to tables, make sure that the column names, data types, and 
lengths all match.

Special Characters and Missing Values

When you import a spreadsheet that uses special characters or has missing values, 
keep in mind the following considerations:

n If the filename or worksheet names use special characters, the import can fail.

TIP Table names are restricted by the VALIDMEMNAME= SAS system option. 
Column names are restricted by the VALIDVARNAME= SAS system option.
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n If a column has no values, it is skipped during the import process.

n If a row has missing values, but the cells are formatted (for example, Text), the 
import can introduce an error. The data builder combines the row with missing 
values with values from the following row. You can avoid this problem by formatting 
the cells as General.

Pivot Tables

Importing pivot tables is not supported.

Importing Local Data

To import data from a spreadsheet, delimited text file, or SAS data set, follow these 
steps:

1 Select File  Import Local Data, and then select the data file.

2 In the Import Local Data window, specify the following input file parameters:

Note: For SAS data sets, there are no parameters to specify.

DelimiterApplies to CSV

Select the delimiter that is used in the text file to import. You can specify a single 
character to use as a user-defined delimiter.

Select worksheetApplies to XLS

Select All or the check boxes for the worksheets to import. For more information, 
see “Working with Spreadsheets” on page 93.

Note: Make sure that you clear the Append worksheets together check box. 
That feature is not supported in SAS Visual Analytics 6.2.

Use data in the first row as SAS variable names
Select this check box when the worksheet has the variable names in the first row. 
The variable names are retrieved from the first non-empty row.
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Trim spaces
Select this check box to remove leading spaces and trailing spaces from 
character variables.

Data records begin on row
The default is to import data records from the first row. If you select Use data in 
the first row as SAS variable names, then this value increments to 2. This 
check box is disabled if you import a spreadsheet and select multiple 
worksheets.

EncodingApplies to CSV

Select the encoding of the file. If you are importing UTF-8 or UTF-16 data, make 
sure the SAS Application Server is a Unicode server or that all of the file contents 
can be successfully transcoded to the encoding of the SAS Application Server. If 
you are importing a UTF-16 (big-endian or little-endian) file, make sure it contains 
a BOM (byte-order mark).

3 (Optional) Click Preview to view the data. You can preview delimited text files and 
spreadsheets only.

Preview displays up to 500 rows from the first 2 MB of the file.

4 Review the Advanced properties, and adjust them if needed.

Field Description

Name Specify a table name for the imported data.

Location Click , and select a metadata folder. The 
imported data is registered as a table in the 
specified location.

Library Click , and select the library in which to 
import the data.
If you select the Show SAS LASR Analytic 
Server libraries only check box, then the 
list is filtered to show those libraries only.

5 Click OK.
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Importing Remote Data

To import a SAS data set that is accessible from your SAS Application Server, follow 
these steps:

1 Select File  Import Remote Data, and then select the data file.

Note: Remember that the data files and directories are on the remote machine, not 
on your PC. In the Basic Properties table, the Date Created, Description, and 
Keywords fields are not used.

2 In the Import Remote Data window, review the Advanced properties, and adjust 
them if needed:

Field Description

Name Specify a table name for the imported data.

Location Click , and select a metadata folder. The 
imported data is registered as a table in the 
specified location.

Library Click , and select the library in which to 
import the data.

3 Click OK.
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About SAS Information Maps

A SAS Information Map is business metadata that is applied on top of the data sources 
in your data warehouse. (Metadata is information about the structure and content of 
data. An information map does not contain any physical data.) Information maps provide 
business users with a user-friendly way to query data and get results for themselves.

SAS Information Maps are created with either SAS Information Map Studio or the 
INFOMAPS procedure. SAS Visual Data Builder cannot create, edit, or save an 
information map. However, the data builder can import the business logic from a 
relational information map and represent it as SAS statements that use the SQL 
procedure.

See Also

Base SAS Guide to Information Maps
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Importing a SAS Information Map

To import a SAS Information Map:

1 Use the SAS Folders tree to locate the map ( ).

2 Select the map, right-click, and select Import Query.

A new query is created with the same name as the map. The output table is 
automatically set with the same name as the map.

The business logic is imported from the map and represented as SAS statements on 
the Code tab.

TIP If you want to join a table, save the query, and then create a new query and add 
it as a subquery.

See Also

“Customizing Code” on page 101

Limitations and Restrictions

SAS Visual Data Builder has the following limitations and restrictions for working with 
information maps:

n The information map cannot use more than 50 physical tables. A table that is used 
more than once in a self join counts as one physical table.

n The information map cannot use more that 5000 physical columns. A column that is 
used in more than one data item counts as one physical column.
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n Prompts are not supported. Even if a prompt has a default value, the default value is 
not included.

n Data items that are based on business data are not supported. For example, the 
equation Dataitem1 = Year + 2 (where Year is a data item) is not included in 
the query.

n Data items that are based on physical columns are not supported. For example, the 
equation Dataitem2 = FirstName || LastName (where FirstName and 
LastName are columns) is not included in the query.

n The output table is automatically named with the same name as the map. The name 
field is limited to 32 characters.
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Using the Code Tab

You can click the Code tab to view the SQL statements that are generated by the data 
preparation expressions on the Design tab.

The Code tab can also be used to enter custom code.

n The Preprocess and Postprocess views enable you to enter SAS statements that 
are run before and after the query runs.

n The All Code view shows the generated SQL statements. You can click the 
button to unlock the view so that you can manually edit all of the SAS statements for 
the query. After you have unlocked the view, the button icon changes to .

After you have unlocked the view, you cannot continue using the Design tab to edit the 
query, and the Preprocess and Postprocess views are disabled. However, if you have 
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not saved your changes to the code, you can click the  button to be able to use the 
Design tab.

Preprocess and Postprocess Code

In some cases, you might want to assign SAS options, load format catalogs, use 
LIBNAME statements, or run macros before running a query. You can unlock the code 
to enter the statements, but that prevents you from using the Design tab. However, the 
Preprocess view or Postprocess view might enable you to supplement the query while 
using the code generation features of the Design tab.

Any SAS statements that you enter in the Preprocess view or Postprocess view are 
included in the All Code view.

Considerations for Manually Editing 
Code

Before You Manually Edit Code

The code generation features in SAS Visual Data Builder can generate a lot of SAS 
statements with a few simple clicks. Depending on your needs, you might benefit by 
using the Design tab for adding input tables, performing joins, and filtering data before 
you customize the generated code.

The following features and settings must be specified before you unlock the code:

Unique values
Selecting this check box determines whether the DISTINCT keyword is included in 
the generated PROC SQL statement. After you unlock the code, the check box 
cannot be used to include the keyword.

Append data
Selecting this check box enables you to use the generated SAS statements for 
appending data to the output table before you unlock the code.
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Output table
You must specify the table name, location, and library, and you must save the query 
before you unlock the code. When you save the query, the metadata for the table is 
registered.

Use a staging table
Selecting this check box registers the metadata for the table when you save the 
query. Select the check box, specify the library, and save before you unlock the 
code.

Input and Output Libraries

When you unlock the code for manual editing, you must specify the libraries to use for 
your tables. You can do this with LIBNAME statements. If you dragged and dropped the 
tables onto the workspace before you unlocked the code for manual editing, the 
LIBNAME statements for the tables are automatically included.

See Also

n SAS Statements: Reference

n SAS/ACCESS for Relational Databases: Reference

Output and Staging Tables

Specify the table names, locations, and libraries on the Properties tab just as you do on 
the Design tab.

Note: Specify the tables and save the query before you unlock the code. If you do not 
specify the table name or the table name is already in use, you are not able to save the 
query.

See Also
SAS Language Interfaces to Metadata
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Validating Custom Code

If you entered SAS statements in the Preprocess or Postprocess views, those 
statements are not validated when you click .

If you unlock the code in the All Code view, the  button is disabled. You cannot 
validate customized code.
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About Scheduling Queries

How Does the Scheduling Feature Work?

When you have a query open in the workspace, you can click  to schedule the query. 
When you schedule a query, SAS Visual Data Builder performs the following 
operations:

1 Creates a job that performs the query operations.
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2 Creates a deployed job from the job.

3 Places the job into a new deployed flow.

4 Schedules the flow on a scheduling server.

You can use SAS Visual Data Builder to reschedule the query based on specified 
conditions (for example, run immediately or run whenever a trigger condition is met).

The job, deployed job, and deployed flow are metadata objects. The data builder stores 
them in the same metadata folder with the query. The metadata objects are named 
based on the following pattern:

vdb_query_id_timestamp

Editing Queries That Are Already Scheduled

If you edit a query that is already scheduled, you must click  again so that the SAS 
statements for the query are regenerated and saved.

Caution about Scheduling Queries to Run 
Now

When you schedule a query, one of the options is to run the query immediately. Select 
Run now in the Schedule window.

Performing the following steps results in an error condition:

1 Use a SAS data set for the output table of the query.

2 Run the query.

3 Click the Results tab to look at the output.

4 Schedule the query by selecting Run now.

These steps result in an error condition because SAS unlocks a SAS data set when it is 
opened for reading. When step 3 is performed, the output table is locked, and no other 
process can overwrite the output table. The following message is included in the SAS 
log:
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Locked Error Message

ERROR: A lock is not available for OUTPUTTABLE.

ERROR: Lock held by process xxxx.

You can avoid this error condition. If you want to schedule the query to run now, close 
the query, open it again, and then schedule it to run now. Alternatively, you can 
schedule the query to run in the future, and then close the query.

Scheduling Preferences

Default Scheduling Server

You can specify a different scheduling server in your application preferences. Any 
queries that you schedule after you specify a different scheduling server will use the 
new scheduling server.

Use the Server Manager plug-in to SAS Management Console to identify the scheduling 
servers that are included in your deployment. By default, your deployment includes a 
server that is named Operating System Services – hostname.example.com. 
This server is used as the default scheduling server.

The SAS Distributed In-Process Services Scheduling Server is an alternative server. To 
use this server, change the scheduling server. The default name is SAS Distributed 
In-Process Services Scheduling Server.

Some deployments include the Platform Suite for SAS server. To use this server, 
change the scheduling server. The default name is Platform Process Manager.

In all cases, when you schedule a new query, SAS Visual Data Builder retrieves your 
default scheduling server, and uses that value to look up the scheduling server in SAS 
metadata. The data builder uses the first server that matches the value in SAS 
metadata. Including the host name, such as Operating System Services – 
hostname.example.com ensures that the data builder uses the server that you specify.

Default Batch Server

You can specify a different batch server in your application preferences. Consider the 
following before you change the default batch server:
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n The batch server must be registered in metadata as a component of a SAS 
Application Server that you can access.

n You must specify the same SAS Application Server as your default application 
server in your preferences.

As with the default scheduling server, SAS Visual Data Builder retrieves your default 
batch server, and uses that value to look up the batch server in SAS metadata the first 
time you schedule the query. The data builder uses the first server that matches the 
value in SAS metadata.

Default Deployment Directory

A deployment directory is a SAS metadata object that represents the following items:

n the name of the SAS Application Server with which the deployment directory is 
associated (the default value is SASApp)

n a name for the deployment directory (the default value is Batch Jobs)

n the path to the deployment directory (the default value is SAS-config-dir/Lev1/
SASApp/SASEnvironment/SASCode/Jobs)

When you schedule a query, the SAS statements for the query are saved in a file. The 
file is saved in the path that is associated with the deployment directory. The file is 
named based on the same pattern that is described in “How Does the Scheduling 
Feature Work?” on page 105.

SAS Visual Data Builder retrieves your deployment directory, and uses that value to 
look up the deployment directory in SAS metadata the first time you schedule a query. 
The data builder uses the first server that matches the value in SAS metadata.

You can specify a different name for the default deployment directory. For more 
information about deployment directories and using the Server Manager plug-in to SAS 
Management Console, see Scheduling in SAS.

When Are the Scheduling Preferences Used?

Any of the preferences that you change are used the next time you create a query and 
schedule it. If you edit an existing query that is already scheduled, the existing settings 
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for the scheduling server, batch server, and deployment directory are not updated with 
the changes. To change the settings for existing queries that are already scheduled, 
use SAS Management Console to redeploy the deployed job for the query.

Creating Events

Why Use Events?

Events specify conditions that must be met before a step in the flow can take place. You 
can use SAS Visual Data Builder to create two types of events.

n Time events are evaluated based on a specified time being reached.

n File events are evaluated based on the state of a specified file.

You can create file events if your deployment includes a scheduling server that supports 
them, and the flow is deployed to that scheduling server. Time and file events can be 
used as triggers (conditions that must be met in order to run a flow on the scheduling 
server).

Creating a Time Event

You can create a time event and use it as a trigger.

To create a time event:

1 In the Schedule window, select Select one or more triggers for this query, and 
then click New Time Event.

2 In the New Time Event window, specify whether the time event should happen one 
time only or more than once. If the time event should happen one time only, specify 
the date and time for the time event.

3 If the time event should happen more than once, select More than once, and then 
select a radio button for how often the time event should repeat (such as hourly, 
weekly, or yearly).
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4 Specify the details of when the time event should repeat. The specific fields that are 
available depend on the recurrence interval that you select.

If the recurrence interval requires you to select start times, use the Hours and 
Minutes check boxes to select the times. The Minutes area contains groupings of 
10-minute intervals. Selecting a check box for a minute grouping selects all of the 
minutes in that grouping.

To select individual minutes, expand the grouping.

If you select multiple values for Hours, all of the selections for Minutes apply to all 
of the selected hours. For example, if you select 02:00 AM and 05:00 AM in the 
Hours area, and 43 in the Minutes area, the time event is scheduled for 2:43 AM 
and 5:43 AM.
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5 If needed, specify the start date and end date for the time event. The default is to 
start at the current date and time and not to have an end date.

Creating a File Event

You can create a file event and use it as a trigger. The file event can check for various 
file conditions, such as its existence, size, or age.

Note: Not all scheduling servers support file events. Platform Suite for SAS and the 
SAS Distributed In-Process Services Scheduling Server are two servers that do support 
file events. The New File Event button that is used to create a file event is available 
only when the scheduling server supports file events.

To create a file event:

1 In the Schedule window, select Select one or more triggers for this query, and 
then click New File Event.

2 In the New File Event window, specify or select the file to use for the file event.

3 Select the condition to evaluate the file to make the file event true. For example, if 
you selected not exist for the condition, the file event would be true only if the 
selected file was not in the specified location.

4 If needed, specify the details (such as size or age) about the condition.
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Exporting Queries as Jobs

For deployments that include SAS Data Integration Studio and prefer to deploy jobs, 
flows, and schedule flows manually, you can export a query as a job, and then perform 
the deployment steps.

This feature enables you to work with a query interactively while you design it, and then 
you can export the query as a job for automating the operations. After the job is 
exported, you can deploy the job for scheduling with SAS Data Integration Studio. For 
more information about deploying jobs, see Scheduling in SAS.

After a job is stored in metadata, you can open the job with SAS Data Integration Studio 
and edit it. This might be necessary if you need to add or remove columns or change 
the column expression in a calculated column.

If the deployment does not include SAS Data Integration Studio, then you can modify 
the query and export it as a job again. However, you cannot overwrite job objects in 
metadata with SAS Visual Data Builder. If you need to delete objects from metadata 
(such as jobs, libraries, or tables), use SAS Management Console.

To export a query as a job:

1 Use the SAS Folders tree to locate the query.

2 Select the query, right-click, and select Export as a job.

3 In the Export as a Job window, enter a name and specify a location. Click Export.

Additional Scheduling Resources

SAS Visual Data Builder provides an easy-to-use method for taking a query and making 
it available for scheduling as a flow. In addition, the Schedule Manager plug-in to SAS 
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Management Console provides additional resources for managing deployed flows, job 
dependencies, and scheduling servers.

For users that are familiar with the Schedule Manager plug-in, be aware that SAS Visual 
Data Builder does not support scheduling a query without a trigger. In the Schedule 
Manager plug-in, this option is specified as the Manually to the scheduling server 
option. If this is your preferred method for scheduling, you can use the Schedule 
Manager plug-in to modify the flow for the scheduled query. If you use SAS Visual Data 
Builder to schedule the query afterward, the setting is lost, and you will need to repeat 
your steps with the Schedule Manager plug-in.

See Also
Scheduling in SAS 
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About the Results Tab

After you have designed your query and clicked , the query runs, and you are 
prompted to determine whether you want to view the results.

If you click Yes, the data builder retrieves the data and shows you the results on the 
Results tab.

Note: For large data sets, retrieving and displaying the data can require a long time.

115



Data Pages

When you view data, a SAS server retrieves the data from the data set. Instead of 
returning all of the data, the data viewer requests a page of data. You can set the page 
size to between 20 and 2000 rows.

A slider is provided at the bottom of the Results tab so that you can navigate through 
the pages and browse the entire data set.

Navigate within the Data

Navigate to a row in the table by entering the row number in the Go to row field. The 
Go to first row and Go to last row buttons provide navigation to the first and last rows 
of the table.

Find

Search for text or numbers in the data set by clicking , typing in the Find field, and 
pressing Enter. The find feature searches through the rows in the data set for the value, 
and it highlights the first row with the value. You can navigate through the results by 
clicking Find next and Find previous.

Click  to set advanced find options. The following list identifies the options:

n Options tab

o Exactly matches the specified string

o Contains the specified string (default setting)

o Starts with the specified string
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o Case sensitive

o Trim leading and trailing spaces (default setting)

n Columns tab

Enable and clear check boxes to specify the columns to search.

Filter and Sort

Sort the data by clicking , and then choosing the columns and sort order. The 
Generated SQL statement field shows the sort criteria.

Filter the data by clicking , and setting the following options:

n The Sample tab is used to limit the number of rows to return or to select distinct 
values.

n The Row Filter table is used to subset data with a WHERE clause. You can filter on 
the values in multiple columns, set ranges for numeric values, and use IN and NOT 
IN criteria for character values. If the number of distinct values is less than 50, you 
can select check boxes for the values. If there are more than 50 distinct values, you 
must enter the values to use for filtering.

n The Column Filter tab is used to select the columns to display.

Export Data

You can save the data that you view as a comma-separated values file. After you click 
, you can choose to export the rows on the current data page, all of the rows, or a 

range of rows. The export feature has a limit of exporting 200,000 rows.

If you choose to export all of the data or a range of rows, you have to click Retrieve 
Data before you can click Export as CSV.
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Column Headings

Use the Headings menu to control the appearance of the column headings. You can 
view the column name from the data set, the column label from the data set, or a 
combination of the two. If a column does not have a label in the data set, then the 
column name is used.
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Overview of SAS Visual Analytics 
Explorer

What Is SAS Visual Analytics Explorer? . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Accessing the Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

The Welcome Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Your First Look at the Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

What Is SAS Visual Analytics Explorer?

SAS Visual Analytics Explorer (the explorer) is a component of SAS Visual Analytics 
that enables you to explore your data sources. You can explore your data by using 
interactive visualizations such as charts, histograms, and tables. You can also apply 
data analysis such as forecasting, correlation, and fit lines.

Your work in the explorer is saved as a metadata object called an exploration. An 
exploration (sometimes called a visual exploration) contains all of the visualizations, 
data settings, and filters from your explorer session.

You can use the explorer to explore in-memory tables from the SAS LASR Analytic 
Server. You can either open a table directly or you can open a saved exploration.

You can export your exploration results as reports, which can be refined in SAS Visual 
Analytics Designer (the designer) or viewed directly. Reports can be viewed on a mobile 
device or in the SAS Visual Analytics Viewer (the viewer).
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You can save your explorations as PDF documents, share your saved explorations via 
e-mail, and export your visualizations as image files. You can export the data from your 
visualizations to a data file that you can use in other tools.

Accessing the Explorer

You can access the explorer by using any of the following methods:

n On the SAS Visual Analytics home page, click Explore Data.

You can select a data source by using the Welcome window.

n On the SAS Visual Analytics home page, double-click on an exploration to open it in 
the explorer.

n Follow a link or enter the URL to access the explorer directly. For example, you 
might enter http://server.abc.com/SASVisualAnalyticsExplorer. 

After you have logged on to SAS Visual Analytics, you can choose a data source 
from the Welcome window.

n From an e-mail, follow a link directly to a specific exploration. After you have logged 
on to SAS Visual Analytics, the exploration opens in the explorer automatically.

The Welcome Window

If you enter the explorer without a reference to a specific exploration, then the Welcome 
window appears.
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Display 18.1 The Welcome Window

The Welcome window enables you to perform the following tasks:

n Create a new exploration by clicking Select a Data Source. The Open Data Source 
window appears. 

In the Open Data Source window, select the data source that you want to open, and 
then click Open.

In the Search field, you can enter a short string to find all of the data sources whose 
names or descriptions begin with that string.

Note: You can also perform a search that matches a string anywhere in the data 
source name. Select the Search field and then press CTRL+Down to switch the 
search to Search (contains).

n Open an existing exploration. Select from your recent explorations, or select any 
exploration by clicking Browse to locate the exploration.
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Your First Look at the Explorer

Here are the main parts of the explorer user interface:

Figure 18.1 The Explorer User Interface

1 The application bar provides access to the home page and recent explorations.

2 The menu bar offers common tasks, such as creating a new exploration.

3 The toolbar enables you to manage your explorations and visualizations.

124 Chapter 18 / Overview of SAS Visual Analytics Explorer



4 The Data pane enables you to manage the data that is used in your visualizations.

5 The data properties table enables you to set data item properties.

6 The workspace displays one or more visualizations.

7 The right pane’s tabs enable you to set properties and data roles , subset data, and 
use comments.

8 The dock contains any minimized visualizations.
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Specifying Preferences for SAS Visual 
Analytics Explorer

Specifying Global Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Specify Preferences That Are Specific to SAS 
Visual Analytics Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Specifying Global Preferences

See “Specifying Global Preferences” on page 16 for details about global preferences for 
SAS Visual Analytics.

Specify Preferences That Are Specific 
to SAS Visual Analytics Explorer

Here are the steps to specify preferences that are specific to SAS Visual Analytics 
Explorer (the explorer):

1 Select File  Preferences to open the Preferences window.

2 Select SAS Visual Analytics Explorer  General.

127



3 Select a Graph skin to change the visual effects that are applied to your graphs. For 
example, many of the Graph skin settings apply lighting effects to the features of 
your graph to create a 3-D appearance.

4 Select Visualization data threshold to specify the amount of data values that your 
visualizations can process. The precise amount of data that is supported varies 
depending on the visualization type. See Appendix 3, “Data Limits,” on page 503.

Note: A large value for Visualization data threshold might degrade your 
application performance or lead to time-out errors.

5 To return to the default settings, select Reset to Defaults.

6 Click OK to apply your changes. Your preferences persist between sessions.
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What Is an Exploration?

An exploration (sometimes called a visual exploration) is a metadata object that 
contains all of the visualizations and data settings from a SAS Visual Analytics Explorer 
(the explorer) session. You can use explorations to save your session for later and to 
share it with others.
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Create a New Exploration

To create a new exploration, select File  New Exploration from the menu bar. The 
Open Data Source window appears. Select your data source, and then click Open.

Saving Your Exploration

To save your current exploration, select File  Save As, and then select a location and 
a name.

Deleting Explorations

To delete an exploration, use the SAS Visual Analytics home page. See “Managing 
Content on the Home Page” on page 20.

Exploration Comments

About Exploration Comments

The explorer enables you to create and share comments about your explorations. The 
comments can be viewed in the explorer and on the SAS Visual Analytics home page.

In addition to exploration comments, you can create comments for specific 
visualizations. See “Manage Visualization Comments” on page 175.
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View Exploration Comments

To view the comments for the current exploration, select File  Exploration 
Comments. The comments are grouped by topic.

If there are many comments in a topic, then only the most recent comments are 
displayed. Click Show All Comments to view all of the comments for a topic.

To search the comments, enter a search term in the Search within comments field.

Create an Exploration Comment

Create a Comment under an Existing Topic

To create a comment under an existing topic:

1 Enter your comment text in the Respond to topic field that is beneath the topic that 
you want to comment on. 

2 (Optional) Click  to attach a file to the comment.

3 When you are finished with the comment, click Post. Your comment is saved and 
shared immediately.

Create a Comment under a New Topic

To create a comment under a new topic:

1 Enter the name of the topic in the Enter a topic name field.

2 Enter your comment text in the Enter a comment field. 

3 (Optional) Click  to attach a file to the comment.

4 When you are finished with the comment, click Post. Your comment is saved and 
shared immediately.
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Edit an Exploration Comment

To edit a comment, select the comment that you want to edit, and then click Edit.

Note: To edit other users’ comments, you must belong to the 
Comments:Administrator role.

Delete an Exploration Comment

To delete a comment, select the comment that you want to delete, and then click 
Delete.

Note: To delete comments, you must belong to the Comments:Administrator role.
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Managing Data Properties

Overview of Managing Data Properties

At any time after you have loaded a data source for your exploration, you can modify 
the properties of the data items. The changes that you make are saved as part of the 
exploration, but do not affect the original data source.

You can manage the properties for all of your data items by using the Data Properties 
window.

You can manage the properties for individual data items by using the Data pane.
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Manage Data Properties By Using the Data 
Properties Window

To access the Data Properties window, select Data  Data Properties from the menu 
bar.

For each data item, you can specify the following properties:

Name
specifies the name of the data item.

Role
specifies whether the data item is a category, a measure, or a geography.

Model Type
specifies the type of data model for a measure or for a category with datetime data. 
Select whether the data model is continuous or discrete.

The model type that you specify determines the type of data filters that you can 
create for the data item.

Note: If you change the model type for a data item that is used in a filter, then the 
filter is removed.

Format
specifies the data format for the data item.

See “Select a Numeric Format” on page 137 and “Select a Date or Time Format” on 
page 138 for information about specifying formats.

Aggregation (for measures only)
specifies the method that is used to aggregate values for the measure. Select one of 
the following aggregation types:

Sum
provides the sum of the values in the measure.

Average
provides the average of the values in the measure.
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Maximum
provides the maximum value in the measure.

Minimum
provides the minimum value in the measure.

Count
provides the number of nonmissing values in the measure.

Manage Data Properties By Using the Data 
Pane

You can manage data properties for a specific data item by selecting the data item in 
the Data pane and then interacting with the properties table at the bottom of the Data 
pane.

For a selected data item, you can specify the following properties:

Name
specifies the name of the data item.

Role
specifies whether the data item is a category, a measure, or a geography.

Model type
specifies the type of data model for a measure or for a category with datetime data. 
Select whether the data model is continuous or discrete.

The model type that you specify determines the type of data filters that you can 
create for the data item.

Note: If you change the model type for a data item that is used in a filter, then the 
filter is removed.

Format
specifies the data format for the data item.

See “Select a Numeric Format” on page 137 and “Select a Date or Time Format” on 
page 138 for information about specifying formats.
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Aggregation (for measures only)
specifies the method that is used to aggregate values for the measure. Select one of 
the following aggregation types:

Sum
provides the sum of the values in the measure.

Average
provides the average of the values in the measure.

Maximum
provides the maximum value in the measure.

Minimum
provides the minimum value in the measure.

Count
provides the number of nonmissing values in the measure.

Select a Numeric Format

Here are the steps to select a numeric format:

1 In the Data Properties window or in the property table in the Data pane, click the 
format for the data item. A window appears.

2 Select the basic format type from the Format list.

3 Specify the Width parameter for the format. The width of the format specifies the 
maximum number of characters that a value can contain, including decimal points.

A preview of your format appears in the Sample field.

4 Specify the number of Decimals for the format. The Decimals value specifies the 
number of digits that appear to the right of the decimal place.

A preview of your format appears in the Sample field.

5 Click OK to apply your format.
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Note: You can restore the default format by clicking Reset to Default.

Select a Date or Time Format

Here are the steps to select a date or time format:

1 In the Data Properties window or in the property table in the Data pane, click the 
format for the data item. A window appears.

2 Select the basic format type from the Format list.

3 If necessary, select a more specific format from the Sample list. The format names 
also represent sample values for the format.

4 Click OK to apply your format.

Note: You can restore the default format by clicking Reset to Default.

Note: Time and datetime values in the explorer ignore daylight-saving time.

Show and Hide Data Items

If your exploration contains a large number of data items, you might want to hide the 
items that you are not interested in.

Here are the steps to select which data items that are shown in the Data pane:

1 Select Data  Show or Hide Items from the menu bar. The Show or Hide Items 
window appears.

2 Click Select All to select or deselect all of the data items, or click the check box 
beside each data item to select whether that data item is shown.

3 Click OK to apply your changes.

138 Chapter 21 / Managing Data



Sort Data Items

To sort your data items in the Data pane, select  and then select Sort Items. Select 
Ascending by Name or Descending by Name.

Group Data Items

To group your data items in the Data pane, select , and then select Group Items. 
Select one of the following grouping types:

By First Letter
groups by the first letter of the data item name.

By Data Type
groups by data type (date, number, or text).

By Model Type
groups by model type (continuous or discrete).

By Role
groups by data role (category, geography, hierarchy, measure, or aggregated 
measure).

By Format
groups by data format (for example, $CHAR, Numeric, Percent, or MMMYYY).

By Aggregation
groups by the default aggregation (Sum, Average, Count, Minimum, or Maximum).

Note: The default grouping is By Role.

Assigning Colors for Category Values

About Colors

By default, the explorer assigns colors dynamically to category values for grouped 
visualizations. You can assign specific colors to your category values to ensure that the 
category values are always represented by a specific color.
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Assign Colors for a Category

Here are the steps to set the colors for a category:

1 Right-click on a category from the Data pane, and then select Colors. A color 
selection window appears.

2 For each category value to which you want to assign a color, select the value from 
the Choose drop-down list, and then click the color box to select a color. Click 
Apply to save your selection.

3 (Optional) To automatically assign persistent colors for all of the unassigned 
category values, click Assign remaining. Colors are assigned to all of the remaining 
category values. These colors are used consistently in all of your visualizations.

4 Click OK to apply your changes.

Reset Colors for a Category

Here are the steps to reset the colors for a category:

1 Right-click on a category from the Data pane, and then select Colors. A color 
selection window appears.

2 Click Reset all to clear all of the color assignments for the category.

3 Click OK to apply your changes.

Assign a Color for a Specific Category Value

Here are the steps to assign the color for a specific category value:

1 Within a grouped visualization, right-click on a data value, and then select Change 
Color.

2 Click the color box to select the color.

3 Click OK to apply the new color. This color value is used consistently for the 
selected category value in all of your visualizations.
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Open a Different Data Source as a New 
Exploration

To explore a different data source, create a new exploration by selecting File  New 
Exploration, and then select the data source that you want to explore.

Change the Data Source for Your 
Exploration

At any time, you can change the data source for your exploration. All of your 
visualizations, filters, and settings are applied to the new data source.

Here are the steps to change the data source for your exploration:

1 Select Data  Change Data Source.

2 From the Change Data Source window, select the data source that you want to use.

Note: If any data items in your current data source do not exist in the new data 
source, then a message appears. Any data items that do not exist in the new data 
source are removed from your exploration. Any filters, ranks, or calculated items that 
are based on the removed items are also removed.

3 Click Open to open the new data source.

Refresh Your Data Source

At any time, you can refresh your data source to include the latest changes.

To refresh your data, select Data  Refresh Data.
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Your visualizations are automatically updated with the refreshed data.

Creating Calculated Data Items

About Calculated Data Items

The explorer enables you to calculate new data items from your existing data items by 
using an expression.

Note: All calculations are performed on unaggregated data. The calculation expression 
is evaluated for each row in the data source before aggregations are performed.To 
perform calculations on aggregated data, see “Creating Aggregated Measures” on page 
144.

In addition to performing mathematical calculations on numeric values, you can use 
calculated data items to create date and time values. For example, if your data contains 
separate categories for month, day, and year, then you can calculate a date value from 
each category.

Create a Calculated Data Item

Here are the steps to create a calculated data item:

1 Select Data  New Calculated Item. 
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The New Calculated Item window appears.

Display 21.1 The New Calculated Item Window

2 Enter a Name for the calculated data item.

3 Select the data type for the calculated data item from the Result type drop-down 
list.

4 Build the expression for your calculated data item by dragging and dropping data 
items and operators onto the expression in the right pane. For each field in the 
expression, you can insert a data item, an operator, or a specific value.

Note: Derived data items are not supported for calculation expressions.
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When you drag and drop data items and operators onto the expression, the precise 
location of the cursor determines where and how the new element is added to the 
expression. As you drag the new element over the expression, a preview appears, 
which displays how the expression would change if you drop the element at the 
current location.

For example, if your current expression is ( Profit / Revenue ), and you drag 
the x - y (subtract) operator over the open parenthesis symbol, then the expression 
changes to ( [number] — ( Profit / Revenue )). If you drag the operator 
over the division symbol, then the expression changes to ( Profit — 
Revenue ).

There are a large number of operator types available to perform mathematical 
functions, process datetime values, and evaluate logical processing such as IF 
clauses. See Appendix 1, “Operators for Calculated Data Items,” on page 489.

5 When you are finished creating your expression, select the Default aggregation for 
the calculated data item, and then click Select to choose the data format.

6 Click Preview to see a preview of the calculated data item as a table. The table 
displays the values of the calculated item and any data items that are part of the 
calculation expression.

7 Click OK to create the new calculated data item. The new data item appears in the 
Data Items pane.

Creating Aggregated Measures

About Aggregated Measures

Aggregated measures enable you to calculate new data items by using aggregated 
values. For example, you might want to calculate a company’s profits by subtracting 
expenses from revenues.
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Note: To calculate data items by using unaggregated values, see “Creating Calculated 
Data Items” on page 142.

Aggregations are evaluated as part of the calculation expression. For each data item in 
your expression, you can select the aggregation type and the context for the 
aggregation.

Create an Aggregated Measure

Here are the steps to create an aggregated measure:

1 Select Data  New Aggregated Measure. 

The New Aggregated Measure window appears.

Display 21.2 The New Aggregated Measure Window

Creating Aggregated Measures 145



2 Enter a Name for the aggregated measure.

3 Build the expression for your aggregated measure by dragging and dropping data 
items and operators onto the expression in the right pane. For each field in the 
expression, you can insert a data item, an operator, or a specific value.

Note: You can create a new calculated item to use in the aggregated measure 
expression. Click New Calculated Item to create the new calculate item.

When you drag and drop items and operators onto the expression, the precise 
location of the cursor determines where and how the new element is added to the 
expression. As you drag the new element over the expression, a preview appears, 
which displays how the expression would change if you drop the element at the 
current location.

There are a large number of operator types available to perform mathematical 
functions and evaluate logical processing such as IF clauses. See Appendix 1, 
“Operators for Calculated Data Items,” on page 489.

4 For each data item in your expression, select an aggregation type. By default, Sum 
is used for measures and Distinct is used for categories. To select a new 
aggregation type, drag and drop an aggregated operator from the Operators list 
onto the aggregation type in the expression. See Appendix 1, “Operators for 
Calculated Data Items,” on page 489 for a list of the aggregated operators that are 
available.

5 For each aggregation in your expression, select the aggregation context. A drop-
down list beside each aggregation enables you to select one of the following context 
values:

ByGroup
calculates the aggregation for each subset of the data item that is used in a 
visualization. For example, in a bar chart, an aggregated measure with the 
ByGroup context calculates a separate aggregated value for each bar in the 
chart.
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ForAll
calculates the aggregation for the entire data item (after filtering). For example, in 
a bar chart, an aggregated measure with the ForAll context uses the same 
aggregated value (calculated for the entire data item) for each bar in the chart.

By using the ForAll and ByGroup contexts together, you can create measures that 
compare the local value to the global value. For example, you might calculate the 
difference from mean by using an expression like the following:

Avg ByGroup(X) - Avg ForAll(X)

6 When you are finished creating your expression, click Select to choose the data 
format.

7 Click OK to create the new aggregated measure. The new data item appears in the 
Data Items pane.

Support for Aggregated Measures

Aggregated measures can be used in the following visualization types:

n Automatic Chart

n Crosstab

n Bar Chart

n Bubble Plot (grouped bubble plots only)

n Line Chart

n Treemap

n Geo Map
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Using Distinct Counts

About Distinct Counts

You can derive the distinct count of a category or a date as a new aggregated measure. 
The aggregated measure does not contain data values in itself, but when it is used in a 
visualization, it displays the number of distinct values for the data item on which it is 
based.

For example, you might derive the distinct count of a category that contains city names. 
If you create a bar chart of the aggregated measure and a category that contains 
product lines, then the bar chart shows the number of cities where each product line is 
produced.

Figure 21.1 A Bar Chart with a Derived Distinct Count
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Derive the Distinct Count for a Category or 
Date

To derive the distinct count for a category or date, right-click on a category or date in the 
Data pane, and then select Derive Distinct Count. The derived measure appears 
automatically in the Data pane. The name of the aggregated measure is the same as 
the category or date on which it is based, with the suffix “(Distinct Count).”

Support for Aggregated Measures

Aggregated measures can be used in the following visualization types:

n Automatic Chart

n Crosstab

n Bar Chart

n Bubble Plot (grouped bubble plots only)

n Line Chart

n Treemap

n Geo Map

Explore Distinct Values in a Visualization

For bar charts, line charts, treemaps, and geomaps, you can right-click on a data point 
in the visualization, and then select Explore Distinct Values. When you explore the 
distinct values, a new bar chart is created. The new bar chart displays the values and 
the frequency of each value.

For example, you might use a derived measure to create a bar chart that displays the 
number of cities where each product line is produced:

Using Distinct Counts 149



Figure 21.2 Bar Chart of Cities by Product Line

Then, you might want to explore the distinct values for City where Promotional items are 
produced. By right-clicking on the bar for Promotional, and then selecting Explore 
Distinct Values, you get a new bar chart that contains the cities where promotional 
items are produced and the frequency of data for each city.
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Figure 21.3 Distinct Values of City for the Promotional Product Line

Using Percentages of Total

About Percentages of Total

You can derive the percentage of the total for a measure as a new aggregated 
measure. The aggregated measure does not contain data values in itself, but when it is 
used in a visualization, it displays the percentage of the total value for the measure on 
which it is based.

Note: The percentage of total is relative to the subset of data that is selected by your 
filters and ranks.

For example, you might derive the percentage of the total for a measure that contains 
revenue values. If you create a bar chart of the aggregated measure and a category 
that contains product lines, then the bar chart shows the percentage of total revenue for 
each product line.
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Figure 21.4 A Bar Chart with a Derived Percentage of Total

Derive the Percentage of Total for a Measure

To derive the percentage of the total for a measure, right-click on a measure in the Data 
pane, and then select Derive Percent of Total. The derived measure appears 
automatically in the Data pane. The name of the aggregated measure is the same as 
the measure on which it is based, with the suffix “(Percent of Total).”

Support for Aggregated Measures

Aggregated measures can be used in the following visualization types:

n Automatic Chart

n Crosstab

n Bar Chart
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n Bubble Plot (grouped bubble plots only)

n Line Chart

n Treemap

n Geo Map

Edit a Calculated or Aggregated Data 
Item

To edit a duplicate data item, an aggregated measure, a calculated data item, or a 
derived data item, select the item in the Data pane, and then select Data  Edit 
Selected Item from the main menu.

Delete a Calculated or Aggregated Data 
Item

To delete a duplicate data item, an aggregated measure, a calculated data item, or a 
derived data item, right-click on the data item in the Data pane, and then select Delete.

Note: If the deleted data item is used by a visualization, then a confirmation message 
appears. The deleted item is removed from the visualization.

Note: You cannot delete a data item that is included in a hierarchy. You must remove 
the data item from any hierarchies before you can delete it.
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Duplicate a Data Item

Duplicate data items enable you to use multiple copies of a measure that have different 
data formats or default aggregations. For example, you might want to use the Minimum 
and Maximum aggregations for a data item in the same visualization.

Here are the steps to duplicate a data item:

1 Right-click on a measure in the Data pane, and then select Duplicate Data Item. 
The New Duplicate Item window appears.

Note: You can also invoke the New Duplicate Item window by dragging and 
dropping the same data item onto a visualization more than once.

2 Enter a Name, a Format, and a Default aggregation for the duplicate data item.

3 Click OK to create the duplicate data item.

Define a Geography Data Item

About Geography Data Items

A geography data item is a category whose values are mapped to geographical 
locations or regions. Geography data items can be used with geo maps to visualize your 
data on a geographic map.

For example, if your data source contains a CountryName column that identifies 
countries, then you might create a geography data item for CountryName by using the 
predefined geographic role, Countries. See “Define a Geography Data Item By Using a 
Predefined Geographic Role” on page 155.

You might also create a customized geography data item to identify geographic 
information that is specific to your organization (for example, sales regions, warehouse 
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locations, oil platforms, and so on). See “Define a Geography Data Item By Using a 
Custom Geographic Role” on page 156.

Note: For predefined geographic roles, the values of your geography data items must 
match the lookup values that are used by SAS Visual Analytics. To view the lookup 
values, see http://support.sas.com/va62geo.

Define a Geography Data Item By Using a 
Predefined Geographic Role

Here are the steps to define a geography data item by using a predefined geographic 
role:

1 In the Data pane or in the Data Properties window, locate a category that contains 
geographic information.

2 Change the role for the category to Geography. The Geography Role window 
appears.

3 Select the predefined geographic role for your category:

Countries
specifies country names.

US States
specifies the names of states and territories in the United States.

US States Abbreviated
specifies the two-letter postal codes for states and territories in the United States.

US ZIP Codes
specifies five-digit ZIP codes for the United States.

4 Click OK to apply your changes.

Define a Geography Data Item 155



Define a Geography Data Item By Using a 
Custom Geographic Role

Here are the steps to define a geography data item by using a custom geographic role:

1 In the Data pane or in the Data Properties window, locate a category that contains 
geographic information.

2 Change the role for the category to Geography. The Geography Role window 
appears.

3 Select Custom, and then specify the following:

Latitude
specifies a measure from your current data source that contains the latitude (Y) 
coordinate values for the geographic role that you want to define.

Longitude
specifies a measure from your current data source that contains the longitude (X) 
coordinate values for the geographic role that you want to define.

Coordinate Space
specifies the coordinate space (coordinate system) that is used to project the 
longitude and latitude coordinate values.

4 Click OK to apply your changes.
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Overview of Visualizations

About Visualizations

SAS Visual Analytics Explorer (the explorer) displays data by using visualizations. A 
visualization is an interactive visual representation of your data. A visualization can be a 
table, a crosstab, a chart, a histogram, or a geographic map.

Visualization Types

You can assign any of the following types to your visualizations:
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Automatic 
Chart

Automatically selects the chart type 
based on the data that is assigned to 
the visualization. When you are first 
exploring a new data set, automatic 
charts give you a quick view of the 
data.
For more information, see “Working 
with Automatic Charts” on page 186.

Table Displays the data as a table. Tables 
enable you to examine the raw data 
for each observation in the data 
source. You can rearrange the data 
columns and apply sorting.
For more information, see “Working 
with Tables” on page 194.
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Crosstab Displays the data as a crosstab. 
Crosstabs enable you to examine the 
data for intersections of hierarchy 
nodes or category values. You can 
rearrange the rows and columns and 
apply sorting. Unlike tables, 
crosstabs display aggregated data.
For more information, see “Working 
with Crosstabs” on page 195.

Bar Chart Displays the data as a bar chart. Bar 
charts are useful for comparing data 
that is aggregated by the distinct 
values of a category.
A bar chart consists of vertical bars 
or horizontal bars. You can apply 
grouping and create lattices.
For more information, see “Working 
with Bar Charts” on page 187.
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Line Chart Displays the data as a line chart. A 
line chart is useful for data trends 
over time.
You can apply grouping and create 
lattices.
For more information, see “Working 
with Line Charts” on page 190.

Scatter 
Plot

Displays the data as a scatter plot. 
Scatter plots are useful to examine 
the relationship between numeric 
data items.
In a scatter plot, you can apply 
statistical analysis with correlation 
and regression. Scatter plots support 
grouping.
When you apply more than two 
measures to a scatter plot, a scatter 
plot matrix compares each pairing of 
measures.
For more information, see “Working 
with Scatter Plots” on page 197.
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Bubble 
Plot

Displays the data as a bubble plot. A 
bubble plot displays the relationships 
among at least three measures. Two 
measures are represented by the 
plot axes, and the third measure is 
represented by the size of the plot 
markers.
You can apply grouping and create 
lattices. By assigning a datetime data 
item to the plot, you can animate the 
bubbles to display changes in the 
data over time.
For more information, see “Working 
with Bubble Plots” on page 199.

Histogram Displays the data as a histogram. A 
histogram displays the distribution of 
values for a single measure.
You can select the bar orientation, 
and you can select whether the 
values are displayed as a 
percentage or as a count.
For more information, see “Working 
with Histograms” on page 203.
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Box Plot Displays the data as a box plot. A 
box plot displays the distribution of 
values for a single measure using a 
box and whiskers. The size and 
location of the box indicate the range 
of values that are between the 25th 
and 75th percentile. Additional 
statistical information is represented 
by other visual features.
You can create lattices, and you can 
select whether the average (mean) 
value and outliers are displayed for 
each box.
For more information, see “Working 
with Box Plots” on page 204.

Heat Map Displays the data as a heat map. A 
heat map displays the distribution of 
values for two data items using a 
table with colored cells. If you do not 
assign a measure to the Color data 
role, then a cell’s color represents 
the frequency of each intersection of 
values. If you assign a measure to 
the Color data role, then a cell’s 
color represents the measure value 
of each intersection of values.
For more information, see “Working 
with Heat Maps” on page 207.
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Geo Map Displays the data as a geo map. A 
geo map displays your data as an 
overlay on a geographic map. You 
can display your data either as 
bubbles or as colored regions.
For more information, see “Working 
with Geo Maps” on page 210.

Treemap Displays the data as a treemap. A 
treemap displays your data as a set 
of rectangles (called tiles). Each tile 
represents a category value or a 
hierarchy node. The size of each tile 
represents either the frequency of 
the category or the value of a 
measure. The color of each tile can 
represent the rectangles can indicate 
the value of an additional measure.
For more information, see “Working 
with Treemaps” on page 212.
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Correlation 
Matrix

Displays the data as a correlation 
matrix. A correlation matrix displays 
the degree of correlation between 
measures as a series of colored 
rectangles. The color of each 
rectangle indicates the strength of 
the correlation.
For more information, see “Working 
with Correlation Matrices” on page 
214.

Decision 
Tree

Displays the data as a decision tree. 
A decision tree displays a series of 
nodes as a tree, where the top node 
is the target data item, and each 
branch of the tree represents a split 
in the values of a predictor data item.
The splits enable you to see which 
values of the predictor data item 
correspond to different distributions 
of values in the target data item.
For more information, see “Working 
with Decision Trees” on page 216.
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Working with Visualizations

Create a New Visualization

To create a new visualization, click  on the toolbar, or select Visualization  New 
from the menu bar.

Manage Visualizations

Delete a Visualization

To delete a visualization, click the  button on the visualization, or select Visualization 
 Delete from the menu bar to delete the selected visualization.

You can delete all of your visualizations by selecting View  Delete All Visualizations.

Duplicate a Visualization

To duplicate a visualization, select Visualization  Duplicate from the main menu, or 
select the  drop-down list from the visualization toolbar, and then select Duplicate.

The new visualization is named “Copy of visualization-name”. You can enter a new 
name on the Properties tab.

Show and Minimize Visualizations

To minimize a visualization, click  in the visualization that you want to minimize. The 
visualization appears in the dock pane at the bottom of the workspace.

To restore a visualization, click the name of the visualization in the dock pane.

You can select which visualizations are visible by using the Manage Visualizations 
window.

To minimize all visualizations, select View  Minimize All Visualizations from the 
menu bar.
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To show all visualizations, select View  Show All Visualizations from the menu bar.

Maximize a Visualization

To maximize a visualization to fill the entire workspace, click  in the visualization that 
you want to maximize. To return the visualization to its normal size, click .

Arrange the Visualizations in the Workspace

Move the Position of a Visualization

To move a visualization, drag and drop the title bar of the visualization on the location 
where you want to place the visualization.

When you drag and drop a visualization onto another visualization, the placement of the 
visualization is determined by the edge that is closest to the drop point.

Suppose your workspace contains two visualizations named “A” and “B”. If you drag A 
to the left edge of B, then A is placed to the left of B. If you drag A to the bottom edge of 
B, then A is placed below B.
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Display 22.1 shows an example layout with four visualizations.

Display 22.1 Example Layout with Four Visualizations
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Display 22.2 shows the effect of moving Visualization 4 to the right edge of Visualization 
1.

Display 22.2 Example Layout After Moving 4 to the Right Edge of 1

When your workspace contains visualizations in multiple rows, if you drag and drop a 
visualization onto the bottom edge or top edge of a visualization, then the target 
visualization and the moved visualization split the space that was previously occupied 
by the target visualization.
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Display 22.3 on page 172 shows the effect of moving a visualization to the bottom edge 
of another visualization.

Display 22.3 Example Layout After Moving 4 to the Bottom Edge of 1

Resize a Visualization

To resize a visualization in your workspace, drag the resizing tab  at the bottom 
edge or the right edge of the visualization that you want to resize.
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Using the Manage Visualizations Window

The Manage Visualizations window enables you to manage all of your visualizations 
together. Each visualization is represented by a thumbnail image or by an icon of the 
visualization type if the visualization has not been displayed in the current session.

To open the Manage Visualizations window, select View  Manage Visualizations 
from the main menu bar.

Figure 22.1 The Manage Visualizations Window
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The Manage Visualizations window enables you to perform the following tasks:

Task Action

Add visualizations to the selection list.
(Restore visualizations.)

Select a visualization from the Available list, 
and then click , or click  to add all of the 
available visualizations.

Remove visualizations from the selection list.
(Minimize visualizations.)

Select a visualization from the Selected list, 
and then click , or click  to remove all of 
the visualizations.

Change the order of the selected 
visualizations.

In the Selected list, drag and drop the 
visualizations in the order that you want, or 
select a visualization and click the up and 
down arrows to move it.

Search the available visualizations. In the Search field, enter a string to search 
for. A visualization matches the search if the 
string appears anywhere in the visualization 
name.
Only the matching visualizations appear in 
the Available list.

Filter the available visualizations. Click , and then select your filter 
parameters. You can filter either on the 
visualization type or on the data items that 
are used in each visualization.
Only the matching visualizations appear in 
the Available list.

Rename a visualization. Right-click on any visualization, and then 
select Rename. Enter a new name, and then 
click OK.

Delete a visualization. Right-click on any visualization, and then 
select Delete.
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Manage Visualization Comments

About Visualization Comments

The explorer enables you to create and share comments about your visualizations.

In addition to visualization comments, you can create comments for the current visual 
exploration. See “Exploration Comments” on page 130.

View Visualization Comments

To view the comments for a visualization, select the Comments tab from the right pane. 
The comments are grouped by topic.

If there are many comments in a topic, then only the most recent comments are 
displayed. Click Show All Comments to view all of the comments for a topic.

To search the comments, enter a search term in the Search within comments field.

Create a Visualization Comment

Create a Comment under an Existing Topic

To create a comment under an existing topic:

1 Enter your comment text in the Respond to topic field that is beneath the topic that 
you want to comment on. 

2 (Optional) Click  to attach a file to the comment.

3 When you are finished with the comment, click Post. Your comment is saved and 
shared immediately.

Create a Comment under a New Topic

To create a comment under a new topic:
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1 Enter the name of the topic in the Enter a topic name field.

2 Enter your comment text in the Enter a comment field.

3 (Optional) Click  to attach a file to the comment.

4 When you are finished with the comment, click Post. Your comment is saved and 
shared immediately.

Edit a Visualization Comment

To edit a comment, select the comment that you want to edit, and then click Edit.

Note: To edit other users’ comments, you must belong to the 
Comments:Administrator role.

Delete a Visualization Comment

To delete a comment, select the comment that you want to delete, and then click 
Delete.

Note: To delete comments, you must belong to the Comments:Administrator role.

Managing Visualization Data Roles

Add a Data Item

For a visualization to display data, you must assign data items to it. You can assign data 
items to a visualization by performing any of the following actions:

n Drag and drop the data item onto the center of the visualization. The data item is 
assigned to a role automatically. If the visualization already has data items assigned 
to the required roles, then you can choose how to assign the new data item.
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n Drag and drop the data item onto a Measure or Category button in the visualization 
to assign the data item to a specific data role.

n From the visualization toolbar, select the  drop-down list, and then select Add 
Category or Add Measure.

n Use the Roles tab in the right pane. Either drag and drop a data item onto a role, or 
select Add from the drop-down list, and then select a data item.

Each visualization requires a minimum number of each type of data item. The following 
table lists the requirements for each visualization:

Table 22.1 Required Data Items for Visualizations

Visualization Type Requirements

Automatic Chart one data item of any type

Table one data item of any type (except aggregated 
measure)

Crosstab one data item of any type

Bar Chart one category or hierarchy

Line Chart one category or hierarchy

Scatter Plot one measure

Bubble Plot three measures

Histogram one measure

Box Plot one measure

Heat Map two data items of any type (except 
aggregated measure)

Geo Map one geography

Treemap one category or hierarchy
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Visualization Type Requirements

Correlation matrix two measures

Decision tree two data items of any type (except 
aggregated measure)

Replace a Data Item

You can replace a data item by using any of the following methods:

n Drag and drop the new data item from the Data pane onto the data item in the 
visualization that you want to replace.

n Right-click on the data item that you want to replace in either the visualization or on 
the Roles tab, and then select Replace item-name  new-item-name.

Remove a Data Item

You can remove a data item by using any of the following methods:

n Drag and drop the data item from the visualization onto the Data pane.

n Select the  drop-down list from the visualization toolbar, and then select Remove 
 item-name .

n Right-click on the data item that you want to delete in either the visualization or on 
the Roles tab, and then select Remove item-name.

Switch Data Roles

To switch the data items that are assigned to two roles, drag and drop one data item 
onto another data item either by using the buttons in the visualization or by using the 
fields on the Roles tab.

For example, you can switch the axes of a scatter plot by dragging the measure on the 
X axis to the measure on the Y axis.
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Working with Filters

You can use the Filters tab to subset the data in your visualizations. See Chapter 23, 
“Working with Filters,” on page 223.

Ranking Data

Overview of Ranking

You can use the Ranks tab to create ranks to subset the data in your visualizations. A 
rank selects either the top (greatest) or the bottom (least) aggregated value for a 
category.

A rank selects values for a category based on either the frequency of the category 
values or the aggregated value of a measure.

For example, you might create a rank of the top 10 countries by frequency to select the 
10 countries that are most represented in your data source. As another example, you 
might create a rank of the top 10 countries by population to select the 10 countries with 
the greatest population.

Note: If the category for the rank is part of a hierarchy that is used in the current 
visualization, then the rank can be edited only when the hierarchy is drilled to the level 
of the rank category.

Create a New Rank

To create a rank:

1 From the Data pane, select the data item that you want to use as the base of the 
rank. You can select any category or geography data item, regardless of whether it 
is assigned to the current visualization.
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2 Either right-click on the data item, and select Add as Rank, or drag and drop the 
data item onto the Ranks tab.

3 Set the parameters for the rank:

a Select the type of rank from the drop-down list. Top specifies that the rank 
selects the greatest value. Bottom specifies that the rank selects the least value.

b Specify the number of values for the rank. For example, if you specify 5, and you 
select Top as the rank type, then the rank selects the five greatest values.

c From the By drop-down list, select the measure that is used to create the rank. 
You can either select any measure, or select Frequency to use the frequency of 
the rank category.

Note: If you select a measure that is used in the current visualization, then the 
rank uses the same aggregation for the measure that is used by the current 
visualization.

d (Optional) Select Ties to include ties in the rank. 

If you select Ties, then the rank selects as many values as necessary to include 
all of the ties. If you do not select Ties, then the rank selects only the number of 
values that are specified by the rank parameters.

For example, if your rank selects the top three values, but there are five values 
tied for the greatest value, then the number of values that are selected by the 
rank depends on the Ties option. If you select Ties, then the rank includes all 
five of the tied values. If you do not select Ties, then the rank includes only three 
of the tied values.

Note: If the ranking does not select all of the tied values, or if the number of tied 
values exceeds the maximum that is set by your administrator, then a message 
appears.

Note: By default, your filter changes are applied automatically to the current 
visualization. To apply multiple changes together, deselect Auto, and then click 
Apply when you are ready to apply your filter changes.
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Delete a Rank

To delete a rank, click  on the rank on the Ranks tab.

Working with Visualization Data Ranges 
and Color Gradients

Support for Customized Data Ranges and 
Color Gradients

The following visualization types enable you to customize the data range and color 
gradient:

n Heat map

n Geo map (with the Color role assigned)

n Bubble plot (with continuous data assigned to the Color role)

n Treemap (with the Color role assigned)

Specify a Custom Color Gradient

To specify a custom color gradient:

1 Right-click on the color gradient in the legend, and then select Configure Color 
Gradient.

2 From the Select Color Gradient window, select a color gradient from the Color 
gradient drop-down list.

3 Click OK to apply the new color gradient.
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Specify a Custom Data Range

To specify a custom data range:

1 Right-click on the color gradient in the legend, and then select Configure Color 
Gradient.

2 From the Select Color Gradient window, deselect Automatically adjust color 
range to data.

3 In the Lower field, specify the lower bound for the data range.

4 If the selected color gradient uses three colors, specify the inflection point of the 
gradient in the Inflection field, or select Use midpoint to use the midpoint between 
the lower and upper values as the inflection point. The inflection point is the point for 
the middle color in a three-color gradient.

5 In the Upper field, specify the upper bound for the data range.

6 Click OK to apply the new color gradient.

Share a Color Gradient and Data Range 
between Visualizations

To share data ranges and color gradients between visualizations, all of the 
visualizations must support customized data ranges. See “Support for Customized Data 
Ranges and Color Gradients” on page 181.

To share a data range and color gradient between visualizations:

1 If the data range has not been customized, then right-click on the legend for the 
color gradient and data range that you want to share, and then select Lock Data 
Range.
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2 Right-click on the legend for the color gradient and data range that you want to 
share, and then select Transfer Configuration. The Select compatible 
visualizations window appears.

3 Select the visualizations that you want to share the color gradient and data range 
with. The visualizations are sorted based on their similarity to the source 
visualization. Visualizations that use the same data items and visualizations that are 
the same type are shown at the top of the list.

4 When you are finished, click OK to apply the color gradient and data range to all of 
the selected visualizations.

Remove Customized or Shared Color Data 
Ranges

To remove a customized or shared data range from a visualization, right-click on the 
legend, and select Remove Custom Data Range.

Working with Data Brushing

Overview of Data Brushing

Data brushing is a feature of some visualizations that enables you to select data values 
in one visualization and highlight the corresponding data values in all of your other 
visualizations.

For example, you might have a bar chart and a scatter plot in your exploration. If you 
enable data brushing, and you select a bar in the bar chart, then the markers in the 
scatter plot that correspond to the selected value in the bar are highlighted.
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Figure 22.2 Data Brushing Example

The following visualization types support data brushing:

n Bar chart

n Line chart

n Scatter plot

n Bubble plot (if the Group role is assigned)

n Histogram

n Heat map (if categories are assigned to both axes)

n Geo map

n Treemap

For histograms and for bar charts of frequency that are not grouped or latticed, data 
brushing can indicate the portion of a bar that corresponds to the brushed data. The bar 
is highlighted and then partially shaded to indicate the corresponding portion. The value 
for the shaded portion of the bar is included in the data tip for the bar.
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In Figure 22.3 , a selection in a bubble plot highlights a portion of the corresponding bar 
in a bar chart.

Figure 22.3 Data Brushing with Partial Shading

For bar charts that have a measure assigned or that are grouped or latticed, the entire 
bar is highlighted.

Enable Data Brushing

To enable data brushing, select View  Data Brushing.

Select Values in a Visualization

You can select values in your visualization by using any of the following methods:

n Click the data values. This is most useful for bar charts, histograms, and treemaps. 
To select multiple data values, hold down the Ctrl key while clicking each data value.
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n Click and drag to select data values in a rectangular region. This is most useful for 
scatter plots and heat maps. 

n Select data values in the table view for the visualization. Press Shift+click to select 
multiple adjacent values, or press Ctrl+click to select or deselect individual values.

Working with Automatic Charts

Automatic charts display different types of charts automatically based on the data items 
that are assigned to the chart.

The type of chart can be any of the following:

Table 22.2 Automatic Chart Types

Data Items Chart Type

One measure Histogram

One category Bar chart 

One aggregated measure Crosstab

One datetime category and any number of 
other categories or measures

Line chart 

One geography and up to two measures Geo map 

One geography and three or more measures Bar chart 

Two measures Scatter plot or heat map 

Three or more measures Scatter plot matrix or correlation matrix 

One or more categories and any number of 
measures and geographies

Bar chart 
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Note: The Roles tab for an automatic chart always contains Categories and 
Measures. To set advanced data roles such as grouping and lattices, change the 
visualization type to select the specific chart type that you want. For example, if your 
automatic chart shows a bar chart, then change the type to Bar Chart to enable 
advanced data role settings.

Working with Bar Charts

About Bar Charts

A bar chart displays data by using bars. The height of each bar represents the value.

Specify Properties for a Bar Chart

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the response axis.

Bar direction
specifies whether the bars are vertical or horizontal.

Frequency
specifies whether the frequency is displayed as a count (Count) or as a percentage 
(Percent).
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Note: The frequency values are based on the data that is shown in the visualization 
(after filters and other data selections have been applied).

Note: This option has no effect if a measure is assigned to the visualization.

Grouping style
specifies how grouped data is displayed. If you select Stack, then the values of the 
grouping variable are displayed as segments of each bar. If you select Cluster, then 
each value of the grouping variable is displayed as a separate bar.

Note: This option is disabled if no data item is assigned to the Group role.

Measure layout
specifies whether the measures share a single response axis (Shared axis) or have 
separate response axes for each measure (Separate axes).

Note: The Measure layout option is disabled if your visualization contains exactly 
one measure.

Overview
specifies whether the chart overview is enabled.

Show data values
shows the data values as text in the visualization.

Note: You can always view a data value as a data tip when you position the cursor 
over a data value.

Rotate axis labels
displays the category labels at an angle.

Note: The Rotate axis labels option has no effect when you select a horizontal bar 
orientation.

Data Roles for a Bar Chart

The basic data roles for a bar chart are categories and measures. You can assign one 
category only, and the category values are plotted on the category axis. You can assign 
many measures, and the measure values are plotted on the response axis. If a bar 
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chart contains no measures, then the frequency of the category values is plotted on the 
response axis.

In addition to the basic data roles, you can assign these roles:

Group
groups the data based on the values of the category data item that you assign. 
Depending on the value that you selected for the Grouping style property, the 
group values are shown as either individual bars or as segments of each bar.

Note: Grouping is not available if you assign multiple measures to the visualization.

Lattice columns
creates a lattice of charts with a column for each value of the category data item that 
you assign.

Lattice rows
creates a lattice of charts with a row for each value of the category data item that 
you assign.

Sort Data Values

By default, a bar chart is sorted in descending order by the value of the first measure. 
To change the sorting, right-click on the data item that you want to sort on, and then 
select Sort  [sort-method]. For a grouped bar chart, the data is sorted by the 
category values in alphabetical order.

Note: If the visualization contains a rank, then, by default, the data is sorted based on 
the values of the rank.
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Working with Line Charts

About Line Charts

A line chart displays data by using a line that connects the data values. If you assign 
multiple measures to a line chart, then you can create separate Y axes for each 
measure.

Specify Properties for a Line Chart

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the response axis.

Frequency
specifies whether the frequency is displayed as a count (Count) or as a percentage 
(Percent).

Note: The frequency values are based on the data that is shown in the visualization 
(after filters and other data selections have been applied).

Note: This option has no effect if a measure is assigned to the visualization.
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Measure layout
specifies whether the measures share a single response axis (Shared axis) or have 
separate response axes for each measure (Separate axes).

Note: The Measure layout option is disabled if your visualization contains exactly 
one measure.

Overview
specifies whether the chart overview is enabled.

Show markers
shows markers for the data points in the visualization.

Show data values
shows the data values as text in the visualization.

Note: You can always view a data value as a data tip when you position the cursor 
over a data value.

Rotate axis labels
displays the category labels at an angle.

Duration (if forecasting is enabled)
specifies the number of data intervals to forecast.

Note: This option is available only if forecasting is enabled for the visualization.

Data Roles for a Line Chart

The basic data roles for a line chart are categories and measures. You can assign one 
category only, and the category values are plotted on the category axis. You can assign 
many measures, and the measure values are plotted on the response axis. If the line 
chart contains no measures, then the frequency of the category values is plotted on the 
response axis.

In addition to the basic data roles, you can assign these roles:

Group
groups the data based on the values of the category data item that you assign. A 
separate line is created for each data value.
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Note: Grouping is not available if you assign multiple measures to the visualization.

Lattice columns
creates a lattice of charts with a column for each value of the category data item that 
you assign.

Lattice rows
creates a lattice of charts with a row for each value of the category data item that 
you assign.

Underlying factors
if forecasting is enabled, adds additional measures to the forecast as underlying 
factors. The forecasting model evaluates the additional measures to determine 
whether they contribute to the accuracy of the forecast. If the additional measures do 
not increase the accuracy of the forecast, then they are not used. If the additional 
measures do increase the accuracy of the forecast, then the forecast line is 
adjusted, and the confidence bands are narrowed.

The measures that you add as underlying factors can also be used in a scenario 
analysis.

Note: Underlying factors are available only if your line chart contains a single 
measure in the Measures role.

Sort Data Values

By default, for category data, a line chart is sorted in descending order by the value of 
the first measure. To change the sorting, right-click on the data item that you want to 
sort on, and then select Sort  [sort-method].

Note: If the visualization contains a rank, then, by default, the data is sorted based on 
the values of the rank.

Note: Sorting is not available if a datetime data item is assigned to the Category role.
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Forecasting

About Forecasting

Forecasting uses the statistical trends in your data source to predict future data values. 
Forecasting is available only if a date, time, or datetime data item is assigned to the 
visualization.

In addition to the predicted future data values, the forecast displays a confidence band. 
For more information, see “Forecasting” on page 264.

Enable Forecasting

To add forecasting to a line chart, select the  drop-down list from the visualization 
toolbar, and then select Show Forecast.

Note: The line chart must contain a date, time, or datetime data item to apply 
forecasting.

On the Properties tab for the line chart, you can adjust the number of data values to 
predict by using the Duration option.

On the Roles tab, you can add additional measures to the forecast as Underlying 
factors. The forecasting model evaluates the additional measures to determine whether 
they contribute to the accuracy of the forecast. If the additional measures do not 
increase the accuracy of the forecast, then they are not used. If the additional measures 
do increase the accuracy of the forecast, then the forecast line is adjusted, and the 
confidence bands are narrowed.

The measures that you add as underlying factors can also be used in a scenario 
analysis.For more information, see “Apply Scenario Analysis to a Forecast” on page 
266.
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Working with Tables

About Tables

A table displays data as text. The data value for each measure or category that is 
assigned to the table is displayed as a column. The data values in the table are not 
aggregated.

Note: For very large data sources, the table visualization displays only the first two 
billion (2,147,483,647) rows.

Note: If you sort the table, then the table displays only the first 5,000 sorted rows.

Specify Properties for a Table

On the Properties tab, you can specify the following option:

Name
specifies the name of the visualization.

Data Roles for a Table

The basic data role for a table is a column. A column can be any type of data item. You 
can add any number of columns to a table.

Managing Columns

Sort Columns

To sort the table by a column, click on the column heading. An arrow appears in the 
column heading to indicate the sorting. If the arrow points upward, then the sort is 
ascending. If the arrow points downward, then the sort is descending.

Note: If you sort the table, then the table displays only the first 5,000 sorted rows.
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Rearrange Columns

To rearrange your columns, drag and drop the column headings.

Resize Columns

To resize a column, click, and then drag and drop the left or right edge of a column 
heading.

Working with Crosstabs

About Crosstabs

A crosstab displays the intersections of category values and measure values as text. If 
the crosstab contains measures, then each cell of the crosstab contains the aggregated 
measure values for a specific intersection of category values. If the crosstab does not 
contain measures, then each cell of the crosstab contains the frequency of an 
intersection of category values.

Specify Properties for a Crosstab

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Indented
selects the indented layout for the crosstab.

Show column subtotals
adds subtotals to each column for each node on the row axis after the first.

Note: For the indented layout, subtotals are always enabled.

Show column totals
adds totals to each column.
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Note: Total values are aggregated based on the default aggregations for each 
measure.

Show row subtotals
adds subtotals to each row for each node on the column axis after the first.

Note: For the indented layout, subtotals are always enabled.

Show row totals
adds totals to each row.

Note: Total values are aggregated based on the default aggregations for each 
measure.

Totals Placement
specifies the location of totals and subtotals. Select Before to place the totals and 
subtotals before the axis headings. Select After to place the totals and subtotals 
after the axis headings.

Note: For the indented layout, totals are always placed before the axis headings.

Data Roles for a Crosstab

The basic data roles for a crosstab are columns, rows, and measures. You can assign 
either a single hierarchy or any number of categories to each column and row role. If 
you assign measures to the crosstab, then the measure values are displayed in the 
cells of the crosstab. If you do not assign measures, then the frequency of each 
intersection of values is displayed in the cells of the crosstab.

Managing Rows and Columns

Sort a Row or Column

By default, the crosstab is sorted alphabetically by the values of the first category that 
you assign to the Rows role. To change the sorting, right-click on the heading for the 
row or column that you want to sort by, and then select Sort  [sort-method].

If you apply sorting to a measure, then the sorting for the rows is applied as a 
secondary sort. To remove measure sorting, select a sort for any category.
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Rearrange Rows and Columns

To rearrange your rows and columns, drag and drop the row headings and column 
headings.

Resize Columns

To resize a column, click, and then drag and drop the left or right edge of the column 
heading.

Create Hierarchies from a Crosstab

Crosstabs enable you to create hierarchies from the categories on a crosstab axis. To 
create a hierarchy, right-click on a category heading, and then select Create Hierarchy. 
The categories are replaced with a new hierarchy.

The name of the new hierarchy is generated from the name of the outermost category, 
with the suffix “Hierarchy.”

Working with Scatter Plots

About Scatter Plots

A scatter plot displays the values of measures by using markers. When you apply more 
than two measures, the visualization displays a scatter plot matrix. A scatter plot matrix 
is a series of scatter plots that display every possible pairing of the measures that are 
applied to the visualization.

If you create a scatter plot that has a very large number of data values, then the scatter 
plot is rendered either as a heat map (for two measures) or as a correlation matrix for 
three or more measures.

Specify Properties for a Scatter Plot

On the Properties tab, you can specify the following options:
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Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the plot axes.

Marker size
specifies the size of each marker in pixels.

Fit Line
adds a fit line to the scatter plot. For information about the fit types that are available, 
see “Fit Lines” on page 263.

Note: Fit lines are not available if a grouping variable is assigned to the scatter plot.

Data Roles for a Scatter Plot

The basic data role for a scatter plot is a measure. You can assign any number of 
measures. If you assign a single measure to a scatter plot, then the values are plotted 
along a line.

In addition to measures, you can assign a Group variable. The Group variable groups 
the data based on the values of the category data item that you assign. A separate set 
of scatter points is created for each value of the group variable.

You can add data items to the Labels role. The values for the data items in the Labels 
role are displayed in the data tips for the scatter plot.
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Applying Data Analysis

About Data Analysis

For scatter plots, you can apply the following data analyses:

Correlation
identifies the degree of statistical correlation between the variables in the 
visualization. For more information, see “Correlation” on page 262.

Fit Line
plots a model of the relationship between the variables in the visualization.

There are many types of fit lines, including linear fit, quadratic fit, cubic fit, and 
penalized B-spline. For more information, see “Fit Lines” on page 263.

Correlation is applied to your visualization automatically when you add a linear fit line. It 
is not available with other fit types.

Enable Data Analysis

To add a fit line to your visualization, select the  drop-down list from the visualization 
toolbar, and then select Fit Line  [fit-type]. For details about the fit types that are 
available, see “Fit Lines” on page 263.

Working with Bubble Plots

About Bubble Plots

A bubble plot displays the values of at least three measures by using differently sized 
plot markers (bubbles) in a scatter plot. The values of two measures are represented by 
the position on the plot axes, and the value of the third measure is represented by the 
marker size.

Note: Bubble sizes are scaled relative to the minimum and maximum values of the size 
variable. The minimum and maximum sizes are illustrated in the plot legend. The actual 
value for each bubble is displayed as a data tip and in the summary table.
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You can create animated bubble plots to display changing data over time.

Specify Properties for a Bubble Plot

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the response axis.

Color gradient
selects the gradient colors for the visualization.

You can click  to select the values that are used to assign the colors. See “Specify 
a Custom Data Range” on page 182.

Data Roles for a Bubble Plot

The basic data roles for a bubble plot are:

X axis
specifies the measure that is assigned to the X axis.

Y axis
specifies the measure that is assigned to the Y axis.

Bubble size
specifies the measure that determines the marker size.
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In addition to the basic data roles, you can assign these roles:

Group
groups the data based on the values of the category data item that you assign. A 
separate set of points is created for each value.

Note: You cannot assign both the Group role and the Color role at the same time.

Color
specifies a data item that determines the color of the bubbles. If you specify a 
category, then each value of the category is represented by a different bubble color. 
If you specify a measure, then the measure value is represented by the bubble color.

Note: You cannot assign both the Group role and the Color role at the same time.

Lattice columns
creates a lattice of charts with a column for each value of the category data item that 
you assign.

Lattice rows
creates a lattice of charts with a row for each value of the category data item that 
you assign.

Animation
specifies a datetime data item that is used to animate the bubble plot.

Note: The Animation role is enabled only if you assign a data item to the Group 
role.

Using Animated Bubble Plots

About Animated Bubble Plots

An animated bubble plot displays the changes in your data values over time. Each 
frame of the animation represents a value of the datetime data item that is assigned to 
the Animation data role.

For example, if you assign a category with the YEAR format to the Animation data role, 
then each frame of the animation displays a bubble plot of your data for a specific year.
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Create an Animated Bubble Plot

To create an animated bubble plot:

1 Select an existing bubble plot, or create a new bubble plot.

2 Assign a data item to the Group data role.

3 Assign a data item with a datetime format to the Animation data role.

Display an Animated Bubble Plot

For an animated bubble plot, a set of animation controls appears at the bottom of the 
visualization.

Table 22.3 Animation Control Tasks

Task Action

Start the animation. Click .

Go to the previous animation frame. Click .

Go to the next animation frame. Click .

Jump to a specific animation frame. Use the slider.

Specify whether to repeat the animation. Select or deselect Loop.

Select the animation speed. Use the Speed slider.

Track the movement of a specific bubble. Click the bubble that you want to track.
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Working with Histograms

About Histograms

A histogram displays the distribution of values for a single measure. A series of bars 
represents the number of observations in the measure that match a specific value or 
value range. The bar height can represent either the exact number of observations or 
the percentage of all observations for each value range.

Note: If you use the default number of bins, then the minimum and maximum values on 
the histogram axis might not match the actual extent of your data values. If you specify 
the number of histogram bins, then the histogram axis matches your data values 
exactly.

Specify Properties for a Histogram

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the response axis.

Bar direction
specifies whether the bars are vertical or horizontal.
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Frequency
specifies whether the frequency is displayed as a count (Count) or as a percentage 
(Percent).

Note: The frequency values are based on the data that is shown in the visualization 
(after filters and other data selections have been applied).

Use default bin count
specifies whether to use the default number of bins (value ranges) for the histogram. 
The default number of bins is determined by the number of data values in your 
histogram.

Bin count
specifies the number of bins (value ranges) for the histogram.

Data Roles for a Histogram

The basic data role for a histogram is a measure. You can assign only one measure to 
a histogram.

Working with Box Plots

About Box Plots

A box plot displays the distribution of data values by using a rectangular box and lines 
called “whiskers.”
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Figure 22.4 Parts of a Box Plot

Figure 22.4 on page 205 shows a diagram of a box plot. The bottom and top edges of 
the box indicate the interquartile range (IQR). That is, the range of values that are 
between the first and third quartiles (the 25th and 75th percentiles). The marker inside 
the box indicates the mean value. The line inside the box indicates the median value.

You can enable outliers, which are data points whose distances from the interquartile 
range are greater than 1.5 times the size of the interquartile range.

The whiskers (lines protruding from the box) indicate the range of values that are 
outside of the interquartile range. If you do not enable outliers, then the whiskers extend 
to the maximum and minimum values in the plot. If you enable outliers, then the 
whiskers indicate the range of values that are outside of the interquartile range, but are 
close enough not to be considered outliers.

If there are a large number of outliers, then the range of outlier values is represented by 
a bar. The data tip for the bar displays additional information about the outliers. To 
explore the outliers, double-click on the outlier bar to view the values as a new 
histogram visualization.

Specify Properties for a Box Plot

On the Properties tab, you can specify the following options:

Working with Box Plots 205



Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show grid lines
displays grid lines for each tick on the response axis.

Box direction
specifies whether the boxes are vertical or horizontal.

Overview
specifies whether the chart overview is enabled.

Measure layout
specifies whether the measures share a single response axis (Shared axis) or have 
separate response axes for each measure (Separate axes).

Note: The Measure layout option is disabled if your visualization contains exactly 
one measure.

Show averages
displays the mean value as a marker inside the box.

Show outliers
shows outliers outside of the whiskers. Outliers are data points whose distances 
from the interquartile range are greater than 1.5 times the size of the interquartile 
range.

Rotate axis labels
displays the category labels at an angle.

Note: The Rotate axis labels option has no effect if the box plot contains no 
categories.
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Data Roles for a Box Plot

The basic data roles for a box plot are categories and measures. You can assign one 
category only, and the category values are plotted on the category axis. You can assign 
many measures, and the measure values are plotted on the response axis. At least one 
measure is required.

In addition to the basic data roles, you can assign these roles:

Lattice columns
creates a lattice of charts with a column for each value of the category data item that 
you assign.

Lattice rows
creates a lattice of charts with a row for each value of the category data item that 
you assign.

Working with Heat Maps

About Heat Maps

A heat map displays the distribution of values for two data items by using a table with 
colored cells. If you do not assign a measure to the Color data role, then a cell’s color 
represents the frequency of each intersection of values. If you assign a measure to the 
Color data role, then a cell’s color represents the aggregated measure value for each 
intersection of values.

Specify Properties for a Heat Map

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.
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Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Bin count
specifies the number of value ranges that are represented as cells. Bin count 
affects only measures.

Show borders
specifies that the borders between cells are visible.

Rotate axis labels
displays the category labels at an angle.

Note: The Rotate axis labels option affects only the values on the X axis.

Note: The Rotate axis labels option has no effect if the heat map contains no 
categories.

Color gradient
selects the gradient colors for the visualization.

You can click  to select the values that are used to assign the colors. See “Specify 
a Custom Data Range” on page 182.

Fit line
adds a fit line to the heat map. For information about the fit types that are available, 
see “Fit Lines” on page 263.

Note: Fit lines are not available if a category is assigned to the heat map.

Data Roles for a Heat Map

The basic data roles for a heat map are:
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X axis
specifies the data item that is assigned to the X axis.

Y axis
specifies the data item that is assigned to the Y axis.

Color
specifies a measure that determines the cell color. If you do not assign the Color 
role, then the cell color indicates frequency.

Applying Data Analysis

About Data Analysis

For heat maps, you can apply the following data analyses:

Correlation
identifies the degree of statistical correlation between the variables in the 
visualization. For more information, see “Correlation” on page 262.

Fit Line
plots a model of the relationship between the variables in the visualization.

There are many types of fit lines, including linear fit, quadratic fit, cubic fit, and 
penalized B-spline. For more information, see “Fit Lines” on page 263.

Correlation is applied to your visualization automatically when you add a linear fit line. It 
is not available with other fit types.

Enable Data Analysis

To add a fit line to your visualization, select the  drop-down list from the visualization 
toolbar, and then select Fit Line  [fit-type]. For information about the fit types that are 
available, see “Fit Lines” on page 263.

Note: Fit lines are not available if your heat map contains categories or hierarchies.
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Working with Geo Maps

About Geo Maps

A geo map overlays your data on a geographic map. You can display your data either 
as bubbles or as colored regions on the geo map.

To display a geo map, you must define one or more of the categories as geography 
data items. For more information, see “Define a Geography Data Item” on page 154.

Specify Properties for a Geo Map

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Frequency
specifies whether the frequency values are displayed as the number of values 
(Count) or as the percentage of values (Percent).

Map style
specifies the type of data overlay for the map. Select one of the following values:

Bubbles
displays your data as a series of bubbles. Each bubble is located at the center of 
a geographic region or at the coordinates of a location.
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Regions
displays your data as colored regions on the map.

Note: The Regions map style is not available for custom geographic roles.

Note: The Map style option is disabled if both the Bubble size role and Color role 
are assigned.

Show map navigation control
specifies whether the map zoom and pan controls are visible.

Color gradient
selects the gradient colors for the visualization.

You can click  to select the values that are used to assign the colors. See “Specify 
a Custom Data Range” on page 182.

Transparency
specifies the amount of transparency for the data overlay.

Data Roles for a Geo Map

The basic data roles for a bubble plot are:

Geography
specifies the geography data item that identifies geographic regions for your map.

Geography data items are identified by the  icon.

Bubble size
for the Bubbles map style, specifies the measure that determines the bubble size.

Color
for the Regions map style, specifies the measure that determines the regions’ 
colors.

for the Bubbles map style, specifies a measure that determines the bubble color.
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Zoom a Geo Map

You can zoom the map by using any of the following controls:

n click the zoom bar to select your zoom level

n press the + and – buttons on the zoom bar

n scroll the mouse wheel to zoom in or zoom out at the location of the cursor

Pan (Scroll) a Geo Map

You can pan (scroll) the map by using any of the following controls:

n click and drag the map

n click the arrows on the pan control

Working with Treemaps

About Treemaps

A treemap displays a hierarchy or a category as a set of rectangular tiles. Each tile 
represents a category value or a hierarchy node. The size of each tile represents either 
the frequency count or the value of a measure. If you assign a measure to the Color 
role, then the color of each tile represents the value of that measure.

Specify Properties for a Treemap

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.
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Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show data labels
shows a text label for each tile in the treemap.

Frequency
specifies whether the frequency values are displayed as the number of values 
(Count) or as the percentage of values (Percent).

Arrangement
specifies the layout of the tiles in the treemap. Select one of the following values:

Standard
arranges the tiles into squares, with the largest tiles generally at the bottom left.

Flow
arranges the tiles from largest to smallest, with the largest tile at the top left.

Toggle
arranges the tiles into a single row or column, with the largest tile on the left or at 
the top.

The orientation of the tiles alternates between hierarchy levels. The top level is 
arranged as a row, the second level is a column, and so on.

Additional levels
specifies the number of levels that are displayed beneath the current level.

Color gradient
selects the gradient colors for the visualization.

You can click  to select the values that are used to assign the colors. See “Specify 
a Custom Data Range” on page 182.
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Data Roles for a Treemap

The basic data roles for a treemap are:

Tile
specifies categories or a hierarchy that are used to create the tiles in the treemap. If 
you specify categories for the Tile role, the order of the categories determines the 
level of each category. Drag and drop the categories to place them in the order that 
you want.

Size
specifies a measure that determines the size of each tile. If you do not specify the 
Size role, then the tile size is determined by the frequency count.

Note: If any of the aggregated values for the Size role results in a negative size 
value or a value of zero, then an error appears.

Color
specifies a measure that determines the color of the tiles.

Create a Hierarchy from a Treemap

If your treemap contains categories in the Tile role, then you can create a new hierarchy 
by using the categories.

On the Roles tab, click on the drop-down list for the Tile role, and then select Create 
Hierarchy. A new hierarchy is created with the name of the first category in the 
hierarchy.

Working with Correlation Matrices

About Correlation Matrices

A correlation matrix displays the degree of correlation between multiple intersections of 
measures as a matrix of rectangular cells. Each cell in the matrix represents the 
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intersection of two measures, and the color of the cell indicates the degree of correlation 
between those two measures.

A correlation matrix can either compare within a single set of measures or it can 
compare between two sets of measures.

The correlation values are calculated by using Pearson’s product-moment correlation 
coefficient. Correlation values are identified as weak, moderate, or strong as follows:

Weak
0.3 or lower

Moderate
greater than 0.3 and less than or equal to 0.6

Strong
greater than 0.6

Specify Properties for a Correlation Matrix

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Show borders
specifies that the borders between cells are visible.

Rotate axis labels
displays the axis labels at an angle.
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Color gradient
selects the gradient colors for the visualization.

Data Roles for a Correlation Matrix

The basic data role for a correlation matrix is a measure. You must assign at least two 
measures.

Note: The maximum number of measures is 60.

The Show Correlations option specifies whether the correlation matrix uses a single 
set of measures (Within one set of measures) or two sets of measures (Between two 
sets of measures.)

If you select Between two sets of measures, then assign measures to the X axis and 
Y axis roles.

Sort Correlation Values

For a correlation matrix between two sets of measures, you can sort by the correlation 
values for a measure.

To apply sorting, right-click the Measures button on the axis that you want to sort, and 
then select Sort. You can select any of the measures on the selected axis, and you can 
select whether to sort the correlation values in ascending or descending order.

Working with Decision Trees

About Decision Trees

A decision tree uses the values of one or more predictor data items to predict the values 
of a target data item. A decision tree displays a series of nodes as a tree, where the top 
node is the target data item, and each branch of the tree represents a split in the values 
of a predictor data item. Decision trees are also known as classification and regression 
trees.
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Figure 22.5 Example Decision Tree

Each branch of the tree displays the name of the predictor for the branch at the top of 
the split. The thickness of the branch indicates the number of values that are associated 
with each node. The predictor values for each node are displayed above the node.

Each node in the tree displays the data for the node either as a histogram (if the target 
contains continuous data) or as a bar chart (if the target contains discrete data). The 
histogram or bar chart in each node displays the values of the target data item that are 
selected by the splits in the tree. The number at the top right of the node indicates the 
greatest value for the bar chart or histogram. At the bottom of each node, the total 
number of data values (count) is displayed.

Decision trees in SAS Visual Analytics use a modified version of the C4.5 algorithm.
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The table view for a decision tree contains two additional data columns, Node ID and 
Parent ID. Node ID specifies a unique value for each node in the tree. Parent ID 
specifies the ID of the parent node.

Specify Properties for a Decision Tree

On the Properties tab, you can specify the following options:

Name
specifies the name of the visualization.

Title
specifies the title that appears above the graph.

Note: The Title option is disabled if you select Generate graph titles.

Generate graph titles
specifies that the graph title is generated automatically based on the data items in 
the visualization.

Growth strategy
specifies the parameters that are used to create the decision tree. Select one of the 
following values:

Basic
specifies a simple tree with a maximum of two branches per split and a maximum 
of six levels. For details, see Table 22.4 on page 219.

Advanced
specifies a complex tree with a maximum of four branches per split and a 
maximum of six levels. For details, see Table 22.4 on page 219.

Expert
enables you to select the values for each of the expert parameters.

If you select Expert as the value for Growth strategy, then the following additional 
options appear:

Maximum branches
specifies the maximum number of branches for each node split.
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Maximum levels
specifies the maximum number of levels in the tree.

Leaf size
specifies the minimum number of values (count) for each node.

Target bins
specifies the number of bins that are used for the target data item.

Note: This option has no effect if the target data item contains discrete data.

Predictor bins
specifies the number of bins that are used for predictor data items.

Note: This option has no effect if the predictor data items contain discrete data.

Pruning
specifies the level of pruning that is applied to the tree. Pruning removes leaves and 
branches that contribute the least to the predictive accuracy of the tree. A more 
Lenient pruning value specifies that fewer leaves and branches are removed from 
the tree. A more Aggressive pruning value specifies that more leaves and branches 
are removed from the tree.

Include missing
specifies whether missing values are included in the tree.

Reuse predictors
specifies that predictors can be used more than once in the tree.

The following parameter values are used for the Basic and Advanced growth 
strategies:

Table 22.4 Parameter Values for the Basic and Advanced Growth Strategies

Property Basic Value Advanced Value

Maximum branches 2 4

Maximum levels 6 6

Leaf size 1 1
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Property Basic Value Advanced Value

Target bins 10 10

Predictor bins 2 2

Include missing No Yes

Reuse predictors No Yes

Data Roles for a Decision Tree

The basic data roles for a decision tree are:

Target
specifies the target for the decision tree. You can specify any category or measure. 
The decision tree attempts to predict the values of the target data item. The bar 
chart or histogram inside each node of the tree displays the frequency of values for 
the target data item.

Predictors
specifies predictors for the decision tree. You can specify one or more categories or 
measures as predictors. The values of predictor data items are displayed above the 
nodes in the tree. The order of the data items in the Predictors list does not affect 
the tree.

Note: If a predictor does not contribute to the predictive accuracy of the tree, then it 
is not used in the tree.

Explore a Node as a New Visualization

For each node in the tree, you can explore the data values as a new histogram or bar 
chart visualization. To create a new visualization for a node, right-click on the node, and 
then select Create Visualization from Node. A new visualization appears.

Note: If you create a visualization from a node that displays a histogram, then the new 
histogram might have visual differences from the histogram that is displayed in the 
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decision tree. For example, the bins and the extent of data on the X axis might be 
different. However, the two histograms use exactly the same data.

Calculate a Data Item from a Decision Tree

You can create a calculated data item to represent the results of a decision tree. The 
calculated data item creates values that correspond to the node IDs that can be seen in 
the table view for the decision tree.

You can use the calculated data item in filters to select the values for a decision tree 
node in other types of visualizations.

To calculate a data item from a decision tree:

1 Select the  drop-down list from the visualization toolbar, and then select Create 
Calculated Item.

2 In the New Calculated Item window, enter a Name for the new calculated item.

3 Click OK to create the new item.

Display the Overview

For large decision trees, the overview enables you to select the portions of the tree that 
are visible.

To display the overview, select the  drop-down list from the visualization toolbar, and 
then select Show Overview.

Zoom a Decision Tree

You can zoom a decision tree by using either of the following controls:

n in the overview, select the part of the decision tree that you want to view

n scroll the mouse wheel over the visualization to zoom in or out at the location of the 
cursor
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Pan (Scroll) a Decision Tree

You can pan (scroll) the decision tree by using any of the following controls:

n in the overview, drag the selection box

n hold down the Shift key and drag the decision tree
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About Filters in SAS Visual Analytics 
Explorer

In SAS Visual Analytics Explorer (the explorer), you can create filters to subset your 
data.

Three types of filters are available:

Basic filters
subset the data for your visualizations by using a single data item. Basic filters can 
be adjusted by using visual filter controls, or by using the Edit Filter window.

For information about basic filters, see “Working with Basic Filters” on page 225.

Advanced filters
subset the data for your visualizations by using any number of data items. Visual 
filter controls are not available for advanced filters.

For information about advanced filters, see “Working with Advanced Filters” on page 
231.

Data source filters
subset the data for the entire exploration. Data source filters can use any number of 
data items to select data.

For information about data source filters, see “Working with Data Source Filters” on 
page 239.

All of your filters are saved when you save your exploration.
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Working with Basic Filters

About Basic Filters

For all visualization types, you can subset your data by using the Filters tab in the right 
pane. You can base your filters on any data item, regardless of whether the data item is 
assigned to the current visualization.

Your filters can be either local filters that apply only to the current visualization, or global 
filters that apply to all of the visualizations in the current exploration. For more 
information, see “Set the Scope of a Basic Filter (Global or Local)” on page 230.

The total percentage of values that are selected by your filters is displayed at the bottom 
of the Filters tab. The tooltip for the percentage displays the exact number of data rows. 
The percentage is calculated after data source filters are applied.

You can perform the following tasks to manage basic filters:

n “Create a Basic Filter” 

n “Create a Basic Filter from a Data Selection”

n “Edit a Filter By Using Visual Filter Controls” 

n “Edit a Basic Filter By Using the Edit Filter Window” 

n “Set the Scope of a Basic Filter (Global or Local)” 

n “Delete a Basic Filter” 

n “Reset a Basic Filter” 
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Create a Basic Filter

To create a basic filter:

1 From the Data pane, select the data item that you want to use as the base of the 
filter. You can select any data item, regardless of whether it is assigned to the 
current visualization.

2 For a local filter, either right-click on the data item, and select Add as Local Filter, 
or drag and drop the data item onto the Local Filters area of the Filters tab.

For a global filter, either right-click on the data item, and select Add as Global 
Filter, or drag and drop the data item onto the Global Filters area of the Filters tab.

Note: If a local filter exists for a data item in any of your visualizations, then you 
cannot create a new global filter for that data item. Remove the local filter, or change 
its scope to global. Similarly, if a global filter exists for a data item, then you cannot 
create a local filter for that data item.

3 Set the parameters for your filter. You can either create a basic filter by using visual 
filter controls , or you can create an advanced filter by using the Edit Filter window .

Note: By default, your filter changes are applied automatically to the active 
visualization. To apply multiple changes together, deselect Auto, and then click 
Apply when you are ready to apply your filter changes.

Create a Basic Filter from a Data Selection

When you select data values in a visualization, you can use the selected values to 
create a basic filter.

To create a new filter from a data selection:

1 Select one or more data values in a visualization.

2 Right-click on the visualization, and then select one of the following:
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Include Only Selection
creates a filter that includes the selected values only.

Exclude Selection
creates a filter that excludes the selected values.

The new filter appears on the Filters tab.

Edit a Filter By Using Visual Filter Controls

About Visual Filter Controls

Visual filter controls are accessible directly from the Filters tab. The visual filter controls 
are different, depending on the model type of the filter data item.

Filtering Discrete Data
Display 23.1 A Visual Filter for a Discrete Data Item

Note: If your data contains a large number of discrete values, then visual filter controls 
are not available. Use the Edit Filter window instead.

For data items that use the discrete data model, the filter displays all of the distinct 
values for the data item. To the right of each value, a bar indicates the frequency.

Use the check boxes next to each value to select the values for the filter. You can 
search for a value by clicking . Enter a text string in the field. The search locates 
values that begin with your text string.
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Click Select all to select or deselect all of the values. To invert your selection, open the 
 drop-down list, and then select Invert Selection.

To exclude data observations in which the filter category has a missing value, deselect 
Include missing values.

Note: This option is available only if your data contains missing values.

By default, your filter changes are applied automatically to the active visualization. To 
apply multiple changes together, deselect Auto, and then click Apply when you are 
ready to apply your filter changes.

Filtering Continuous Data
Display 23.2 A Visual Filter for a Continuous Data Item

For measures that use the continuous data model, the filter shows the range of data 
values as a histogram. Sliders at each side of the histogram enable you to select the 
upper and lower limits of the data range that is selected by the filter.

You can enter the limits explicitly:

n For numeric data, click on an upper or lower limit value, and then enter a new value 
in the text field.

n For a continuous datetime data item, click , and then select a date or time.

To exclude data observations in which the filter measure has a missing value, deselect 
Include missing values.

Note: This option is available only if your data contains missing values.

By default, your filter changes are applied automatically to the active visualization. To 
apply multiple changes together, deselect Auto, and then click Apply when you are 
ready to apply your filter changes.
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Edit a Basic Filter By Using the Edit Filter 
Window

To edit a basic filter by using the Edit Filter window:

1 On the Filters tab, open the  drop-down list for the filter that you want to edit, and 
then select Edit Filter. 

The Edit Filter window appears.

Display 23.3 The Edit Filter Window (Basic)
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2 Build the expression for your filter by dragging and dropping conditions and 
operators onto the expression in the right pane. 

For information about the conditions and operators that are available, see Appendix 
2, “Conditions and Operators for Filters,” on page 499.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a condition onto the operator name in the 
right pane, or right-click the operator name, select Add, and then select New 
Condition.

3 (Optional) For discrete data, click Preview Results to preview the filter results.

4 When you are finished editing your filter, click OK to apply the filter.

Set the Scope of a Basic Filter (Global or 
Local)

A filter can be either local (applies only to the current visualization) or global (applies to 
all of the visualizations in the exploration).

To set the scope of a filter, open the  drop-down list, and then select Global Filter or 
Local Filter.

Note: If you change a global filter’s scope to local, then a local filter is created for all of 
the visualizations in the exploration.

Note: If local filters exist in your other visualizations for the same data item, then 
converting your filter to a global filter will replace those local filters. A confirmation 
window enables you to continue or cancel.

Delete a Basic Filter

To delete a basic filter, click  on the filter on the Filters tab, or open the  drop-down 
list on the filter menu and then select Delete Filter.

230 Chapter 23 / Working with Filters



You can delete all of your filters by opening the  drop-down list in the Global Filters 
area or in the Local Filters area of the Filters tab, and then selecting Delete All 
Filters.

Note: If you delete a global filter, then the filter is removed from all of your 
visualizations in the exploration.

Reset a Basic Filter

To restore a basic filter to its initial state, open the  drop-down list for the filter, and 
then select Reset Filter.

You can reset all of your filters by opening the  drop-down list in the Global Filters 
area or in the Local Filters area of the Filters tab, and then selecting Reset All Filters.

Working with Advanced Filters

About Advanced Filters

For all visualization types, you can create advanced filters to subset your data by using 
the Filters tab in the right pane.

Advanced filters enable you to create filters that use more than one data item.

Your advanced filters can be either local filters that apply only to the current 
visualization, or global filters that apply to all of the visualizations in the current 
exploration.

The total percentage of values that are selected by your filters is displayed at the bottom 
of the Filters tab. The tooltip for the percentage displays the exact number of data rows. 
The percentage is calculated after data source filters are applied.

You can perform the following tasks to manage advanced filters:

n “Create an Advanced Filter”

n “Edit an Advanced Filter”
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n “Set the Scope of an Advanced Filter (Global or Local)”

n “Delete an Advanced Filter”

Create an Advanced Filter

To create an advanced filter:

1 Open the  drop-down list in the Global Filters area or in the Local Filters area of 
the Filters tab, and then select New Advanced Filter.

232 Chapter 23 / Working with Filters



The Edit Filter window appears:

Display 23.4 The Edit Filter Window (Advanced)

2 Specify a Filter name. The filter name identifies the advanced filter on the Filters 
tab.
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3 Create a condition for the filter:

a From the Data Items list, select the data item on which the condition is based.

b From the Conditions list, select a condition. For a list of the conditions that are 
available, see Appendix 2, “Conditions and Operators for Filters,” on page 499.

c Drag and drop the condition onto the expression in the right pane.

d For any required parameters, select the parameter, and enter a value, or right-
click the parameter field, and select Replace with to select a data item.

4 (Optional) Add additional operators to the expression.

a From the Operators list, select an operator to join the conditions in your 
expression. For a list of the operators that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Drag and drop the operator onto the expression in the right pane.

c Add a new condition as described in step 2 above.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a condition onto the operator name in the 
right pane, or right-click the operator name, select Add, and then select New 
Condition.

5 When you are finished creating your advanced filter, click OK to apply the filter.

Edit an Advanced Filter

About Editing Advanced Filters

You can perform the following tasks to edit an advanced filter:

n “Open the Edit Filter Window”

n “Specify the Filter Name”

234 Chapter 23 / Working with Filters



n “Edit a Parameter Value”

n “Add a Condition”

n “Add an Operator”

n “Replace a Condition”

n “Remove Part of an Expression”

n “Subset an Expression”

Open the Edit Filter Window

To open the Edit Filter window, on the Filters tab, open the  drop-down list for the 
advanced filter that you want to edit, and then select Edit Filter.
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The Edit Filter window appears.

Display 23.5 The Edit Filter Window (Advanced)

Specify the Filter Name

To specify a name for the filter, enter a name in the Filter name field. The filter name 
identifies the advanced filter on the Filters tab.
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Edit a Parameter Value

To edit a parameter value, select the parameter, and enter a new value, or right-click 
the parameter field, and select Replace with to select a data item.

Add a Condition

Note: If your filter expression contains an existing condition, then you must first Add an 
Operator to the expression.

To add a new condition:

1 From the Data items list, select the data item on which the condition is based.

2 From the Conditions list, select a condition. For a list of the conditions that are 
available, see Appendix 2, “Conditions and Operators for Filters,” on page 499.

3 Drag and drop the condition onto the expression in the right pane.

4 For any required parameters, select the parameter, and enter a value, or right-click 
the parameter field, and select Replace with to select a data item.

Add an Operator

To add an operator to the expression:

1 From the Operators list, select an operator to join the conditions in your expression. 
For a list of the operators that are available, see Appendix 2, “Conditions and 
Operators for Filters,” on page 499.

2 Drag and drop the operator onto the expression in the right pane.

3 Add a New Condition.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a condition onto the operator name in the right 
pane, or right-click the operator name, select Add, and then select New Condition.

Replace a Condition

To replace a condition, drag and drop a new condition onto the existing condition in the 
right pane.
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Remove Part of an Expression

To remove a part of an expression, highlight the part of the expression that you want to 
remove, and then select Delete or Clear.

Subset an Expression

To subset an expression and delete the remainder:

1 Highlight the part of the expression that you want to keep.

2 Right-click, and select Keep Operand. The parts of the expression that were not 
selected are removed.

Set the Scope of an Advanced Filter (Global 
or Local)

A filter can be either local (applies only to the current visualization) or global (applies to 
all of the visualizations in the current exploration).

To set the scope of a filter, open the  drop-down list, and then select Global Filter or 
Local Filter.

Note: If you change a global filter’s scope to local, then a local filter is created for all of 
the visualizations in the exploration.

Note: If local filters exist in your other visualizations for the same data item, then 
converting your filter to a global filter will replace those local filters. A confirmation 
window enables you to continue or cancel.

Delete an Advanced Filter

To delete an advanced filter, click  on the filter on the Filters tab, or open the  drop-
down list on the filter menu, and then select Delete Filter.

You can delete all of your filters by opening the  drop-down list in the Global Filters 
area or in the Local Filters area of the Filters tab, and then selecting Delete All 
Filters.
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Note: If you delete a global filter, then the filter is removed from all of your 
visualizations in the exploration.

Working with Data Source Filters

About Data Source Filters

A data source filter enables you to subset the data in an entire exploration. A data 
source filter differs from a global advanced filter in the following ways:

n A data source filter updates the cardinality values that appear in the Data pane.

n A data source filter updates the total number of rows that is used in the filtered rows 
percentage at the bottom of the right pane.

n A data source filter is not shown on the Filters tab.

n An exploration can contain only one data source filter.

You can perform the following tasks to manage data source filters:

n “Create a Data Source Filter from a Global Filter”

n “Create a New Data Source Filter”

n “Edit a Data Source Filter”

n “Delete a Data Source Filter”

Create a Data Source Filter from a Global 
Filter

To convert an existing global filter to a data source filter:

1 On the Filters tab, select the global filter that you want to convert.

2 Open the  drop-down list, and select Convert to Data Source Filter. The global 
filter disappears from the Filters tab.
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You can convert all of your global filters together into a single data source filter by 
opening the  drop-down list in the Global Filters area or in the Local Filters area of 
the Filters tab, and then selecting Convert All to Data Source Filter.

To view the data source filter settings, select Data  Data Source Details from the 
main menu. The data source filter settings are displayed in the Data source filter field.

Create a New Data Source Filter

To create a data source filter:

1 Select Data  Data Source Details from the main menu.

2 Click New to create a data source filter.

Note: If the current exploration contains an existing data source filter, then click Edit 
to add conditions to the existing data source filter.
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The Edit Filter window appears:

Display 23.6 The Edit Filter Window (Data Source)

3 Create a condition for the filter:

a From the Data items list, select the data item on which the condition is based.

b From the Conditions list, select a condition. For a list of the conditions that are 
available, see Appendix 2, “Conditions and Operators for Filters,” on page 499.
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c Drag and drop the condition onto the expression in the right pane.

d For any required parameters, select the parameter, and enter a value, or right-
click the parameter field, and select Replace with to select a data item.

4 (Optional) Add additional operators to the expression.

a From the Operators list, select an operator to join the conditions in your 
expression. For a list of the operators that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Drag and drop the operator onto the expression in the right pane.

c Add a new condition as described in step 2 above.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a condition onto the operator name in the 
right pane, or right-click the operator name, select Add, and then select New 
Condition.

5 When you are finished creating your filter, click OK to apply the filter.

Edit a Data Source Filter

About Editing Data Source Filters

You can perform the following tasks to edit a data source filter:

n “Edit a Data Source Filter By Using the Edit Filter Window”

n “Edit a Parameter Value”

n “Add a Condition”

n “Add an Operator”

n “Replace a Condition”

n “Remove Part of an Expression”
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n “Subset an Expression”

Edit a Data Source Filter By Using the Edit Filter Window

To open the Edit Filter window, select Data  Data Source Details from the main 
menu, and then click Edit.

The Edit Filter window appears:

Display 23.7 The Edit Filter Window (Data Source)
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Edit a Parameter Value

To edit a parameter value, select the parameter, and enter a new value, or right-click 
the parameter field, and select Replace with to select a data item.

Add a Condition

Note: If your filter expression contains an existing condition, then you must first Add an 
Operator to the expression.

To add a new condition:

1 From the Data items list, select the data item on which the condition is based.

2 From the Conditions list, select a condition. For a list of the conditions that are 
available, see Appendix 2, “Conditions and Operators for Filters,” on page 499.

3 Drag and drop the condition onto the expression in the right pane.

4 For any required parameters, select the parameter, and enter a value, or right-click 
the parameter field, and select Replace with to select a data item.

Add an Operator

To add an operator to the expression:

1 From the Operators list, select an operator to join the conditions in your expression. 
For a list of the operators that are available, see Appendix 2, “Conditions and 
Operators for Filters,” on page 499.

2 Drag and drop the operator onto the expression in the right pane.

3 Add a New Condition.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a condition onto the operator name in the right 
pane, or right-click the operator name, select Add, and then select New Condition.

Replace a Condition

To replace a condition, drag and drop a new condition onto the existing condition in the 
right pane.
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Remove Part of an Expression

To remove a part of an expression, highlight the part of the expression that you want to 
remove, and then select Delete or Clear.

Subset an Expression

To subset an expression and delete the remainder:

1 Highlight the part of the expression that you want to keep.

2 Right-click, and select Keep Operand. The parts of the expression that were not 
selected are removed.

Delete a Data Source Filter

To remove a data source filter, select Data  Data Source Details, and then click 
Delete.
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Overview of Exporting Content

You can export your data and your visualizations from SAS Visual Analytics Explorer 
(the explorer) by using the following tasks:

n “Export a Visual Exploration as a Report” 

n “Export a Visual Exploration as a PDF”

n “Save a Visualization as an Image File” 

n “Export Data from a Visualization”

n “E-mail a Visual Exploration as a Link” 
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Export a Visual Exploration as a Report

You can export your visual exploration as a report, which can be refined in the designer 
interface or viewed directly on a mobile device or in SAS Visual Analytics Viewer (the 
viewer).

To export your current visual exploration as a report:

1 Select File  Export  Exploration as Report.

Note: If you have only one visualization in your exploration, the Save As window is 
displayed at this point. Select the location where you want to save the report, and 
then click Save to export it as a report.

2 In the Export as Report window, select the visualizations that you want to include in 
the report.

Note: The following types of visualizations are not available to include in the report:

n visualizations that do not contain any data

n animated bubble plots

n treemaps that display additional levels

n line charts with forecasting analysis are not available if the visualization has 
not been displayed during the current session

n decision trees

Note: If your scatter plot or heat map contains correlation data, the correlations are 
not included in the report.

248 Chapter 24 / Exporting Content



The Export to Report window enables you to perform the following tasks:

Task Action

Add visualizations to the selection list.
(Restore visualizations.)

Select a visualization from the Available 
list, and then click , or click  to add all 
of the available visualizations.

Remove visualizations from the selection 
list.
(Minimize visualizations.)

Select a visualization from the Selected list, 
and then click , or click  to remove all 
of the visualizations.

Change the order of the selected 
visualizations.

In the Selected list, drag and drop the 
visualizations in the order that you want, or 
select a visualization and click the up and 
down arrows to move it.

Search the available visualizations. In the Search field, enter a string to search 
for. A visualization matches the search if 
the string appears anywhere in the 
visualization name.
Only the matching visualizations appear in 
the Available list.

Filter the available visualizations. Click , and then select your filter 
parameters. You can filter either on the 
visualization type or on the data items that 
are used in each visualization.
Only the matching visualizations appear in 
the Available list.

When you have finished selecting your visualizations, click OK.

3 Select the location where you want to save the report, and then click Save.

4 Click OK to return to the explorer, or select Open the report and close the current 
exploration, and click OK to view the report in the designer.
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Export a Visual Exploration as a PDF

To export your current visual exploration as a PDF:

1 Select File  Export  Exploration as PDF.

2 In the Export as PDF wizard, enter a Title and a Description for the PDF 
document. Then, select the following options:

Page numbers
specifies that the PDF document contains page numbers.

Summary data
specifies whether the PDF document contains summary data tables for each 
visualization.

Filter descriptions
specifies whether each visualization includes a description of its active filters.

Click Next.

3 Select the visualizations that you want to include in the PDF document.

Note: The following types of visualizations are not available to include in the PDF 
document:

n visualizations that do not contain any data

n crosstabs

n tables that contain more than 1,000 rows

The Export as PDF window enables you to perform the following tasks:

Task Action

Add visualizations to the selection list.
(Restore visualizations.)

Select a visualization from the Available 
list, and then click , or click  to add all 
of the available visualizations.
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Task Action

Remove visualizations from the selection 
list.
(Minimize visualizations.)

Select a visualization from the Selected list, 
and then click , or click  to remove all 
of the visualizations.

Change the order of the selected 
visualizations.

In the Selected list, drag and drop the 
visualizations in the order that you want, or 
select a visualization and click the up and 
down arrows to move it.

Search the available visualizations. In the Search field, enter a string to search 
for. A visualization matches the search if 
the string appears anywhere in the 
visualization name.
Only the matching visualizations appear in 
the Available list.

Filter the available visualizations. Click , and then select your filter 
parameters. You can filter either on the 
visualization type or on the data items that 
are used in each visualization.
Only the matching visualizations appear in 
the Available list.

Click Next.

4 Click Finish to open a download window for your browser. 

5 Select the location where you want to save the PDF document.

Note: If the legend for a visualization is too large, then it is not included in the PDF 
document.

Save a Visualization as an Image File

To save your current visualization as an image file:
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1 Select the visualization that you want to save as an image.

2 If your visualization contains hierarchies, drill down to the hierarchy levels that you 
want to show in the image.

3 Select the  drop-down list from the visualization toolbar, and then select Export 
Image.

4 If necessary, scroll and zoom the visualization to show the data items that you want 
to include in the image. If your visualization contains filters, legends, or hierarchy 
breadcrumbs, select whether to include these elements.

5 Click Save to open a download window for your browser.

6 Select the location where you want to save the image.

Export Data from a Visualization

You can export the data from a visualization in comma-separated values (.csv) format. 
You can open .csv files in other software such as SAS Enterprise Miner, SAS Enterprise 
Guide, or Microsoft Excel.

To export data for a visualization:

1 Select the visualization for which you want to export data.

Note: Table visualizations do not support exporting data. For crosstab 
visualizations, a data summary is exported instead of a full data table.

2 If your visualization contains hierarchies, drill down to the hierarchy levels that you 
want to export.

3 Select the  drop-down list from the visualization toolbar, and then select Export 
Data to open a download window for your browser.

252 Chapter 24 / Exporting Content



Note: For a crosstab visualization, select Export Data Summary instead of Export 
Data.

4 Specify a filename and select the location where you want to save the file.

E-mail a Visual Exploration as a Link

To e-mail your visual exploration as a link:

1 Select File  E-mail. The E-mail window appears.

2 Enter the following information:

To
specifies the e-mail destination. To enter multiple addresses, separate the 
addresses by using commas, semicolons, or spaces.

From
specifies the e-mail address that is shown as the sender of the e-mail. This e-
mail address is used for notifications if the e-mail cannot be delivered to the 
addresses in the To field.

Subject
specifies the subject line of the e-mail.

Message
specifies the text for the e-mail message body. This field is optional.

Note: The message body of the e-mail automatically includes a link to the 
current visual exploration. If you specify text for the Message field, then your text 
appears before the link in the e-mail.

3 Click OK to send the e-mail.
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Overview of Hierarchies in SAS Visual 
Analytics Explorer

What Is a Hierarchy?

A hierarchy is an arrangement of category columns that is based on parent-child 
relationships. The levels of a hierarchy are arranged with more general information at 
the top and more specific information at the bottom.

For example, you might create a hierarchy of date-time columns with Year as the top 
level, Month as the next level, and Day as the bottom level.
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Creating hierarchies enables you to add drill-down functionality to your visualizations. 
For example, if you use a date-time hierarchy, you can drill down to the data for a 
specific year. Then, you can drill down to the data for a specific month.

When you drill down a hierarchy, a set of breadcrumb links at the top of your 
visualization enables you to drill back up the hierarchy.

Hierarchy Management Tasks

In SAS Visual Analytics Explorer (the explorer), you can perform the following tasks to 
manage hierarchies:

n “Create a New Hierarchy” 

n “Derive a Hierarchy from a Date, Time, or Datetime Data Item”

n “Edit a Hierarchy” 

n “Delete a Hierarchy” 

Create a New Hierarchy

To create a new hierarchy:

1 Select Data  New Hierarchy. The New Hierarchy window appears.

2 In the Name field, enter a name for the hierarchy.

3 Select the categories that you want to include in the hierarchy, and then click  to 
add them to the hierarchy.

Note: You can also drag and drop categories.

To change the order of the categories in your hierarchy, select the category that you 
want to move. Then, click  to move the category up, or click  to move the 
category down.
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To remove a category from the hierarchy, select the category that you want to 
remove. Then, click .

4 Click OK to finish creating the hierarchy.

Note: You can create a hierarchy from within a crosstab visualization. See “Create 
Hierarchies from a Crosstab” on page 197.

Derive a Hierarchy from a Date, Time, or 
Datetime Data Item

For date, time, and datetime data items, you can derive a hierarchy automatically. To 
derive a hierarchy, right-click on a date, time, or datetime data item in the Data pane, 
and then select one of the following values:

Create Date Hierarchy
creates a hierarchy with levels for year, quarter, month, and day. Depending on the 
format of the data item, some of the levels might not be created.

Create Date and Time Hierarchy
creates a hierarchy with levels for year, quarter, month, day, hour, minute, and 
second. Depending on the format of the data item, some of the levels might not be 
created.

Create Time Hierarchy
creates a hierarchy with levels for hour, minute, and second. Depending on the 
format of the data item, some of the levels might not be created.

New calculated items are created for each level in the hierarchy. By default, the new 
calculated items are hidden in the Data pane. If you delete a derived hierarchy, then a 
window appears. The window enables you to delete the calculated items that are 
associated with the hierarchy.
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Create a Hierarchy from a Treemap 
Visualization

You can create a hierarchy from a treemap visualization. See “Create a Hierarchy from 
a Treemap” on page 214.

Edit a Hierarchy

To edit an existing hierarchy:

1 From the Data pane, right-click on the hierarchy that you want to edit, and then 
select Edit. The Edit Hierarchy window appears.

2 In the Name field, enter a name for the hierarchy.

3 To add a category to the hierarchy, select the category, and then click .

Note: You can also drag and drop categories.

To change the order of the categories in your hierarchy, select the category that you 
want to move. Then, click  to move the category up, or click  to move the 
category down.

To remove a category from the hierarchy, select the category that you want to 
remove. Then, click .

4 Click OK to save the changes to your hierarchy.

Delete a Hierarchy

To delete a hierarchy:
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From the Data pane,, right-click on the hierarchy that you want to delete, and then 
select Delete. Click Yes to confirm that you want to delete the hierarchy.
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Overview of Data Analysis in SAS Visual 
Analytics Explorer

Types of Data Analysis

SAS Visual Analytics enables you to perform three basic types of data analysis:

Correlation
identifies the degree of statistical relationship between measures.
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Fit Line
plots a model of the relationship between measures. There are many types of fit 
lines, including linear fit, quadratic fit, cubic fit, and penalized B-spline.

Forecasting
estimates future values for your data based on statistical trends.

Correlation

Correlation identifies the degree of statistical relationship between measures. The 
strength of a correlation is described as a number between -1 and 1. A value that is 
close to -1 implies a strong negative correlation, a value that is close to 0 implies little or 
no correlation, and a value that is close to 1 implies a strong positive correlation.

To apply correlation to a visualization, add a linear fit line, or select the correlation 
matrix visualization type.

For a heat map or a simple scatter plot, the correlation is identified by a text label in the 
visualization legend. Select  to view additional details about the correlation, including 
the exact correlation value.

For a scatter plot matrix, the correlation for each plot is identified by a colored border 
around the plot. The visualization legend displays a key for the color values. Select  to 
view additional details about the correlation, including the exact correlation values for 
each plot.

Note: For nonlinear fit types, a scatter plot matrix displays additional plots to show each 
intersection of variables in two orientations. For example, if a scatter plot matrix plots 
the variables A, B, and C, then plots are created for both A * B and B * A when a 
nonlinear fit line is applied.

For a correlation matrix, the correlation for each cell is identified by the color of the cell 
background. The visualization legend displays a key for the color values. The data tip 
for each cell displays the correlation value.
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Fit Lines

A fit line plots a model of the relationship between measures. You can apply fit lines to 
scatter plots and heat maps.

You can apply the following types of fit line to your visualization:

Best Fit
tests the cubic, quadratic, and linear fit methods against your data, and selects the fit 
method that produces the best result. To see which fit method was used, select 
from the visualization legend.

Linear
creates a linear fit line from a linear regression algorithm. A linear fit line produces 
the straight line that best represents the relationship between two measures. For 
more information about the linear fit line, select  from the visualization legend.

For a linear fit, correlation is automatically added to the visualization. Correlation is 
not available with other fit types.

Quadratic
creates a quadratic fit line. A quadratic fit produces a line with a single curve. A 
quadratic fit line often produces a line with the shape of a parabola. For more 
information about the quadratic fit line, select  from the visualization legend.

Cubic
creates a cubic fit line. A cubic fit line produces a line with two curves. A cubic fit line 
often produces a line with an “S” shape. For more information about the cubic fit line, 
select  from the visualization legend.

PSpline
creates a penalized B-spline. A penalized B-spline is a smoothing spline that fits the 
data closely. A penalized B-spline can display a complex line with many changes in 
its curvature. For more information about the penalized B-spline, select  from the 
visualization legend.

Overview of Data Analysis in SAS Visual Analytics Explorer 263



Forecasting

Forecasting estimates future values for your data based on statistical trends. 
Forecasting is available only for line charts that contain date or time data items.

A forecast adds a line with a predicted values to your visualization and a colored band 
that represents the 95% confidence interval. The 95% confidence interval is the data 
range where the forecasting model is 95% confident that the future values will be.

The explorer automatically tests multiple forecasting models against your data, and then 
selects the best model. To see which forecasting model was used, select  from the 
visualization legend.

The forecast model can be any one of the following:

n Damped-trend exponential smoothing

n Linear exponential smoothing

n Seasonal exponential smoothing

n Simple exponential smoothing

n Winters method (additive)

n Winters method (multiplicative)

Add a Fit Line to an Existing 
Visualization

To add a fit line to a scatter plot or heat map, select the  drop-down list from the 
visualization toolbar, and then select Fit Line  [fit-type]. For information about the fit 
types that are available, see “Fit Lines” on page 263.

264 Chapter 26 / Performing Data Analysis



Add Forecasting to an Existing 
Visualization

To add data analysis to a line chart, select the  drop-down list from the visualization 
toolbar, and then select Show Forecast.

Note: To apply forecasting, the line chart must contain a date, time, or datetime item.

On the Properties tab for the line chart visualization, you can adjust the number of data 
points to predict by using the Duration option.

On the Roles tab, you can add measures to the forecast as Underlying factors. The 
forecasting model evaluates the additional measures to determine whether they 
contribute to the accuracy of the forecast. If the additional measures do not increase the 
accuracy of the forecast, then they are not used. If the additional measures do increase 
the accuracy of the forecast, then the forecast line is adjusted, and the confidence 
bands are narrowed.

If your forecast includes underlying factors, then you can apply scenario analysis to the 
forecast. For more information, see “Apply Scenario Analysis to a Forecast” on page 
266.

Forecast Measures as a New 
Visualization

To create a visualization that forecasts multiple measures:

1 Select Analysis  Forecast. The Forecast window appears.

2 From the Date category drop-down list, select the date, time, or datetime data item 
for the forecast.
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3 From the Forecast area, select the measures that you want to include in the 
forecast.

4 (Optional) If you selected a single measure for Forecast, then you can also select 
additional measures to use as Underlying factors in the forecast. The forecasting 
model evaluates the additional measures to determine whether they contribute to the 
accuracy of the forecast. If the additional measures do not increase the accuracy of 
the forecast, then they are not used. If the additional measures do increase the 
accuracy of the forecast, then the forecast line is adjusted, and the confidence 
bands are narrowed.

5 In the Forecast duration field, enter the number of data values that you want to 
predict for the forecast.

6 Click OK to create the visualization. The visualization is created as a line chart.

Apply Scenario Analysis to a Forecast

If the forecast for a line chart contains underlying factors, then you can apply scenario 
analysis to explore hypothetical scenarios.

To apply scenario analysis:

1 If the table view for the line chart is not shown, then select the  drop-down list from 
the visualization toolbar, and then select Show table view.

2 In the table view, select the Scenario Analysis tab. For each of the measures that 
are assigned to the forecast as underlying factors, a line displays the values of the 
measure, and a series of points enables you to set the future values for the 
measure.

3 Use the check box beside each measure to choose which measures are used in the 
scenario analysis.
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4 For each measure in the scenario analysis, set the future data values. You can set 
the values by using any of the following methods:

n drag each data point upward or downward on the line plot on the Scenario 
Analysis tab. To select the accuracy of the points, select the  icon beside the 
measure name, and select Snap interval.

n enter the value for each data point. Right-click on each data point, and select Set 
point value.

n set all of the values for the measure. Right-click on a data point, and select Set 
series values. The Change future values window enables you to set all of the 
values to a specific value or to adjust the future values relative to the most recent 
observed value of the measure. 

To reset any data point to its original value, right-click on the data point, and then 
select Reset point.

To reset all of the data points for a measure, right-click on any data point for the 
measure, and then select Reset entire series.

5 When you are finished setting the future data values for the scenario, click Update 
to apply the scenario to the forecast.

The forecast is updated to show the results of the scenario. The original forecast is 
displayed as an additional line that is labeled (Baseline).

To remove the scenario analysis from a forecast, click Reset to forecast on the 
Scenario Analysis tab.
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About the SAS Visual Analytics 
Designer

The SAS Visual Analytics Designer (the designer) enables users to easily create reports 
or dashboards that can be saved and viewed on either a mobile device or in the viewer. 
The designer is part of the SAS Visual Analytics product that enables a user with either 
the SAS Visual Analytics: Analysis role or the SAS Visual Analytics: 
Administration role can view, interact with, and create reports. Simply open an existing 
report and interact with the information based on your current needs. Report authors 
can easily point and click to query central sources of data. You can drag and drop 
tables, graphs, and gauges to create a well-designed report. You can also add text, 
images, stored processes, and controls to reports. All of this is accomplished by using 

271



the designer, which runs in a web browser. You do not need to understand a 
programming language to create reports.

Report authors can easily create reports and dashboards based on data sources that 
have been provided by a system administrator. They can update reports that were 
created from visual explorations. Report authors can create reports by importing objects 
or visual explorations from other reports. They can also define interactions (either 
filtering or brushing) for report objects, and then include SAS analytical results in a 
single report.

Your First Look at the Designer

When you are designing reports in SAS Visual Analytics, you see the designer. In 
general, data-related tasks are initiated from the leftmost pane, and presentation-related 
tasks are initiated from the rightmost pane.

272 Chapter 27 / Overview of SAS Visual Analytics Designer



Here are the features of the designer:

Figure 27.1 The Designer

1 The application bar enables you to return to the SAS Visual Analytics home page 
and access your recently created or viewed reports. You can also access recently 
used visual explorations, stored processes, or visual data builder queries in your 
recent history. When you select a visual exploration, the application takes you to the 
explorer. When you select a stored process, the application takes you to SAS Visual 
Analytics Viewer (the viewer). When you select a visual data builder query, the 
application takes you to SAS Visual Data Builder (the data builder).
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2 The menu bar provides menu items that apply to the entire report or to the currently 
displayed report section. Actions include creating a new report, adding a new 
section, inserting new report objects, adding interactions, and launching the viewer 
without returning to the home page. You can also log off from SAS Visual Analytics.

3 The toolbar contains icons that enable you to manage your reports. You can click 
to hide the left and right panes. Or, you can click  to display the left and right 
panes. You can access the report views by clicking , , or  on the menu bar.

4 The Objects, Data, Imports, and Shared Rules tabs are in the left pane. The 
Objects and Data tabs are displayed by default. You can choose to display icons 
instead of names on the tabs. To display the icons on the tabs, click  after the last 
tab name, and select Show icons only. From this menu, you can also choose which 
tabs are displayed.

The Objects tab provides a list of the tables, graphs, gauges, and controls that can 
be used in a report or dashboard.

The Data tab enables you to select a data source (or data sources) and the data 
items for your report. You can add, refresh, or remove a data source using the icons 
above the list of data items. Using the menu, you can change the data source, 
define a hierarchy, define a calculated item, define an aggregated measure, and 
show or hide data items. You can check the details for the measures in the data set. 
For more information, see “Working with Data Items in a Report” on page 355.

The data item table on the Data tab provides information about a selected data item, 
including the name, role, format, aggregation, and sort options. These data item 
properties can be modified, which impacts all of the report objects that use the data 
item. For more information, see “Modify Data Item Properties” on page 368.

The Imports tab provides a list of reports and report objects that have been created 
in the designer or exported from the explorer. This enables you to create reports 
from multiple data sources and create full-featured reports. You can choose objects 
or sections in these reports to include in either a new or an existing report.

The Shared Rules tab enables you to create a new display rule for a gauge, which 
is used by other gauges to designate intervals and colors for ranges. You can edit or 
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delete an existing shared display rule. These display rules are shared across 
multiple gauges and can be created at any time.

5 The canvas is the workspace for building a report. You can modify the canvas using 
the report view icons on the toolbar. For more information, see “Creating a New 
Report” on page 288. The appearance of the canvas is affected by the report 
theme. For more information, see “Report Themes” on page 279.

A report can have multiple sections, which can be accessed by using the tabs at the 
top of the canvas. For more information, see “Maintaining Multi-Section Reports” on 
page 461.

There is an area at the top of the canvas where you can drop filter controls and then 
categories to create section prompts.

6 The tabs in the right pane enable you to work with details about the report and report 
objects. The Properties, Styles, and Display Rules tabs are displayed by default. 
You can choose to display icons instead of tab names on the tabs. To display the 
icons on the tabs, click  after the last tab name, and select Show icons only. 
From this menu, you can also choose which tabs are displayed.

The Properties tab lists the properties for the currently selected report or report 
object. The report’s title and description are listed. The object’s name, title, and 
description are listed. Information that is specific to the report object type, such as 
the axes and legend, are listed. If a report object is not selected on the report 
canvas, then the properties are for the section and the report.

The Styles tab enables you to specify the data styling, frame styling, text styling, 
and data colors for a selected report object. You can specify the report theme for the 
report.

The Display Rules tab enables you to populate, add intervals, or color-mapped 
values for an object that is currently selected on the report canvas. You can edit or 
delete an existing display rule for the selected table, graph, gauge, or control. For 
more information, see “Overview of Display Rules” on page 395.

The Comments tab enables you to add comments to the report after you save it. 
For more information, see “Adding Comments to Reports” on page 345.
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The Filters tab enables you to add a filter (or filters) to the selected report object. 
For more information, see “About Report Filters” on page 411.

The Interactions tab enables you to add or update filter or brush interactions with 
the report objects in a section. For more information, see “Creating Interactions” on 
page 434.

The Ranks tab enables you to add rankings to report objects. For example, you 
might want to see the top 10 products that sold last year. For more information, see 
“Overview of Ranking in Reports” on page 455.

The Roles tab enables you to add or update data role assignments in a selected 
report object that has a data source. For more information, see “Modifying Data Role 
Assignments in Report Objects” on page 386.

Open Window

About the Open Window

Click  on the menu bar or select File  Open to display the Open window.

The Open window enables you to search for and open saved reports. In addition, the 
Open window enables you to create new folders and perform many other tasks on 
selected reports and folders.
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Display 27.1 Open Window

Working with Folders in the Open Window

You can work with folders in the Open window. Icons in the Open window are located to 
the right of the drop-down list of folder names, as shown in Display 27.1 on page 277.

Icon Action

Navigates back one level.

Navigates up one level.

Refreshes the items in the current location.

Deletes the selected item.

Creates a new folder.

Specifies either the Details or List view.

Opens the Search window.

You can create a new folder when you copy a report, move a report, or save a report.
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Search Window

The Search window in the designer enables you to find the report that you need. For 
example, you might need to navigate through multiple folders to find a report. In the 
Open window, click  to open the Search window.

Display 27.2 Search Window

To search for a report:

1 In the Name field, enter the text for which you want to search.

2 (Optional) To include descriptions in your search, select the Include description 
and keywords check box.

3 Select a Location. If you want to search multiple folders, make sure that the Search 
all subfolders check box is selected.

4 (Optional) To limit your search by time, select a Date range. You can also specify 
either Date created or Date modified.

5 Click Search.
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Report Themes

Report themes are available in the designer. You can select a report theme for each 
report using the Styles tab. By default, the choices are SAS Light or SAS Dark. Your 
site might also have custom report themes. Custom report themes are automatically 
created when a coordinating custom application theme is created in SAS Theme 
Designer for Flex.

Alternatively, you can set a preference for a default report theme. For more information, 
see “Specifying Your Preferences for the Designer” on page 281.

Users who have the Theme Designer for Flex:Administration role or a custom role 
that has the Customize Themes capability enabled will see a Customize Theme button 
on the Styles tab. Click Customize Theme to go to SAS Theme Designer for Flex. For 
more information about report styles and application themes, see SAS Theme Designer 
for Flex: User's Guide.
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Specifying Global and General Preferences . . . . . . . . . . . . . . . . . . . . . . . 281

Specifying Your Preferences for the Designer . . . . . . . . . . . . . . . . . . . . 281

Specifying Global and General 
Preferences

To specify global SAS preferences, see “Specifying Global Preferences” on page 16. To 
specify general preferences, see “Specifying the SAS Visual Analytics General 
Preferences” on page 17.

Specifying Your Preferences for the 
Designer

To specify preferences that are specific to SAS Visual Analytics Designer (the 
designer):

1 Select File  Preferences to open the Preferences window.

2 Select SAS Visual Analytics  General.
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Display 28.1 Preferences Window for the Designer

3 Specify your default view for new or existing reports. Select Full screen, Tablet (for 
mobile devices), or Wide-screen tablet. Full screen is the default.

4 Select your default report theme. Select Application theme, SAS Light, or SAS 
Dark. Application theme is the default.

5 Click OK to apply your changes.
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Opening Reports in the Designer

Reports in SAS Visual Analytics Designer (the designer) are saved when you use either 
the Save window or the Save As window. A saved report contains at least one section. 
Typically, a section uses data items from a data source to perform queries. The section 
displays the results with one or more report objects (for example, a table, a graph, a 
gauge, a control, and so on).

A section is not required to contain any report objects. For example, you might have a 
report that you use as a template to create other reports. Your template-like report might 
contain data sources, calculated items, global data filters, and shared display rules, but 
it does not contain report objects.

To open a saved report:

n On the home page, select a report. In the details view, click Edit. Or, you can 
double-click on the report that you want to open.

n In the designer:

o Select File  Recent, and then select a report name.
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o Click  beside the recent content drop-down list at the top of the window, and 
then select a report name.

o Click  on the menu bar to navigate to a report, and then select it.

o Select File  Open to display the Open window.
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An Example Report

The following display shows a report in the designer. The report contains a bar chart, a 
line chart, and a list table. It has two sections.

Display 29.1 An Example Report
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About Reports

You can drag and drop tables, graphs, gauges, and controls to create a well-designed 
report in SAS Visual Analytics Designer (the designer). You can add text, images, and 
other controls to reports. Reports can contain multiple sections.

When you design a report, keep in mind that it might look slightly different on a mobile 
device or in the viewer. For example, the layout of the tiles in the treemap is dependent 
on the size of the display area. This means that the same treemap might appear slightly 
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different in the designer than it does in the viewer or on a mobile device. For more 
information about treemaps, see“About Treemaps” on page 315.

Reports that are imported from SAS Visual Analytics Explorer (the explorer) might look 
slightly different in the designer.

The designer provides a report view that enables you to change the size of the canvas 
that you use for laying out reports. There are three report views: Full Screen, Tablet, or 
Wide-Screen Tablet. The default report view is Full Screen. You can access the report 
views from the View menu or by the icons ( , , or ) on the menu bar.

Two report layouts are available in the designer: Precision and Tiled. For more 
information, see “Choosing a Report Layout” on page 291.

Creating a New Report

There is no single process for creating a new report in the designer. For example, some 
users select their data source (or data sources) before they add the report objects while 
other users add report objects to the canvas and then select their data source (or data 
sources). Some users choose to update the properties and styles for their reports while 
other users choose not to. The following list of steps is one way that you can create a 
new report in the designer.

To create a new report:

1 Select a data source with the associated data items. For information about selecting 
data, see Chapter 32, “Selecting Data for Reports,” on page 349.

2 (Optional) Select the layout (precision or tiled) for the report. For more information, 
see “Choosing a Report Layout” on page 291.

3 Select the report object (or report objects) that you want to use in the report. For 
information about selecting report objects, see “Using Tables, Graphs, Gauges, 
Controls, and Other Report Objects” on page 300.
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4 Add report objects by dragging and dropping them onto the canvas or by double-
clicking the report object on the Objects tab. You can tab over a report object, and 
press Enter to add the report object to the canvas.

5 Add data items to report objects by dragging and dropping them onto the canvas or 
by right-clicking on the report object (or report objects) and using the context menu.

6 (Optional) Update the properties for the report and the report objects. For 
information about properties, see “Using Tables, Graphs, Gauges, Controls, and 
Other Report Objects” on page 300.

7 (Optional) Update the styles for the report objects. For information about selecting 
styles, see “Using Tables, Graphs, Gauges, Controls, and Other Report Objects” on 
page 300.

8 (Optional) Modify data role assignments. For more information, see “Modifying Data 
Role Assignments in Report Objects” on page 386.

9 (Optional) Create or modify display rules. For more information, see “Adding Display 
Rules to a Gauge” on page 408.

10 (Optional) Add filters to the report. For more information, see “About Report Filters” 
on page 411.

11 (Optional) Add interactions between the report objects in a section. For more 
information, see “Overview of Interactions” on page 433.

12 (Optional) Add a rank to a report object (or report objects). For more information, see 
“Adding a New Rank” on page 456.

13 (Optional) Add a new section (or sections) to the report. For more information, see 
“Overview of Report Sections” on page 461.

14 Save your report. For more information, see “Saving a Report” on page 294.

15 (Optional) E-mail your saved report. For more information, see “E-mailing a Report” 
on page 295.
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16 (Optional) Add comments to your saved report. For more information, see “Adding 
Comments to Reports” on page 345.

You can create a new report based on an existing report or on existing report objects 
from a report that you have imported. For more information, see “Basing a New Report 
on Report Objects Imported from One or More Existing Reports” on page 292.

Specify Report Properties

You can view or update report properties using the Properties tab in the right pane. For 
example, you can view a report title and specify a description.

To view the report’s title and update the description:

1 In the right pane, click the Properties tab.

2 Click  to open the object inventory list, and then select the report name.

Here is an example of an object inventory list for a report:

Display 30.1 Object Inventory List on the Properties Tab

Note:  You can use the object inventory list to navigate to different sections or 
report objects.

3 (Optional) Update the Description for the report.
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Here is an example of the title and the description for a report:

Display 30.2 Report Properties

You can use the Properties tab to update the properties for individual report objects. 
The available properties depend on the selected report object.For information about 
updating report object properties, see “Using Tables, Graphs, Gauges, Controls, and 
Other Report Objects” on page 300.

Choosing a Report Layout

The following report layouts are available in the designer:

Precision
enables you to place, align, and size report objects. The precision layout allows 
report objects to overlap, and lets users control the depth order of these overlapping 
objects by sending objects backward or bringing them forward. (For example, you 
might want your company logo to display behind a bar chart and a pie chart in your 
report).

This layout option is keyboard accessible.

Tiled
provides you a quick way to place report objects directly next to other report objects. 
The report objects cannot overlap. All report objects in the section are sized to fit in 
one screen. If you adjust the size of an object, then the other objects automatically 
resize to ensure that all objects continue to fill the entire screen.
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Note: You can switch from the tiled layout to the precision layout after you have added 
report objects to your report. However, this action can change the size and the position 
of the report objects.

To choose your report layout:

1 Select a section tab.

2 In the right pane, click the Properties tab.

3 For Layout, select either Precision or Tiled. The Tiled layout is the default.

Here is an example of the Precision layout on the Properties tab:

Display 30.3 Properties Tab for Precision Layout

4 (Optional) If you select Precision, then you can specify Fit to screen. The Fit to 
screen option prevents objects from being sized too wide or too tall, which can 
cause the report viewing area for the section to scroll.

Basing a New Report on Report Objects 
Imported from One or More Existing 
Reports

If there is an existing saved report that closely matches the report that you want to 
create, then you can open the existing report that contains the report objects that you 
want to reuse. The report objects can be from either a report that has been saved in the 
designer or from a report that has been exported from the explorer. (For example, you 
might want to reuse calculated data items or hierarchies from an existing report in your 
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current report.) You can immediately save the report with a new name, or you can 
customize the existing report, and then save it.

To base a new report on report objects that have been imported from one or more 
existing reports:

1 Open or import the existing report by doing one of the following:

n On the home page, double-click on the report that you want to open.

n In the designer, do one of the following:

o Select File  Recent, and then select the report name.

o Click  beside the recent content drop-down list at the top of the window, 
and then select a report name.

o Click  on the menu bar to navigate to a report, and then select it.

o Select File  Open to display the Open window and select a report.

o Click Imports in the left pane. If the Imports tab is not visible, select View  
Imports.

Select a report name from Select a report to import, or click Import another 
report to display the Open window, where you can select a report.

Display 30.4 Imports Tab with a Report List

In the tree view on the left, a list of sections and report objects appears. Drag 
a single report object, multiple report objects, or an entire section that you 
want to include in the new report, and drop it onto the canvas.
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Display 30.5 Imports Tab with a List of Report Objects

Note: Report objects that cannot be imported from the explorer are not 
displayed on the Imports tab.

2 (Optional) Modify the report objects, properties, styles, roles, filters, and display 
rules.

3 Select File  Save, or click , which displays the Save As window. Enter a Name. 
Report names cannot use these characters: / \ 

4 Click Save.

Saving a Report

To save a report:

1 Select File  Save, or click . If you are saving a new report, then the Save As 
window is displayed.

2 For a new report, enter a Name. Report names cannot use these characters: / \ 

If you are saving an existing report, then the name of that report is listed. You can 
either leave the name as it is and overwrite the existing report, or you can change 
the name to create a new report.
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Display 30.6 Save As Window

3 Click Save.

E-mailing a Report

You can e-mail a report to someone. If the recipient opens the e-mail message on a PC 
or Mac with a Flash-enabled viewer, and then clicks the e-mail link, then the report is 
displayed in the viewer. If the recipient opens the e-mail message on a mobile device, 
and then clicks the e-mail link, then the report is displayed using the SAS Mobile BI app 
if the user has it installed.

To e-mail a report from the designer:

1 Select File  E-mail. The E-mail window is displayed. The URL for the report is 
automatically generated, and a preview appears in the e-mail message.

2 Enter the recipient’s e-mail address.
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Display 30.7 E-mail Window

3 (Optional) Enter a comment for the report.

4 Click Send.

Printing a Report

This is a pre-production feature.

Note:  You must save a report before you can print it.
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To print a report:

1 Select File  Print, or click . The Print window is displayed.

2 Select the Paper size, Orientation, Options, and Margins.

Clearing the Retain the graph quality when the document is resized check box 
means that the quality of the report will be compromised if you look at the report at a 
zoom percentage greater than 100%.

Selecting the Show all rows in a table check box means that the data in the table 
will not be truncated. Specifying this option can impact the layout of the table.

Display 30.8 Print Window

3 Click Print.
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Using Tables, Graphs, Gauges, Controls, 
and Other Report Objects

After selecting your data source and data items, add one or more report objects to 
display the results. The SAS Visual Analytics Designer (the designer) provides report 
objects for all of your reports. (You can also select data after you add report objects to 
the canvas.) Report objects in the designer are grouped into these types on the Objects 
tab in the left pane and in the Insert menu: Tables, Graphs, Gauges, Controls, and 
Other.
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The following table types are available in the designer:

n list tables

n crosstabs

For more information, see “Using Tables to Display Results” on page 303.

The following graph types are available in the designer:

n bar charts

n targeted bar charts

n waterfall charts

n line charts

n pie charts

n scatter plots

n time series plots

n bubble plots

n treemaps

n dual axis bar charts

n dual axis line charts

n dual axis bar-line charts

n dual axis time series plot

For more information, see “Using Graphs to Display Results” on page 310.

The following gauges types are available in the designer:

n bullet

n slider

n thermometer

n dial
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n speedometer

For more information, see “Using Gauges to Display Results” on page 321.

The following control types are available in the designer:

n drop-down lists

n lists

n button bars

n text input fields

n range sliders

For more information, see “Using Controls to Display Results” on page 327.

These other objects are also available in the designer:

n text

n image

n stored processes

n vertical containers

n horizontal containers

n geo bubble maps

n geo region maps

For more information, see “Using Other Object Types in Reports” on page 332.

In the designer, you have access to report with report objects from SAS Visual Analytics 
Explorer (the explorer). You can open a histogram, heat map, box plot, or correlation 
matrix in a report that has been exported from the explorer. However, you cannot create 
new histograms, heat maps, box plots, or correlation matrices in the designer.
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Using Tables to Display Results

Overview of the Table Types

About List Tables

A list table is a two-dimensional representation of data in which the data values are 
arranged in unlabeled rows and labeled columns. List tables can use any data items 
from a data source. A list table cannot use a hierarchy or a percentage of total item.

By default, a list table contains aggregated data with one row for each distinct 
combination of category values. However, if the Show detail data check box has been 
selected, then all of the data is not aggregated.

You can add sparklines to a column (if the data source contains a date data item) when 
aggregated data is displayed in the list table.

Display 31.1 A List Table

About Crosstabs

A crosstab (also known as a crosstabulation table) shows an aggregate metric for the 
intersections of two or more categories. Crosstabs often have two or more categories 
assigned to both the rows and columns, forming a matrix. Crosstabs can be easier to 
read than list tables because they often use less space, and they always collapse 
repeating values for outer category data items into one unique value, which is known as 
grouping. You can choose to show subtotals and totals by selecting the appropriate 
check box (or check boxes) on the Properties tab for the crosstab. A crosstab can use 
a hierarchy.
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You cannot add a sparkline or display rules to a crosstab.

You should consider placing lower cardinality (fewer distinct values) categories on the 
columns and higher cardinality (more distinct values) categories on the rows. Crosstabs 
can help you improve readability especially when there are several category data items 
to include in your table.

Display 31.2 A Crosstab

Note: By default, frequency is displayed only when there are no measures in the 
crosstab.

Insert a Table into a Report

1 To insert a table into a report, choose one of the following methods:

n Drag the table icon from the Objects tab in the left pane and drop it onto the 
report canvas.
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n Select Insert  Tables, and then select the table object that you want to insert. 
The table is automatically placed in the report canvas. If you want the table to 
appear in a different location, then drag and drop it in a new location.

Note: For list tables only, you can press the Ctrl key to select multiple data 
items, and then drag and drop them onto the table in the report canvas.

The following table lists the available table objects:

Icon Table Type

List Table

Crosstab

2 To insert the data items that you want to use in the table:

n Drag and drop data items onto the table.

n Use the Roles tab in the right pane, and then specify the Category and 
Frequency roles.

Specify Table Properties

To specify the properties for tables:

1 If it is not already selected, select the table in the report canvas that you want to 
update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the table. You can update the Name, Title, 
Format, and Description.

4 Update the object-specific properties for the table.

For a list table, you can specify that you want to enable sorting and that you want to 
show detail data, headings, and totals.
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For a crosstab, you can specify that you want an indented layout and totals and 
subtotals for columns, rows, or both. You can specify the placement of the totals and 
subtotals. For more information, see “Add Percentage of Total or Percentage of 
Subtotals to a Crosstab” on page 308.

Here is an example of the properties for crosstabs:

Display 31.3 Properties for a Crosstab

306 Chapter 31 / Displaying Results Using Report Objects



Specify Table Styles

To specify styles for tables:

1 If it is not already selected, select the table in the report canvas that you want to 
update.

2 In the right pane, click the Styles tab.

3 Update the styles for the table.

For a list table, you can customize the colors of Cells, Column headings, and 
Totals.

For a crosstab, you can customize the colors of Cells, Row headings, Column 
headings, Measure headings, Totals, and Subtotals.

Add Sparklines to a List Table

A sparkline is a small line graph that presents a single trend over time. A sparkline is 
about the size of one or two words, so it fits in a single cell and repeats for each row in a 
column. A sparkline does not have axes or labels. They are frequently used to present 
stock trends or production rates over time. A sparkline is intended to be both succinct 
and noteworthy.

In the designer, you can add sparklines to a column in a list table. The data source for 
the list table must include a date, datetime, or time data item before you can add a 
sparkline.

To add sparklines:

1 If it is not already selected, select the list table in the report canvas that you want to 
update.

2 Right-click the list table and then select Add Sparkline. The Add Sparkline window 
is displayed.
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Display 31.4 Add Sparkline Window

3 Enter a Column label.

4 For Time Axis, select a date, datetime, or time data item in the current data source.

5 Select a Measure (line).

6 (Optional) Select the Set baseline check box. Enter a Value and select a Fill type. 
Your choices are Gradient or Solid.

7 Click OK. The sparkline is added to the last column in the list table. You can move 
the sparkline to another location in the table.

To edit a sparkline, right-click in the sparkline column in the list table, and then select 
Edit Sparkline. The Edit Sparkline window is displayed. Update the information, and 
then click OK to save your changes.

To delete a sparkline, right-click in the sparkline column in the list table, and then select 
Remove Sparkline.

Add Percentage of Total or Percentage of 
Subtotals to a Crosstab

You can add a percentage of total, a percentage of column total, a percentage of 
column subtotal, a percentage of row total, and a percentage of row subtotal to a 
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crosstab in the designer. You can create these percentages only when the source data 
item has an aggregation of Sum or Count.

Note: The percentage of total or percentage of subtotals is relative to the subset of 
data that is selected by your filters and ranks.

For example, you might derive the percentage of total for a measure that contains 
revenue values.

To add a percentage of total to a crosstab:

1 If it is not already selected, select the crosstab in the report canvas that you want to 
update.

2 Right-click on a measure in the crosstab, and then select Add Percent of Total. The 
new percentage of total is added to right of the original measure in the crosstab.

To add a percentage of subtotals to a crosstab:

1 If it is not already selected, select the crosstab in the report canvas that you want to 
update.

2 Right-click on a measure in the crosstab, and then select Add Percent of 
Subtotals. The Add Percent of Subtotals window is displayed.

Display 31.5 Add Percent of Subtotals Window

3 Select the check box (or check boxes) for the subtotal items.

n Percent of column subtotal
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n Percent of column total

n Percent of row subtotal

n Percent of row total

The available check boxes depend on the number of categories on rows or 
categories on columns for the measure that you selected.

4 Click OK. The new percentage of subtotals is added to the right of the original 
measure the crosstab. The default names are as follows:

n <MeasureName> (Percent of Column Total) or <MeasureName> (Count Percent 
of Column Total), depending on whether the aggregation of the source measure 
was Sum or Count.

n <MeasureName> (Percent of Column Subtotal) or <MeasureName> (Count 
Percent of Column Subtotal), depending on whether the aggregation of the 
source measure was Sum or Count.

n <MeasureName> (Percent of Row Total) or <MeasureName> (Count Percent of 
Row Total), depending on whether the aggregation of the source measure was 
Sum or Count.

n <MeasureName> (Percent of Row Subtotal) or <MeasureName> (Count Percent 
of Row Subtotal), depending on whether the aggregation of the source measure 
was Sum or Count.

Using Graphs to Display Results

Overview of the Graph Types

About Bar Charts

A bar chart consists of vertical or horizontal bars that represent quantitative data. Use 
bar charts to compare data that is aggregated by the distinct values of a category.
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You can apply grouping and create lattices. You can filter or rank your data based on a 
specified number of top or bottom values.

Display 31.6 A Bar Chart

About Targeted Bar Charts

A targeted bar chart is a variation of the bar chart that has pointers to target values. In 
this example, the pointers appear above each bar.

Display 31.7 A Targeted Bar Chart

About Waterfall Charts

A waterfall chart (also known as a progressive bar chart) shows how the initial value of 
a measure increases or decreases during a series of operations or transactions. The 
first bar begins at the initial value, and each subsequent bar begins where the previous 
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bar ends. The length and direction of a bar indicate the magnitude and type (positive or 
negative, for example) of the operation or transaction. The resulting chart is a stepped 
bar showing how incremental changes lead to the final value of the measure..

Display 31.8 A Waterfall Chart

About Line Charts

A line chart shows the relationship of one or more measures over some interval, such 
as time or a series of ranges. You can measure a single measure (univariate analysis), 
or you can show the relationships among multiple measures (multivariate analysis), 
such as the leading or lagging relationship between advertising and sales over time. 
The category on the X axis of a line chart is discrete; the category on the X axis of a 
time series plot is continuous.

You can apply grouping and create lattices.
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Display 31.9 A Line Chart

About Pie Charts

A pie chart displays a part-to-whole relationship in a circle divided into multiple slices for 
each value of a category data item based on a single measure data item. Each slice 
represents the relative contribution of each part to the whole. In a pie chart, the legend 
is sorted by contribution.

Effective pie charts limit the number of slices to 5 or 6. In the designer, you can use a 
rank to reduce the number of slices in a pie chart. For more information, see “Adding a 
New Rank” on page 456.

Display 31.10 A Pie Chart
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About Scatter Plots

A scatter plot is a two-dimensional plot that shows the relationship of two measure data 
items. Each marker (represented by a symbol such as a dot, a square, or a plus sign) 
represents an observation. The marker’s position indicates the value for each 
observation. Use a scatter plot to examine the relationship between numeric data items. 
You can apply grouping by assigning a category to the Color role.

Scatter plots do not use aggregated data.

Display 31.11 A Scatter Plot

About Time Series Plots

A time series plot shows an ordered sequence of values that are observed at equally 
spaced time intervals. A time series plot requires a date, datetime, or time data item that 
is continuous.

Display 31.12 A Time Series Plot

314 Chapter 31 / Displaying Results Using Report Objects



About Bubble Plots

A bubble plot is a variation of a scatter plot in which the markers are replaced with 
bubbles. A bubble plot displays the relationships among at least three measures. Two 
measures are represented by the plot axes, and the third measure is represented by the 
size of the plot markers. Each bubble represents an observation. A bubble plot is useful 
for data sets with dozens to hundreds of values. You can add categories to the 
Grouping and Lattice roles.

Display 31.13 A Bubble Plot

Note: A bubble’s size is scaled relative to the minimum and maximum values of the 
size variable. The minimum and maximum sizes are illustrated in the plot legend. The 
actual value for each bubble is displayed as a data tip. For example, the legend that is 
displayed in Display 31.13 on page 315, the minimum size is 1.3 and the maximum size 
is 8.3.

About Treemaps

A treemap displays your data as a set of rectangles (called tiles). Each tile represents a 
category or a hierarchy node. The color of each tile represents the value of the first 
measure. The size of each tile represents the value of the second measure. (There are 
two data roles for measures in a treemap—Size and Color.) For example, a sales data 
treemap might have tile sizes that represent the number of orders, and it might have tile 
colors that are derived from color gradients that represent sales.

Treemaps can display a large number of category values that might be hierarchical in a 
relatively small amount of space, so it is easy to see small changes or exceptions.
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The layout of the tiles in the treemap is dependent on the size of the display area. This 
means that the same treemap might appear slightly different in the designer than it does 
in the viewer or on a mobile device.

Display 31.14 A Treemap

About Dual Axis Bar Charts

A dual axis bar chart is a variation of the bar chart that has two measures. A measure is 
on each axis.

Display 31.15 A Dual Axis Bar Chart

About Dual Axis Line Charts

A dual axis line chart is a variation of the line chart that has two measures. A measure is 
displayed on both the left and right side of the Y axis. The relationship between two 
measures can be examined on two different scales in a dual axis line chart.
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Display 31.16 A Dual Axis Line Chart

About Dual Axis Bar-Line Charts

A dual axis bar-line chart is a variation of the bar chart that has two measures. A 
measure is on each axis, and the bar chart is overlaid by a line chart.

Display 31.17 A Dual Axis Bar-Line Chart

About Dual Axis Time Series Plots

A dual axis time series plot is a variation of the time series plot that has two measures. 
A measure is displayed on both the left and right side of the Y axis.

For example, a dual axis time series plot can be useful when you need to display two 
measures that have the same unit of measurement and different scales, such as 
quantity ordered and returns, or when you need to display two measures that have 
different units of measurement, such as sales and quantity ordered.
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Display 31.18 A Dual Axis Time Series Plot

Insert a Graph into a Report

1 To insert a graph into a report, choose one of the following:

n Drag the graph icon from the Objects tab in the left pane and drop it onto the 
report canvas.

n Select Insert  Graphs and then select the menu item for the graph object that 
you want to insert. The graph is automatically placed in the report canvas. If you 
want the graph to appear in a different location, then drag and drop it in a new 
location.

The following table lists the available graph objects:

Icon Graph Type

Bar Chart

Targeted Bar Chart

Waterfall Chart

Line Chart

Pie Chart
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Icon Graph Type

Scatter Plot

Time Series Plot

Bubble Plot

Treemap

Dual Axis Bar Chart

Dual Axis Line Chart

Dual Axis Bar-Line Chart

Dual Axis Time Series Plot

2 To insert the data items that you want to use in the graph:

n Drag and drop data items onto the graph.

n Use the Roles tab in the right pane, and then specify the Category and 
Frequency roles.

Specify Graph Properties

To specify the properties for graphs:

1 If it is not already selected, select the graph in the report canvas that you want to 
update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the graph. You can update the Name, Title, 
Format, and Description.
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4 Update the specific properties for the graph. The available properties depend on the 
selected graph type. For example, for a pie chart, you can specify Data Labels, 
Group Style, and Legend properties.

Here is an example of the properties for a pie chart:

Display 31.19 Properties for a Pie Chart
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Specify Graph Styles

To specify styles for graphs:

1 If it is not already selected, select the graph in the report canvas that you want to 
update.

2 In the right pane, click the Styles tab.

3 Update the styles for the graph. The available styles depend on the selected graph 
type. For example, for a pie chart, you can specify Data Styling, Frame Styling, 
Text Styling, and Data Colors.

Using Gauges to Display Results
A gauge is a dashboard indicator (also known as a KPI) that displays the status or 
measure of a variable or variables in relation to a target, goal, or interval. Gauges are 
designed to achieve this goal in a way that is familiar to users. Many real-life objects 
use gauges, such as cars and machines. Gauges can be used to display a quantity, 
range, variable, or status. They often appear in business intelligence dashboards. 
Qualitative ranges are required for all gauges in the designer. You can populate the 
range intervals manually, or you can have them generated for you based on the range 
of the actual data. Gauges in the designer support high cardinality.

Overview of the Gauge Types

About Bullet Gauges

A bullet gauge is a horizontal dashboard indicator that compares an actual value to a 
target value and compares them in intervals. The actual value of the primary measure is 
indicated by an inset horizontal bar.

Note that the scale of a bullet gauge often begins at zero, but it can contain both 
positive and negative values if both types of values apply to the primary measure, such 

Using Gauges to Display Results 321



as profit. The inset horizontal bar should always begin at zero so that comparing 
multiple bullet graphs is not confusing.

The bullet gauge requires a primary measure and a range display rule, and the target 
measure is optional. The default orientation is horizontal with an option to display the 
gauge vertically.

Display 31.20 A Bullet Gauge

About Slider Gauges

A slider gauge is a horizontal dashboard indicator that compares an actual value to a 
target value and compares them in intervals. The actual value of the primary measure is 
indicated by a downward-facing arrow. The target value is indicated by a small upward-
facing arrow.

Like a bullet gauge, a slider gauge is oriented horizontally by default, but you can 
change the gauge’s orientation to vertical. You should use a slider gauge when the 
numeric scale does not start at zero.

The slider gauge supports dates (which are continuous) and numeric categories.

Display 31.21 A Slider Gauge
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About Thermometer Gauges

A thermometer gauge is a vertical dashboard indicator that compares an actual value to 
a target value and compares them in intervals. The actual value of the primary measure 
is indicated by a vertical bar. The target value is indicated by a small arrow that is facing 
the center of the thermometer.

The thermometer gauge requires a primary measure value and a range-based display 
rule. A target measure value is optional. The entire vertical bar is colored conditionally 
based on one color from the display rule.

The base of a thermometer bar should always start at zero. You can set this by defining 
your first range display rule to begin at zero. The designer always shows the base of the 
bar at the bottom of the thermometer.

Display 31.22 A Thermometer Gauge

About Dial Gauges

A dial gauge is an arc-shaped dashboard indicator that compares an actual value to a 
target value and compares them in intervals. The actual value of the primary measure is 
indicated by an arrow that points outward from the inner circle. The target value is 
indicated by an arrow that points inward from the outer arc. The color of the center circle 
is the color associated with the primary measure value’s range interval.

The dial gauge requires a primary measure value and a range-based display rule. For 
more information, see “Adding Display Rules to a Gauge” on page 408.

A target measure value is optional.
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Display 31.23 A Dial Gauge

About Speedometer Gauges

A speedometer gauge is a circular dashboard indicator that compares an actual value to 
a target value and compares them in intervals. The actual value of the primary measure 
is indicated by the larger pointer. The target value is indicated by a small triangle along 
the quantitative scale, either pointing inward or outward, depending on the KPI skin 
option for the gauge.

A speedometer gauge requires a primary measure value and a range-based display 
rule. A target measure value is optional.

Display 31.24 A Speedometer Gauge

Insert a Gauge into a Report

1 To insert a gauge into a report, choose one of the following:

n Drag the gauge icon from the Objects tab in the left pane and drop it onto the 
report canvas.
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n Select Insert  Gauges and then select the menu item for the gauge object that 
you want to insert. The gauge is automatically placed in the report canvas. If you 
want the gauge to appear in a different location, then drag and drop it in a new 
location.

The following table lists the available gauge objects:

Icon Gauge Type

Bullet

Slider

Thermometer

Dial

Speedometer

2 To insert the data items that you want to use in the gauge:

n Drag and drop data items onto the gauge.

n Use the Roles tab in the right pane, and then specify the Category and 
Frequency roles.

Specify Gauge Properties

To specify properties for gauges:

1 If it is not already selected, select the gauge in the report canvas that you want to 
update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the gauge. You can update the Name, Title, 
Format, and Description.
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4 Update the specific properties for the gauge. The available properties depend on the 
selected gauge type. For example, for a dial gauge, you can specify KPI Chart and 
Layout options.

Here is an example of the properties for a dial gauge:

Display 31.25 Properties for a Dial Gauge

Specify Gauge Styles

To specify styles for gauges:

1 If it is not already selected, select the gauge in the report canvas that you want to 
update.
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2 In the right pane, click the Styles tab.

3 Update the styles for the gauge. The available styles depend on the selected gauge 
type. For example, for a dial gauge, you can specify Data Styling, Frame Styling, 
and Text Styling.

Using Controls to Display Results

Overview of the Control Types

A control is a report object that filters or narrows the scope of the data that you are 
currently viewing. A control enables you to group your data by a selected category, and 
then select which group you want to view. Controls can be used in a report with 
interactions.

Section prompts are the controls that are placed in the special row area at the top of the 
report canvas. Only the drop-down list, button bar, and text input controls can be used 
in section prompts. A section prompt automatically filters all of the other report objects in 
the same section, as long as the report object uses the same data source as the section 
prompt control.

You can place any control in the main area of the report canvas below the section 
prompt row. You must define explicit interactions (using either the Interactions tab or 
the Interactions view) between these controls (as the source report objects) and one or 
more target report objects. For more information, see “Overview of Interactions” on 
page 433.

The following controls are available in the designer:

n drop-down lists
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Display 31.26 A Drop-Down List Control

n lists

Display 31.27 A List Control

n button bars

Display 31.28 A Button Bar Control

n text input fields

Display 31.29 A Text Input Control

n range sliders

Display 31.30 A Range Slider Control
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Insert Controls into a Report

To insert a control into a report:

1 Choose one of the following:

n Drag the control icon from the Objects tab in the left pane and drop it onto the 
report canvas.

n Select Insert  Controls and then select the menu item for the control object 
that you want to insert. The control is automatically placed in the report canvas. If 
you want the control to appear in a different location, then drag and drop it in a 
new location.

The following table lists the available controls:

Icon Control Type

Drop-down List

List

Button Bar

Text Input

Range Slider

2 To insert the data item that you want to use in the control:

n Drag and drop a category data item onto the control.

n Use the Roles tab in the right pane, and then specify the Category and 
Frequency roles.
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Use a Control to Create a Section Prompt

The drop-down list, button bar, and text input controls are the only ones that can be 
used as section prompts.

To use a control to create a section prompt:

1 Drag the control icon from the Objects tab in the left pane and drop it onto the area 
above the report canvas. (Look for the hint text that says, “Drop controls here to 
create a section prompt.”) The control appears above the report canvas.

2 Drop a category onto the control. For example, if you drag and drop a drop-down list 
control, then you can assign a category like Facility City or Facility Sate. Then the 
drop-down list is populated with the cities or states that are used in that category.

You can also use the Roles tab in the right pane, and then specify the Category 
and Frequency roles.

If you use a control to create a section prompt, then the user can select a value (or 
values, if multi-selection is available) to filter the data. Note that for some control types, 
the user might need to press Ctrl + click to clear the value in the filter.

Specify Control Properties

To specify the properties for a control:

1 If it is not already selected, select the control in the report canvas that you want to 
update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the control. You can update the Name, Title, 
Format, and Description.

4 Update the specific properties for the control. The available properties depend on 
the selected control.
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Here is an example of the properties for a drop-down list control:

Display 31.31 Properties for a Drop-down List Control

Specify Control Styles

To specify styles for controls:

1 If it is not already selected, select the control in the report canvas that you want to 
update.

2 In the right pane, click the Styles tab.

3 Update the styles for the control. The available styles depend on the selected control 
type. For example, for a drop-down list, you can specify Drop–down Styling and 
Text Styling.
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Using Other Object Types in Reports

Overview of the Other Object Types

About Text Objects

Text objects display static text. You can use text to include company standards, such as 
text that indicates confidentiality, in your reports. You can have hyperlinks in text. You 
can also use text to annotate other objects in a report. For more information, see “Insert 
Text into a Report” on page 334.

About Images

You can use images to include your corporate logo or other graphics in your reports. 
You can insert images from a repository or from your local machine. If you select an 
image from your local machine, it is saved to the repository. You can also add tooltip 
text to an image. For more information, see “Insert an Image into a Report” on page 
334.

About Stored Processes

A stored process is a SAS program that is stored on a server and that can be executed 
as requested by client applications such as SAS Visual Analytics. The embedded SAS 
code can contain instructions for displaying report elements that include queries, 
prompted filters, titles, images, and statistical analyses. For more information, see 
“Insert Stored Processes into a Report” on page 336.

About Vertical or Horizontal Container Objects

You can use a vertical or horizontal container to group other report objects. For more 
information, see “Insert Vertical or Horizontal Containers into a Report” on page 337.

About Geo Bubble Maps

A geo bubble map is a bubble plot that is overlaid on a geographic map. Each bubble is 
located at a geographic location or at the center of a geographical region. The bubbles 
are automatically colored based on the location. You provide a measure data item that 
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determines the size of the bubble. A geo bubble map requires a data item that contains 
geographical information and is assigned to a geography role.

Many types of data have a spatial aspect, including demographics, marketing surveys, 
and customer addresses. For example, if a user needs to evaluate population data for 
U.S. Census tracts, a report designer could display the information in a table. However, 
it would be easier and more effective for the person using the report to see the 
information in the context of the geography of the tracts. When evaluating information 
that has a spatial component, users might find it easier to recognize relationships and 
trends in the data if they see the information in a spatial context.

You can add a geo bubble map only if the report uses data items from a data source 
that is enabled for geographic mapping. A geo bubble map requires a geography 
variable with the role type of geography. For more information, see “Insert Geo Bubble 
Maps into a Report” on page 337.

You can create a filter or brush interaction between a geo bubble map and other report 
objects in your report or dashboard. When you click on a specific region or city, the 
other report objects filter or highlight to show the same location.

Note: Certain exported geo bubble maps (for example, geo maps that use custom roles 
or data sets that have centroids) cannot be fully modified in the designer.

About Geo Region Maps

A geo region map (also known as a choropleth map) is a two-dimensional map that 
uses color and fill pattern combinations to represent different categories or levels of 
magnitude. You can fill geographical boundaries (for example, a country or a state) on a 
map with color, based on measure values that are aggregated to the level defined by a 
geographical boundary.

You can add a geo region map only if the report uses data items from a data source that 
is enabled for geographic mapping. A geo region map requires a geography variable 
with the role type of geography. However, it does not support custom geography data 
items.

You can create a filter or brush interaction between a geo region map and other report 
objects in your report or dashboard. When you click on a specific country or state, the 
other report objects filter or highlight to show the same location.
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Note: Certain exported geo region maps (for example, geo maps that use custom roles 
or data sets that have centroids) cannot be fully modified in the designer.

Insert Text into a Report

To insert text into a report:

1 Choose one of the following:

n Drag  from the Objects tab in the left pane and drop it onto the report canvas.

n Select Insert  Other  Text. The text object is automatically placed in the 
report canvas. If you want the text to appear in a different location, then drag and 
drop it in a new location.

2 Double-click inside the text object in the canvas and enter the text. You can use the 
floating toolbar to change the font, font size, text color, and text background color. 
You can also specify whether the text is bold, italic, or underlined and whether it is 
left-aligned, centered, or right-aligned.

You can use the context menu to cut, copy, and delete text. However, you have to 
use the keyboard (Ctrl +V) to paste text.

For information about creating a link from text, see “Creating Links” on page 449.

Insert an Image into a Report

To insert an image into a report:

1 Choose one of the following:

n Drag the  from the Objects tab in the left pane and drop it onto the report 
canvas. The Image Selection window is displayed.

n Select Insert  Other  Image. The Image Selection window is displayed. The 
image object is automatically placed in the report canvas. If you want the image 
to appear in a different location, then drag and drop it in a new location.
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Display 31.32 Image Selection Window

2 Select the image from one of the following locations:

Load from repository
Select this option to choose an image that is stored on the same server as the 
reports.

Load from local machine
Select this option to choose an image from your local machine. Click Browse to 
choose a file on your local machine. Specify a repository in the Save the local 
image to the repository field. If you click Browse, the Save As window is 
displayed. Select a folder and then click OK to return to the Image Selection 
window.

A preview of the image is displayed.

3 (Optional) Specify the Scale type:

None
The actual size of the image is maintained. The image might or might not fill the 
entire area of the image's visual container. If the image is larger than the visual 
container, then scroll bars are displayed.

Stretch
The height and width of image are set to the height and width of the image’s 
visual container. The image’s original aspect ratio is not maintained.
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Fit All
The image is modified to fit best into the image's visual container. The image’s 
original aspect ratio is maintained.

Fit Width
The width of the image is set to the width of the image's visual container. The 
height maintains the image's original aspect ratio. Scroll bars are displayed if the 
set height of the image is greater than the height of the visual container.

Fit Height
The height of the image is set to the height of the image's visual container. The 
width maintains the image's original aspect ratio. Scroll bars are displayed if the 
set width of the image is greater than the width of the visual container.

Tile
The image is tiled in the visual container. The image’s original size is maintained. 
There are no scroll bars.

4 (Optional) Specify the Tooltip text.

5 Click OK.

Insert Stored Processes into a Report

To insert a stored process into a report:

1 Choose one of the following:

n Drag  from the Objects tab in the left pane and drop it onto the report canvas. 
The Open window is displayed.

n Select Insert  Other  Stored Process. The Open window is displayed.

2 In the Open window, select a stored process. Click Open. The stored process is 
automatically placed in the report canvas.

Note: No styles are available for stored processes.
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Insert Vertical or Horizontal Containers into a 
Report

To insert a vertical or horizontal container into a report:

1 Choose one of the following:

n Drag  or  from the Objects tab in the left pane and drop it onto the report 
canvas.

n Select either Insert  Other  Vertical Container or Insert  Other  
Horizontal Container. The vertical or horizontal container is automatically 
placed in the report canvas. If you want the container to appear in a different 
location, then drag and drop it in a new location.

2 Drag and drop other report objects onto the vertical container or horizontal container.

Insert Geo Bubble Maps into a Report

To insert a geo bubble map into a report, choose one of the following:

n Drag  from the Objects tab in the left pane and drop it onto the report canvas.

n Select Insert  Other  Geo Bubble Map. The geo bubble map object is 
automatically placed in the report canvas. If you want the geo bubble map to appear 
in a different location, then drag and drop it in a new location.

Insert Geo Region Maps into a Report

To insert a geo region map into a report:

n Drag  from the Objects tab in the left pane and drop it onto the report canvas.

n Select Insert  Other  Geo Region Map. The geo region map is automatically 
placed in the report canvas. If you want the geo region map to appear in a different 
location, then drag and drop it in a new location.

Using Other Object Types in Reports 337



Specify Text Object Properties

To specify the properties for a text object:

1 If it is not already selected, select the text object in the report canvas that you want 
to update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the text. You can update the Name, Title, Format, 
and Description.

Here is an example of the properties for a text object:

Display 31.33 Properties for a Text Object

Specify Image Properties

To specify the properties for an image:

1 If it is not already selected, select the image in the report canvas that you want to 
update.

2 In the right pane, click the Properties tab.
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3 Update the general properties for the image. You can update the Name, Title, and 
Description.

4 Update the properties specific for the image. Your choices are Location, Scale 
type, and Tooltip text.

Here is an example of the properties for an image:

Display 31.34 Properties for an Image Object

Specify Stored Process Properties

To specify the properties for a stored process:

1 If it is not already selected, select the stored process in the report canvas that you 
want to update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the stored process. You can update the Name, 
Title, Format, and Description.
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Here is an example of the properties for a stored process:

Display 31.35 Properties for a Stored Process

4 Update the properties specific to the stored process. Your choices are Show 
metadata view and Show log in output.

Selecting the Show metadata view check box can make it easier to work with the 
stored process in a report.

Here is an example of the metadata view for a stored process:

Display 31.36 Metadata View for a Stored Process
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Selecting the Show log in output option means that both log output and the stored 
process output are displayed in the report. This can assist you in debugging any 
problems that might arise.

Specify Vertical or Horizontal Container 
Properties

To specify the properties for a vertical or horizontal container:

1 If it is not already selected, select the vertical or horizontal container in the report 
canvas that you want to update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the vertical or horizontal container. You can 
update the Name, Title, Format, and Description.

Here is an example of the properties for a vertical container:

Display 31.37 Properties for a Vertical Container
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4 (Optional) Update the order in which the report objects appear inside the container.

Specify Geo Bubble Map or Geo Region Map 
Properties

To specify the properties for a geo bubble map or geo region map:

1 If it is not already selected, select the geo bubble map or geo region map in the 
report canvas that you want to update.

2 In the right pane, click the Properties tab.

3 Update the general properties for the geo bubble map or geo region map. You can 
update the Name, Title, Format, and Description.

4 Update the properties that are specific to the geo bubble map or geo region map. 
You can update the Show map navigation control, Transparency, and Show 
legend.

Note: For a geo bubble map, you select the Transparency for the bubble plot. For 
a geo region map, you select the Transparency for the region map.
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Here is an example of the properties for a geo bubble map:

Display 31.38 Properties for a Geo Bubble Map

Specify Styles for Geo Bubble Maps and Geo 
Region Maps

To specify styles for a geo bubble map or a geo region map:

1 If it is not already selected, select the geo bubble map or geo region map in the 
report canvas that you want to update.

2 In the right pane, click the Styles tab.

3 Update the styles for the geo bubble map or geo region map. The available styles 
depend on the selected geo map type.
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Duplicating a Report Object

Duplicating a report object in the designer enables you to use a copy of the same object 
in the same section or another section of your report.

To duplicate a report object:

1 On the report canvas, right-click the report object that you want to duplicate.

2 Select Duplicate <ReportObject>, where <ReportObject> is the name of the report 
object in the report. (For example, List Table 1, Bar Chart 1, and so on.) The 
duplicated report object is placed on the canvas with a name based on the original 
name. For example, if the original report object name is List Table 1, then the 
duplicate report object is displayed as List Table 1 (1). If you choose to 
duplicate the same report object again, then it is displayed as List Table 1 (2).

3 (Optional) Move the duplicate report object to another section. Right-click the report 
object that you want to move. Select Move <ReportObject> to Move 
<ReportObject> to  <SectionName>, where <ReportObject> is the name of 
the report object and <SectionName> is the name of the section.

4 (Optional) If you want the report object to appear in a different location, then drag 
and drop it in a new location.

If you move an object to a section with precision layout, then you must manually 
move the object to its proper location. All objects are put in the top left corner by 
default.

344 Chapter 31 / Displaying Results Using Report Objects



Adding Comments to Reports

If you have the Add or View Comments capability, then you can add or view comments. 
You can edit your own comments and respond to other comments. You must save a 
report before you can add comments.

In the designer, you can add comments to the whole report, but you cannot add 
comments to the individual report objects.

Note: If comments have been added to an individual report object using the home 
page, the explorer, or the viewer, then those comments cannot be displayed or edited in 
the designer.

To add a comment to a report:

1 Click the Comments tab in the right pane.

Here is an example:

Display 31.39 Comments Tab

2 Enter a topic name and a comment.
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Here is an example:

Display 31.40 Adding a Comment in the Designer

3 (Optional) Click  to attach a file or an image to your comment. There is no 
restriction on the file type or the size of the attachment.

4 Click Post to add your comment. Your comment is added to the Comments tab in 
the right pane.

To respond to an existing comment:

1 Click the Comments tab in the right pane.

2 Select an existing comment. Then, enter a reply.

3 (Optional) Click  to attach a file or image to your reply.

4 Click Post to add your comment.

Note: To edit another user’s comments or to delete comments, you must belong to the 
predefined role Comments:Administrator.
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To search for a comment:

1 Enter the word or phrase that you want to search for in the search box. Press Enter.

2 (Optional) To clear your search, click . Then, you can enter another word or 
phrase in the search box.
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Overview of Data Sources and Data 
Items

Data sources that are available in SAS Visual Analytics Designer (the designer) are 
prepared by a data administrator or analyst so that you can easily define a report. Data 
administrators load tables into memory using SAS Visual Analytics Administrator. 
Analysts can use SAS Visual Data Builder to design queries that load tables into 
memory too. All data sources contain data items, which can refer to calculations or 
columns in physical data (tables). Reports can include query results from more than one 
data source.

Each data source includes one or more data items that you can use in reports. For 
example, a data source named Order Information might include standard data items 
such as Order ID, Product ID, Unit Cost, Order Date, and Order Amount. You decide 
which data items to use. You can select all of the data items in the data source or a 
subset of the data items.

The designer can display data items using an existing user-defined format that has 
already been specified externally for a data column in a data source. However, you 
cannot specify a new or different user-defined format for a data item in the designer.
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Adding a Data Source or Data Sources

You can use one or more data sources for a report in the designer.

To add a data source for a report:

1 On the Data tab, click  beside the Select a data source text to display the Add 
Data Source window.

Display 32.1 Data Tab

2 In the Add Data Source window, select a data source.
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Display 32.2 Add Data Source Window

TIP Use the Search field to narrow the list of data sources that are displayed in 
the Add Data Source window.

3 Click Add. The list of available data items is displayed in the Data tab.

4 To add another data source, click , which displays the Add Data Source window. 
Select the data source that you want, and then click Add. The Data tab is populated 
with a list of all of the data items that are in the data source.

Refreshing a Data Source for a Report

You can refresh the columns in a data source in the designer at any time. Be aware that 
refreshing a data source means that all live report objects that are connected to that 
data source will have their queries re-run.

Note: Refreshing a data source adds any new columns that have been added to the 
table metadata. The default formats and names of existing columns will be updated the 
next time you open the report.
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To refresh a data source for a report, on the Data tab, select the data source, and then 
click . When you refresh a data source for a report, columns that have been deleted 
from the table metadata will automatically be removed if they do not impact any objects 
in the report. If deleted columns do impact objects in the report, then the Repair Report 
window is displayed so that you can repair the objects that are impacted by the deleted 
columns.For more information, see Appendix 4, “Troubleshooting in SAS Visual 
Analytics Designer,” on page 509.

Removing a Data Source from a Report

You can remove a data source from a report in the designer. Be aware that removing a 
data source means that all related data items are also removed from the report objects 
within the report.

To remove a data source for a report:

1 On the Data tab, select the data source and then click .

2 Click Yes in the confirmation message that is displayed.

Changing a Data Source in a Report

To change a data source for a report:

1 On the Data tab, click  and then select Change Data Source. The Change Data 
Source window is displayed.

2 In the Change Data Source window, select a data source.
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Display 32.3 Change Data Source Window

3 Click Change.

If a data item with the same name does not exist in the replacement data source, 
then it is automatically removed from the replacement data source if there are no 
report objects that use the data item. If there are report objects that use the data 
item, then those report objects will not work. The Repair Report window is displayed 
so that you can repair the objects that use the data item. For more information about 
repairing reports, see Appendix 4, “Troubleshooting in SAS Visual Analytics 
Designer,” on page 509.

Data items in the replacement data source that have names that do not exist in the 
original data source are added to the Data tab automatically.

Note: For data item names, the case is ignored when data sources are compared 
by the designer.
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Working with Data Items in a Report

About Data Items

Each data source in the designer includes one or more standard data items. You decide 
which data items to use to define a query for each report object. You can use all the 
data items in the data source or a subset of data items. Each data item is classified as 
either a category or a measure.

For information about filtering data items, see “Working with Data Item Filters in a 
Report” on page 421.

Table 32.1 Data Items That Are Available in the Designer

Data Item Icon Description

Aggregate 
Measure

A data item that represents special predefined operations, like 
distinct count, percentage of totals, percentage of subtotals, or 
frequency percent. Or the user can define their own aggregated 
measure calculations.
Aggregate measures can be used in only some report objects. They 
cannot be used in filters, controls, spark lines, or time series graphs. 
Percentage of subtotal items (including row total, row subtotal, 
column total, and column subtotal) can be used in only in crosstabs. 
Some aggregate measure calculations cannot be used in a detail 
rank.
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Data Item Icon Description

Calculated , , 
or 

A data item that is calculated from existing data items by using an 
expression. For example, you could create a calculated data item 
called Profit, which is created by using this expression: [Revenue] 
— [Cost], where Revenue and Cost are measures in a data 
source.
Calculated dates and times are treated as categories with distinct 
values being governed by the date or time format that you have 
chosen. Numeric calculated items can be treated as measures (with 
an aggregation type such as Sum, which is applied to each distinct 
category combination). Or, you can change numeric calculated 
items into category data items with distinct values being governed 
by the number of decimal places in the numeric format.

Category A data item whose distinct values are used to group and aggregate 
measures. There are five types of categories: alphanumeric, date, 
datetime, time, and numeric. Alphanumeric categories can be made 
up of all letters, all digits, or a combination of the two. Categories 
that have values that are all digits might be physically stored as 
character or numeric data. The data type affects how values are 
handled in relation to some functionality, such as filtering, sorting, 
and formatting.
Examples of alphanumeric categories include data items such as 
Product ID, Country, Employee Number, and Employee Name. 
Alphanumeric categories sort lexically.
Date, datetime, time, and numeric categories are sorted by their 
underlying numeric values.
Category data items can also be numeric. A category data item 
sorts differently than an alphanumeric data item. Numeric category 
data items sort by number.
Note: If you change a measure to a category, then it uses this 
category icon.

The  icon indicates a filtered category data item.

The  icon indicates a user-defined format category data item. 
User-defined format categories can be based on underlying numeric 
or character data.
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Data Item Icon Description

Date and 
Time

A category data item whose distinct values are used to group and 
aggregate measures. There are three types of date categories: 
date, datetime, and time.
Examples of date, datetime, and time categories are Order Year, 
Date of Sale, and Delivery Time.

Geography A category data item whose values are mapped to geographical 
locations or regions. Geography data items can be used in reports 
to show your data on a geographic map. For example, a geography 
data item can identify geographic information that is specific to your 
organization (for example, sales regions, warehouse locations, oil 
platforms, and so on).

The  icon indicates a filtered geography data item.

Hierarchy A data item whose values are arranged with more general 
information at the top and more specific information at the bottom. 
The first level in the hierarchy is the root level. For example, you 
might have a Time hierarchy, which includes the Year (the root 
level), the Quarter, and then the Month. You can also have 
geographic hierarchies.

Measure A data item whose values can be used in computations. These 
values are numeric. Examples of measures include Sales Revenue, 
Units Sold, and Salary.
The designer assigns a default aggregation method to every 
measure. Almost all measures are assigned sum. You can change 
the aggregation method.

The icon indicates a filtered measure data item.

Note: Report objects that are imported from SAS Visual Analytics Explorer (the 
explorer) use either live or on-demand data. Therefore, you can update the properties 
and styles for these report objects in the designer, but you cannot change the data 
assigned to them.
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Select Data Items

To select data items to use in queries for the current report section:

1 On the Data tab in the left pane, click the down arrow to display a list of available 
data sources. Select a data source and the Data tab is populated with a list of all of 
the data items that are in the data source.

If the data source that you want is not in the list, click , which displays the Add 
Data Source window. Select the data source that you want, and then click Add. The 
Data tab is populated with a list of all of the data items that are in the data source.

If you do not want to use the data source that you originally selected, click Remove 
data source. Click Yes in the confirmation message that is displayed.

Note: For list tables only, you can press the Ctrl key to select multiple data items, 
and then drag and drop them onto the table in the report canvas.

2 Select an existing report object that uses the same data source name or add a new 
report object to the section.

3 Drag and drop a report object onto the report canvas. Alternatively, you can right-
click on a data item and select Add Data Item to <ReportObject>, where 
<ReportObject> is the name of the report object in the report. (For example, List 
Table 1, Bar Chart 1, and so on.)

Note: For list tables only, you can press the Ctrl key to select multiple data items, 
and then drag and drop them onto the report canvas.

4 If the selected data item can replace a current data item in the report object or if the 
selected data item is valid for multiple data roles, then select the data assignment 
from the Assign <DataItemName> as window. A data assignment that is marked 
with a red asterisk (*) is required before the query can be run.
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Here is an example of the Assign <DataItemName> as window when a data item 
called Product Line is being dropped onto a bar chart.

Display 32.4 Assign as Window

5 (Optional) To see more information about a data item, select it in the list. The Name, 
Role, Format, and Aggregation are displayed in the data item table below the list of 
data items. For a category data item with a user-defined format that has an 
underlying numeric value, you can specify Sort Options.
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Here is an example of the details for a data item called Engine Size:

Display 32.5 Details about a Selected Measure Data Item

Rename Data Items

You can rename data items in the data source using the Data tab.

To rename data items:

1 On the Data tab, right-click on a data item, and then select Rename Data Item. The 
Rename Data Item window is displayed.

360 Chapter 32 / Selecting Data for Reports



Display 32.6 Rename Data Item Window

2 Enter a new name. The name cannot be used by another data item in the same data 
source.

3 Click OK.

Alternatively, you can use the data item table at the bottom of the Data tab to rename a 
data item. For the Name property, enter a new name for Value.

Search for Data Items

If your data source contains many data items, you can search for particular data items 
using the Data tab.

To search for data items:

1 Enter the name of a data item in the search field on the Data tab. The field is located 
above the list of data items.

Display 32.7 Search Field in the Designer

2 (Optional) Click  to collapse the list of data item groupings or click  to expand 
the list of data item groupings.

3 Click  to clear the search term and display all of the data items in the data source.
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Sort Data Items on the Data Tab

To sort data items on the Data tab, click , and then select Sort Items  Ascending 
By Name or Sort Items  Descending By Name. The data items are sorted on the 
Data tab within each grouping. The default sort is Ascending By Name.

For information about sorting data values in report objects, see Chapter 33, “Sorting 
Data Items in Reports,” on page 391.

Group Data Items on the Data Tab

To group data items on the Data tab, click , and then select one of the following:

n Group Items  By First Letter

n Group Items  By Data Type

n Group Items  By Role

n Group Items  By Format

n Group Items  By Aggregation

The data items are grouped on the Data tab. The default is grouping By Role.

Duplicate Data Items

Duplicating measure data items in the designer enables you to see the aggregations of 
a data item (Sum, Average, Minimum, Maximum, and Count) side by side in a table. 
You can duplicate a numeric measure if you want to use it as a category to group other 
values in some tables or graphs. If you save a report with duplicate data items, then 
those data items are available when you edit the report the next time.

You can duplicate a calculated data item to make a variation of a calculation. For 
example, you might make similar calculations involving miles per gallon for a vehicle, 
but you create one calculation using MPG (City) and another using MPG (Highway). 
You can duplicate any data item if you want to use it with more than one format in your 
report. For example, you might change Month to Year for a date data item.
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To duplicate a data item:

1 On the Data tab in the left pane, right-click the data item that you want to duplicate.

Display 32.8 Duplicate Data Item Menu Selection

2 Select Duplicate Data Item. All of the properties of the original data item are copied 
to the duplicate data item. The duplicate data item appears in the list of data items 
on the Data tab. For example, if the original data item name is Engine Size, then 
the duplicate data item is displayed as Engine Size (1). If you choose to 
duplicate the same data item again, then it is displayed as Engine Size (2).

3 (Optional) Change the name, format, or aggregation for the duplicate item (or items).

4 (Optional) Edit the calculation for a calculated data item or aggregate measure.

5 (Optional) Change the sort options for a category data item with a user-defined 
format that is based on an underlying numeric value.

6 (Optional) Change the role for the data item. For example, a numeric data item that 
has been duplicated and is not yet assigned to a report object can be a category or a 
measure.
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7 (Optional) Rename the duplicate data item (or data items).

Derive a Distinct Count for a Category Data 
Item

A distinct count query is useful in many ways. For example, you might want to know the 
number of distinct products that were purchased during a specific time period. Or, you 
might want to know which products have the most customers or which products have 
the most customers in a particular geographic region. You can derive a distinct count for 
category data items only.

To derive a distinct count data item:

1 On the Data tab in the left pane, right-click the category data item that you want to 
use for the distinct count.

2 Select Derive Distinct Count. 

Display 32.9 Derive Distinct Count Menu Selection

364 Chapter 32 / Selecting Data for Reports



The distinct count data item appears in the list of data items with a name that is 
derived from the original name. For example, if the original data item name is Date, 
then the distinct count category data item is displayed as Date (Distinct 
Count). The  icon identifies the new distinct count category data item on the Data 
tab.

Derive a Percentage of Total for a Measure

You can derive the percentage of total for a measure as a new aggregated measure in 
the designer. The aggregated measure does not contain data values in itself, but when 
it is used in a report object, it displays the percentage of the total value for the measure 
on which it is based.

Note: The percentage of total is relative to the subset of data that is selected by your 
filters and ranks.

For example, you might derive the percentage of total for a measure that contains 
revenue values. If you create a bar chart of the aggregated measure and a category 
that contains product lines, then the bar chart shows the percentage of total revenue for 
each product line.

To derive a percentage of total from a measure data item:

1 On the Data tab in the left pane, right-click on the measure data item that you want 
to use for the percentage of total.

2 Select Derive Percent of Total.
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Display 32.10 Derive Percent of Total Menu Selection

The percentage of total measure data item appears in the list of aggregated data 
items with a name that is derived from the original name. For example, if the original 
measure data item name is Revenue, then the percentage of total measure data 
item is displayed as Revenue (Percent of Total). The  icon identifies the 
new percentage of total measure data item on the Data tab.

Create Geography Data Items

A geography data item can be useful if your data contains values that are mapped to 
geographical locations or regions. For example, a geography data item can identify 
geographic information that is specific to your organization (for example, sales regions, 
warehouse locations, oil platforms, and so on).

If you change a numeric measure to a geography data item, then it automatically 
becomes a category data item.
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Starting with the 6.2 release, you do not have to use a custom geography data item. 
You can use the geography items that are available in SAS Visual Analytics. These 
geography data items are Countries, US States, US States Abbreviated, US ZIP 
Codes, and Custom. To access these geography data items, select the Data tab in the 
left pane. Right-click the data item that you want to use for the geography data item, 
and then select Geography.

Note:  Calculated data items cannot be turned into geography data items.

To create a custom geography data item:

1 On the Data tab in the left pane, right-click the data item that you want to use for the 
geography data item. Select Geography, and then select Custom. The Geography 
window is displayed.

Display 32.11 Geography Window

2 Select a measure for the Latitude. You can also enter the first letter of the name of 
the latitude column to quickly search for it in the drop-down menu.

3 Select a measure for the Longitude. You can also enter the first letter of the name 
of the longitude column to quickly search for it in the drop-down menu.

4 Select a Coordinate space. The choices are World Geodetic System (WGS84), 
Web Mercator, and British National Grid (OSGB36). The default is World 
Geodetic System (WGS84).

5 Click OK. The  icon identifies the new geography data item on the Data tab.
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Modify Data Item Properties

Rename a Data Item

To rename a data item:

1 Select a data item on the Data tab.

2 In the data item table, select the existing name for the data item, and then enter a 
new name. The name cannot be used by another data item in the same data source. 
Your change is saved automatically.

Modify a Data Item’s Role

You can modify a data item’s role. For example, you might want to modify a measure 
data item to be a category data item. A data item's role cannot be changed if that data 
item is in use in the report. However, duplicating the data item allows the new data item 
to have a different role.

Note: You cannot change the role for the frequency data item or the frequency percent 
data item. You cannot change the role for an aggregate measure.

TIP For geography data items, use the context menu instead of the drop-down menu 
to change the role.

To modify a data item’s role:

1 Select a data item on the Data tab.

2 In the data item table, select the existing role name for the data item.

3 Click  to open the drop-down menu. Select Measure or Category. Your change is 
saved automatically.

Note: Category data items cannot be converted into measure data items.

Note: Calculated data items cannot be converted into geography data items.
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Modify the Format of a Numeric Measure Data Item or a Date, 
Datetime, or Time Data Item

You can modify the format of a numeric measure data item or a date, datetime, or time 
data item. You can also modify the format of a data item with a user-defined format, as 
long as the user-defined format is based on an underlying numeric value.

Note: You cannot modify the format of a data item that is being used in a filter or as 
part of a calculated or aggregated measure.

To change the format:

1 Select a data item on the Data tab.

2 In the data item table, select the existing format. A list is displayed with the Format 
type, Width, and Decimals (for numeric data items). Make your selections. A 
sample of your selection is displayed under the list.

Note: There are different format variations available for some format types for date, 
datetime, and time data items. Select the format variation based on the sample 
value displayed in the Format drop-down list.

Here is an example of the list for a numeric data item:

Display 32.12 Available Formats for a Numeric Data Item
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Here is an example of the list for a date data item:

Display 32.13 Available Formats for a Date Data Item

Note: The Reset to Default option is displayed only if the format has been changed 
from the default.

Note: The Reset to Default option is available for user-defined format data items 
after they have been modified to a standard numeric format, as long as the data item 
is still a category data item.

3 Click OK to save your changes.

Modify User-Defined Formats

In the designer, user-defined formats that are defined in the SAS LASR Analytic Server 
are applied to the results, even though the Format property of the data item does not 
display the name of the applied user-defined format. You can change the format for an 
underlying numeric data item, but you cannot change the format for an underlying 
character-based data item. If you change the numeric format, you can restore the user-
defined format by selecting Reset to Default.

The Format property of the data item does not display the name of a character-to-
character user-defined format, but it does display the base name for a numeric-to-
character user-defined format.

The  icon identifies a category data item with an active user-defined format on the 
Data tab.

Modify How a Measure Is Aggregated

You can change the aggregation method for a measure in a data source using the Data 
tab or a report object in the canvas.
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Note: You need to understand your data because some aggregation methods are not 
always appropriate. For example, an average of an average is not valid.

To change the aggregation method using the Data tab:

1 Select a measure data item on the Data tab.

2 In the data item table, select the existing aggregation. A drop-down list is displayed 
with aggregations. Sum, Average, Minimum, Maximum, and Count are the 
available aggregations. Select one, and your change is saved automatically.

Note: All report objects in the report that uses this data item are affected by this 
change unless you have selected a local aggregation override.

Display 32.14 Available Aggregations for a Data Item
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To change the aggregation method when you are working with a report object in the 
canvas:

1 Choose one of the following:

n For a list table, right-click on a measure header in the report object.

Display 32.15 Aggregation Menu Items for a List Table

n For a crosstab, right-click on the header row with the measure.

n For a graph, right-click on the measure name hotspot. Or, you can right-click on a 
measure data item name on the Roles tab.
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Display 32.16 Aggregation Menu Items for a Graph

2 Select Aggregation  aggregation name, where aggregation name is Sum, 
Average, Minimum, Maximum, or Count.

Your change is saved automatically.

Note: This is a local override for only this report object. It does not affect the default 
aggregation for this data item in other report objects.

Modify the Sort Options for a Category Data Item

Using the data item table on the Data tab, you can change the Sort Options for a 
category data item with a user-defined format that is based on an underlying numeric 
value. The sort options are the following:

Formatted
Uses the formatted character output of the user-defined format and sorts lexically. 
(For example, the names of the months in the year would sort as April, August, 
December, February, and so on.) Formatted is the default.

Unformatted
Use the underlying numeric value and sorts numerically. (For example, if the 
underlying numeric value for January is 1, for February is 2, for March is 3, and for 
April is 4, then the months of the year would sort as January, February, March, April, 
and so on.)
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Delete Data Items

You can delete data items that you have created in the designer (for example, 
calculated data items or duplicated data items) so that they no longer appear on the 
Data tab in the left pane.

You cannot delete a data item that is inside a hierarchy if it reduces the hierarchy to a 
single level. You cannot delete a data item if it is the last or only reference to a column 
in the original data source. You cannot delete a data item if it is used in a calculated 
data item, aggregate measure, or a geography data item.

TIP You can hide a data item that you cannot delete by right-clicking on the data item 
name in the Data tab, and then selecting Hide Data Item. For more information, see 
“Showing or Hiding Data Items” on page 385.

To delete a data item (or data items):

1 On the Data tab in the left pane, right-click the data item that you want to delete.
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Display 32.17 Delete Data Item Menu Selection

2 Select Delete Data Item.

3 Click Yes in the confirmation message that is displayed. The data item is removed 
from the list of data items, as well as from any report objects, filters, or ranks that 
were using it.
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Working with Hierarchies in a Report

About Hierarchies

Creating hierarchies enables you to add drill-down functionality to your reports. A 
hierarchy is an arrangement of category columns that is based on parent-child 
relationships. The levels of a hierarchy are arranged with more general information at 
the top and more specific information at the bottom. For example, you might create a 
hierarchy of date-time columns with Year as the top level, Month as the next level, and 
Day as the bottom level.

You can also have a geographic hierarchy. For example, you might have a hierarchy 
with Region as the top level, State as the next level, and City as the bottom level.

You can have a maximum of two hierarchies for a report object.

Note: List tables do not support hierarchies.

Note: Crosstabs can have either a hierarchy or categories on each row or column, but 
not both.

In the designer, you can:

n “Create New Hierarchies for a Report” on page 376

n “Edit Hierarchies for a Report” on page 377

n “Delete a Hierarchies for a Report” on page 378

Create New Hierarchies for a Report

To create a new hierarchy for a report:

1 On the Data tab, click  and then select New Hierarchy. The New Hierarchy 
window is displayed.

2 Enter a Name.
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3 Select at least two categories and drag them to the Hierarchy list.

Display 32.18 New Hierarchy Window

4 (Optional) Use the up and down arrows to arrange the data items in the Hierarchy 
list.

5 Click OK to save the new hierarchy. The  icon identifies the new hierarchy in the 
list of data items on the Data tab. 

Crosstab report objects enable you to create hierarchies from the categories on a 
crosstab axis. To create a hierarchy, right-click a category heading and then select 
Create Hierarchy. The categories are replaced with a new hierarchy. The name of the 
new hierarchy is generated from the name of the outermost category, with the suffix 
Hierarchy.

Edit Hierarchies for a Report

To edit a hierarchy:

1 Right-click the hierarchy name on the Data tab and select Edit Hierarchy. The Edit 
Hierarchy window is displayed.
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Display 32.19 Edit Hierarchy Window

2 (Optional) Edit the Name.

3 Add and remove categories. There must be at least two categories.

4 Click OK to save the updated hierarchy.

Delete a Hierarchies for a Report

To delete hierarchies:

1 Right-click the hierarchy name on the Data tab and select Delete Hierarchy.

2 Click Yes in the confirmation message that is displayed.
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Working with Calculated Data Items in 
Reports

About Calculated Data Items

The designer enables you to calculate new data items from your existing data items by 
using an expression. For example, you might want to calculate a company’s profits by 
subtracting expenses from revenues.

In addition to performing mathematical calculations on numeric values, you can use 
calculated data items to create date and time values. For example, if your data contains 
separate categories for month, day, and year, then you can calculate a date value from 
those categories.

Note: All calculations are performed on unaggregated data. The calculation expression 
is evaluated for each row in the data source before aggregations are performed. To 
perform calculations on aggregated data, see “Add a New Aggregated Measure to a 
Report” on page 382.

A hierarchy can contain calculated data items.

Using the designer, you can work with calculated data items or aggregated measures.

Add a New Calculated Data Item to a Report

To add a new calculated item:

1 On the Data tab, click , and then select New Calculated Item. The New 
Calculated Item window is displayed.
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Display 32.20 New Calculated Item Window

2 Enter a Name.

3 Select a Result type from the drop-down list. Numeric is the default data type.

The following table lists the available result types:

Icon Result Type

Date

Datetime

Numeric

Time

Calculated data items in the designer always default to the following formats, which 
are based on the data type:

n Date: DATE9

n Datetime: DATETIME10
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n Time: TIME8

n Numeric: COMMA12.2

After you create the new calculated data item, you can change its format using the 
data item table on the Data tab.

SUM is the default aggregation for new numeric calculated items in the designer. 
You can change the aggregation for numeric calculated items using the data item 
table on the Data tab.

4 (Optional) Click  to Show all drop zones. You can also choose to Show scratch 
area to build temporary expressions.

5 Build the expression for your calculated data item by dragging Data items and 
Operators onto the expression in the right pane. For each rectangular field in the 
expression, you can insert a data item, an operator, or a specific value.

When you drag items or operators onto your expression, the precise location of the 
cursor determines where and how the new element is added to the expression. As 
you drag the new element over the expression, a preview appears that displays how 
the expression changes if you drop the element at that location.

For example, if your current expression is ( Profit / Revenue ), and you drag 
and drop the x - y (subtract) operator inside the open parenthesis symbol, then the 
expression changes to ( [number] — ( Profit / Revenue )). If you drag 
and drop the operator over the division symbol, then the expression changes to 
( Profit — Revenue ), and so on.

There are a large number of operator types available to perform mathematical 
functions, process datetime values, and evaluate logical processing such as “if” 
clauses. For more information, see Appendix 1, “Operators for Calculated Data 
Items,” on page 489.

6 Click OK. The new calculated data item appears in the Data tab. The , , or 
icons identify the new calculated data item on the Data tab.

Note: The  icon is displayed only if you change a calculated numeric measure to 
a category data item.
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Add a New Aggregated Measure to a Report

Aggregated measures enable you to calculate new data items by using aggregated 
values. For example, you might want to calculate a company's profit margin by region 
by taking the aggregated sum of the profit for all of the stores in a region group and 
dividing it by the aggregated sum of the revenue for all of the stores in that same region 
group. Aggregations are evaluated as part of a calculated expression.

To add an aggregated measure:

1 On the Data tab, click , and then select New Aggregated Measure. The New 
Aggregated Measure window is displayed.

Display 32.21 New Aggregated Measure Window

2 Enter a Name.

3 (Optional) Click  to Show all drop zones. You can also choose to Show scratch 
area to build temporary expressions.
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4 Build the expression for your aggregated measure by dragging and dropping Data 
Items and Operators onto the expression in the right pane. For each field in the 
expression, you can insert a data item, an operator, or a specific value.

When you drag and drop data items and operators onto the expression, the precise 
location of the cursor determines where and how the data item or operator is added 
to the expression. As you drag the new element over the expression, a preview 
appears, which displays how the expression would change if you drop the element 
at the current location.

There are a large number of operator types available to perform mathematical 
functions and evaluate logical processing such as IF clauses.See Appendix 1, 
“Operators for Calculated Data Items,” on page 489.

5 For each data item in your expression, select an aggregation type. By default, Sum 
is used for measures and Distinct is used for categories. To select a new 
aggregation type, drag and drop an aggregated operator from the Operators list 
onto the aggregation type in the expression.See Appendix 1, “Operators for 
Calculated Data Items,” on page 489 for a list of the aggregated operators that are 
available.

6 For each aggregation in your expression, select the aggregation context. A drop-
down list beside each aggregation enables you to select one of the following context 
values:

ByGroup
calculates the aggregation for each subset of the data item that is used in a 
visualization. For example, in a bar chart, an aggregated measure with the 
ByGroup context calculates a separate aggregated value for each bar in the 
chart.

ForAll
calculates the aggregation for the entire data item (after filtering). For example, in 
a bar chart, an aggregated measure with the ForAll context uses the same 
aggregated value (calculated for the entire data item) for each bar in the chart.

By using the ForAll and ByGroup contexts together, you can create measures that 
compare the local value to the global value. For example, you might calculate the 
difference from mean by using an expression such as the following:
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Avg ByGroup(X) - Avg ForAll(X)

7 Click OK. The new aggregated measure appears on the Data tab. The  icon 
identifies the new aggregated measure.

Edit a Calculated Data Item

To edit a calculated data item:

1 Right-click on a calculated data item on the Data tab and select Edit Calculated 
Item. The Edit Calculated Item window is displayed.

Display 32.22 Edit Calculated Item Window

2 Modify the Data Items and Operators for the calculated data item as needed. For 
information about the operators and conditions that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

3 Click OK.
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You can duplicate, rename, hide, and delete calculated data items using the same steps 
as any other data item. If a calculated data item is used inside another calculated data 
item, then it cannot be removed.

Viewing Measure Details

To view the details about all of the measures in a data source:

1 On the Data tab, click  and then select Measure Details. The Measure Details 
window is displayed.

Display 32.23 Measure Details Window

2 Click Close.

Showing or Hiding Data Items

You can specify which data items you want to see for the data source in the Data tab.
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To show or hide data items:

1 On the Data tab, click  and then select Show or Hide Items. The Show or Hide 
Data Items window is displayed.

Display 32.24 Show or Hide Data Items Window

2 Select the data items that you want to appear on the Data tab. If there are data 
items that you do not want to see on the Data tab, then clear the check box (or 
check boxes) for that data item (or data items).

3 Click OK.

Modifying Data Role Assignments in 
Report Objects

After you have selected a report object and a data source, the Roles tab in the right 
pane shows which data items have been assigned to which role.
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To modify data role assignments:

1 Select a report object in the canvas that has data items assigned.

2 Click the Roles tab in the right pane.

Display 32.25 Roles Tab

3 Click  beside the role that you want to edit. For data roles that allow multiple data 
items, the menu items that are available can vary.

If you select a data item in Roles, then the Aggregation, Add, Remove, and 
Replace menu items are displayed. You can also right-click on a data item, and the 
actions specific to that data item are displayed.

Different data roles are available for different report objects. In addition to the basic 
data roles, you can assign additional data roles.

For example, here are the data roles for a bar chart:

Group
groups the data based on the values of the category data item that you assign.

Lattice columns
creates a lattice of charts with a column for each value of the category data item 
that you assign.
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Lattice rows
creates a lattice of charts with a row for each value of the category data item that 
you assign.

For example, for the bar chart shown in Display 32.25 on page 387, you can replace 
or remove the Category. For the Measure, you can modify the aggregation, add 
another measure, replace the existing measure, or remove the measure. You can 
also modify the Group, the Lattice columns, or Lattice rows.

Removing Data Role Assignments from 
Report Objects

To remove data items from their assigned data roles in a specific report object:

1 Right-click the report object in the canvas. A menu is displayed.

Here is an example of a bar chart with the object menu:

Display 32.26 Report Object Menu

2 Select Remove All Data Items. All data items are removed from the assigned data 
roles and the report object turns gray. The  status icon appears in the lower right 
corner to let you know that the required data roles are not assigned.
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Here is an example of what a bar chart looks like after all the data items have been 
removed from their assigned data roles:

Display 32.27 Report Object with Missing Data Assignments
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How Sorting Can Help with Analysis

Information can be easier to understand when it appears in an intentional order. 
Applying a sort order to one or more data items in SAS Visual Analytics Designer (the 
designer) enables you to arrange rows and columns in tables and axis labels on charts 
in some order, such as alphabetically or highest to lowest numerically. Interactively 
changing the order of data can provide you with a different perspective that often 
facilitates valuable insight. For example, in a report, sales employees who are initially 
arranged alphabetically can be re-sorted by sales amount.

Ranking can help reduce the amount of visible data and is often used in combination 
with sorting. For more information, see “Adding a New Rank” on page 456.
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Sorting Data in a List Table

To sort values in a list table, right-click on a column heading and select Sort. Then, 
select either Ascending or Descending.

Display 33.1 Sort Menu Items for List Tables

Note: You can also press the spacebar to sort a single column in a table.

Sorting Data in a Crosstab

To sort by category or measure values in a crosstab, right-click on a column or row 
heading, and select Sort. Then, select either Ascending or Descending.
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Display 33.2 Sort Menu Items for a Crosstab

You can also sort categories, rather than measures, by clicking the category name.

Sorting Data in a Graph

To sort by values in a graph, right-click on a measure name or category name, and 
select Sort. Then, select either Ascending or Descending.
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Display 33.3 Sort Menu Items for a Graph

394 Chapter 33 / Sorting Data Items in Reports



34
Working with Display Rules for Reports

Overview of Display Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395

Adding Report-Level Display Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396

Adding Table-Level Display Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398
Add Display Rules to a List Table Using an Expression . . . . . . . . . 399
Add Display Rules to a List Table Using a Gauge . . . . . . . . . . . . . . . . 401
Add Display Rules to a List Table Using Color-

Mapped Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404

Adding Graph-Level Display Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 406

Adding Display Rules to a Gauge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408

Overview of Display Rules

Display rules include all types of highlighting of report objects. They provide a flexible 
structure to specify conditions. There are several types of display rules. Display rules 
enable conditions to be shared across objects, but not all display rules apply across all 
report object types.

SAS Visual Analytics Designer (the designer) provides the following interfaces for 
display rules:

n The Display Rules tab in the right pane enables you to populate intervals, add 
intervals, or add color-mapped values for the report object, which is currently 
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selected in the canvas. You can use this pane to specify both report-level or object-
level display rules, depending on what you have selected in the report canvas.

n The Shared Rules tab enables you to create a new display rule for a gauge, which 
is used by other gauges to designate intervals and colors for ranges. You can also 
edit or delete an existing shared display rule. These rules are shared across multiple 
gauges and can be created at any time.

Note: Crosstabs, dual axis bar charts, dual axis bar-line charts, dual axis line charts, 
and dual axis time series plots do not support display rules.

Adding Report-Level Display Rules

To add a report-level display rule:

1 Without any report objects or the section selected in the report canvas, click the 
Display Rules tab in the right pane. Click New. The Add New Display Rule window 
is displayed.

Display 34.1 Add New Display Rule Window

2 Enter a value for the display rule in the field.

3 Select a color for the display rule.

4 (Optional) Repeat the steps for entering a value and selecting a color.
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5 (Optional) Select the Other check box. Then, select a color so that any of the other 
categories that do not have a color will have the one that you just selected.

In the following example, values and colors have been specified for each region in a 
list table. And a color has been selected for the Other check box.

Display 34.2 Add New Display Rule Window with Values and Colors Specified

6 Click OK. The report objects in the report update with the new display rule. And, the 
display rule appears on the Display Rules tab in the right pane.

Adding Report-Level Display Rules 397



The following table illustrates the report-level display rules that were defined in the Add 
New Display Rule window above.

Display 34.3 A List Table and a Bar Chart with Report-Level Display Rules Applied

Adding Table-Level Display Rules
You can add three different types of display rules to tables. You cannot create a display 
rule to highlight dates in a table.
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Add Display Rules to a List Table Using an 
Expression

Note: Display rules cannot be added to crosstabs.

To specify a new display rule for a table using an expression:

1 If it is not already selected, select the table in the report canvas that you want to 
update.

2 In the right pane, click the Display Rules tab. Click New. The Add New Display Rule 
window is displayed.

Display 34.4 Add New Display Rule Window for Tables

3 Click Expression. The Add New Display Rule window expands to show the details 
for the expression.
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Display 34.5 Add New Display Rule Window for an Expression

4 Select the Column or any measure value.

5 Select the Operator. You can select =, < >, Between, <, <=, >, >=, Missing, or 
NotMissing. The default is >.

6 Enter or select a Value.

7 Modify the style, size, and color of the font.

8 Select the row or column in the Applies to drop-down list.

9 Click OK. The table updates with the new display rule. The display rule appears on 
the Display Rules tab in the right pane.
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Here is an example of a display rule that uses an expression:

Display 34.6 Display Rules Tab with the Display Rules for an Expression

10 (Optional) Click  on the Display Rules tab to edit the new display rule.

Add Display Rules to a List Table Using a 
Gauge

To specify a new display rule for a table using a gauge:

1 If it is not already selected, select the table in the report canvas that you want to 
update. 

2 In the right pane, click the Display Rules tab. Click New. The Add New Display Rule 
window is displayed.

3 Click Gauge. The Add New Display Rule window expands to show the details for the 
gauge.
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Display 34.7 Add New Display Rule Window for a Gauge

4 Select a Gauge type from the drop-down list. Your choices are a bullet, an icon, a 
slider, or a thermometer. Icon is the default.

5 Using the Based on column drop-down list, specify which column the rule should 
be based on in the report.

6 Specify where the gauge should appear in the column for the Cell placement. Your 
choices are Left of text, Right of text, or Replace text. 

7 Define the intervals and colors for the rule:

n Enter the individual values for the intervals and then select a color. You can click 
the operator between the intervals to change it.

n Click  to automatically populate the intervals. The Populate Intervals window is 
displayed.
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Display 34.8 Populate Intervals Window

You can specify Number of intervals, Lower bounds, and Upper bounds. 
Click OK.

8 Specify the Column in which you want the gauge to be displayed

9 Click OK. The table updates with the new display rule. The display rule appears on 
the Display Rules tab in the right pane.

Here is an example of an automatically populated display rule that uses an icon:

Display 34.9 Display Rules Tab with the Display Rules for an Icon

10 (Optional) Click  on the Display Rules tab to edit the new display rule.
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Add Display Rules to a List Table Using 
Color-Mapped Values

To specify a new display rule for a table using color-mapped values:

1 If it is not already selected, select the table in the report canvas that you want to 
update.

2 In the right pane, click the Display Rules tab. Click New. The Add New Display Rule 
window is displayed.

3 Click Color-mapped values. The Add New Display Rule window expands to show 
the details for the color-mapped values.

Display 34.10 Add New Display Rule Window for Color-Mapped Values

4 Select the Column or value to which you want to apply the display rule.

5 Click in the box to enter a value for the display rule.
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6 Select a color for the display rule.

7 (Optional) Repeat the steps for entering a value and selecting a color.

8 (Optional) Select the Other check box. Then, select a color.

9 Using the Applies to drop-down list, specify where you want to apply the colors.

In the following example, values and colors have been specified for products in a list 
table.

Display 34.11 Add Display Rule Window with Color-Mapped Values Displayed

10 Click OK. The table updates with the display rules.
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The display rule appears on the Display Rules tab in the right pane.

Display 34.12 Display Rule for Color-Mapped Values

11 (Optional) Click  on the Display Rules tab to change the table-level display rule to 
a report-level display rule.

Adding Graph-Level Display Rules

You can add display rules to graphs. Note that you cannot create a display rule to 
highlight dates in a graph.

Note: Display rules can be added to a waterfall chart only if the Color by response 
sign check box is selected on the Properties tab in the right pane.

To specify a new display rule for a graph:

1 If it is not already selected, select the graph in the report canvas that you want to 
update.

2 In the right pane, click the Display Rules tab. Click New. The Add New Display Rule 
window is displayed.
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Display 34.13 Add New Display Rule Window for a Graph

3 Select a Column or value for the display rule.

4 Click in the box to enter a value for the display rule in the field.

5 Select a color for the display rule.

6 (Optional) Repeat the steps for entering a value and selecting a color. Use the 
arrows to move values up or down.

In the following example, values and colors have been specified for each product 
line in a bar chart.

Display 34.14 Add New Display Rule Window with Values and Colors Specified

7 (Optional) Select the Other check box. Then, select a color.

8 Click OK. The graph updates with the new display rule.
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The display rule appears on the Display Rules tab in the right pane.

Display 34.15 Display Rules Tab with the Display Rules for a Graph

9 (Optional) Click  on the Display Rules tab to edit the new display rule.

10 (Optional) Click  in the Display Rules tab to change the graph-level display rule to 
a report-level display rule.

Adding Display Rules to a Gauge

A display rule is used by a gauge to designate intervals and colors for ranges.

To specify a new display rule for a gauge:

1 If it is not already selected, select the gauge in the report canvas that you want to 
update.

2 In the right pane, click the Display Rules tab. 
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Here is an example of the Display Rules tab for a dial gauge:

Display 34.16 Display Rules Tab for a Dial Gauge

3 Specify (or modify) the display rules for the gauge. You can populate intervals, edit 
the display rule, and specify the Type. 

To automatically populate the intervals:

a Click  to display the Populate Intervals window.

Display 34.17 Populate Intervals Window

b Enter a number for Target value.

c Click OK. The gauge updates with the new display rule.

To edit the display rule for a gauge:

a Click  to display the Edit Display Rule window.
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Display 34.18 Edit Display Rule Window

b Select a Type. Your choices are either Use a Shared Display Rule or Specify 
Intervals. 

If you select Specify Intervals, then the window contents change so that you 
can add intervals. Here is an example:

Display 34.19 Specifying Intervals in the Edit Display Rules Window

Update the conditions for the values, the intervals, and the color for the range. 
Select a color to open the color picker. To add new intervals to the display rule, 
enter a number and click Add. Select the Save as a shared Display Rule check 
box and specify a Name if you want to save the display rule.

c Click OK. The gauge updates with the new display rule.
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About Report Filters

In SAS Visual Analytics Designer (the designer), you can create filters to subset your 
data. Three types of filters are available for report objects:
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Basic filters
subset the data for individual report objects in your reports by using a single data 
item. A basic filter is constrained to use only the data item that was selected when 
the basic filter was created. Basic filters can be modified by using the context menu 
for a report object or by using the Edit Filter window. For more information, see 
“Working with Basic Filters for Report Objects” on page 412.

Advanced filters
subset the data for individual report objects in your reports by using any number of 
data items and operators (for example, OR and AND) in the same expression. 
Advanced filters can be created and modified by using the Advanced Filter window. 
For more information, see “Working with Advanced Filters for Report Objects” on 
page 417.

Data item filters
subset the data that is returned from a query in a data source. The data item filters 
that you create are applied to every report object in the report that uses the data 
source containing the data item. For more information, see “Working with Data Item 
Filters in a Report” on page 421.

All of your filters are saved when you save your report.

Working with Basic Filters for Report 
Objects

About Basic Filters for Report Objects

For certain report objects, you can subset your data by using the Filters tab in the right 
pane of the designer. You can base your filters on any data item in the current data 
source for this report object, regardless of whether the data item is assigned to a report 
object in the current report.

Filters on a report object are applied in conjunction with any data item filters that have 
been applied. Data item filters do not impact the selections that you can make for filters 
on a report object. For example, if there is a data item filter on a Country item that has 
the selections for Canada, United States, and Germany, you might still have a report 

412 Chapter 35 / Working with Report Filters



object filter with selections such as Canada and Mexico. If these filters are applied 
together, then the report object only displays content for Canada.

Create a Basic Filter for a Report Object

To create a basic filter for a report object:

1 If it is not already selected, select the report object in the report canvas that you 
want to filter. The report object must have at least one data item assigned.

2 In the right pane, click the Filters tab.

3 Click  beside the Add Filter button, and select a data item from the list. Then, click 
Add Filter. The filter appears in the tab.

For a basic filter that uses a check box list, a check box is displayed for each distinct 
value that uses the current format applied to the data item. Select the data value (or 
data values) that you want to filter or clear the selections for the data value (or data 
values) that you do not want to filter. Here is an example of a basic filter that uses a 
check box list:

Display 35.1 Basic Filter That Uses a Check Box List
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Click All to select all of the values. Click  to search for a data item (or data items).

For filters that use a slider, the slider shows you the maximum value and the 
minimum value that exist for the data item using the current data item format. Use 
the slider to select a range of target values. Here is an example of a basic filter that 
users a slider:

Display 35.2 Basic Filter That Uses a Slider

Note: By default, your filter changes are applied automatically to the active report 
object. To apply multiple changes together, clear the Auto check box, and then click 
Apply when you are ready to apply changes.

4 Click  (to the left of the delete icon) for options. The available options depend on 
whether you are filtering characters, dates, or numerics.

The following filtering options are available:

Option When Available

Edit Filter This option is always available.

Filter using 
continuous values

This option is available only for measure data items.

Filter using 
discrete values

This option is available for measure and category data items.
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Option When Available

Select all This option is available when filtering discrete values using a check 
box list. It selects all of the current discrete values that are listed. 
This option does not affect the Include missing values setting.

Clear all This option is available when filtering discrete values using a check 
box list. It clears the selections of all of the current discrete values 
that are listed. This option does not affect the Include missing 
values setting.

Invert selection This option is available when filtering discrete values using a check 
box list. It changes all of the discrete value check boxes so that if 
they are selected, then they are cleared. If they are cleared, then 
they are selected. This option does not affect the Include missing 
values setting.

Include missing 
values

This option is available from the menu only for slider-based filters. 
It works the same as selecting the Include missing values check 
box.

Exclude missing 
values

This menu option is available for slider-based filters and works the 
same as clearing the Include missing values check box.

TIP Use the arrow to the left of the filter name on the Filters tab to expand or to 
collapse the filter details when you are working with multiple filters.

Edit a Basic Filter for a Report Object

To edit a basic filter for a report object:

1 If it is not already selected, select the report object in the report canvas that you 
want to filter. The report object must have at least one data item assigned.

2 In the right pane, click the Filters tab.

3 Click  beside the filter name. Then, select Edit Filter. The Edit Filter window is 
displayed.
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Display 35.3 Edit Filter Window

4 Build the expression for your filter by dragging and dropping conditions and 
operators onto the expression in the right pane.

For information about the operators and conditions that are available, see Appendix 
2, “Conditions and Operators for Filters,” on page 499.

Note: The AND and OR operators can accept more than two conditions. To add a 
condition to the operator, drag and drop a new condition onto the operator name in 
the right pane. For example, to add a third condition to an AND operator, drag and 
drop the new condition onto AND in the expression.

TIP Right-click the AND or OR operator in the expression, and then select Add  
New Condition.

5 Click OK to apply the filter.

Delete a Basic Filter for a Report Object

To delete a basic filter, click  beside the filter on the Filters tab.
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Working with Advanced Filters for 
Report Objects

About Advanced Filters for Report Objects

For most report objects, you can create advanced filters to subset your data by using 
the Filters tab in the right pane.

Advanced filters enable you to create filters that use more than one data item.

Note: Advanced filters that are created in the explorer might contain expressions that 
you cannot create in the designer.

Note: Advanced global filters that are created in the explorer are supported by the 
designer, but you cannot create advanced global filters in the designer.

Create an Advanced Filter for a Report 
Object

To create an advanced filter:

1 If it is not already selected, select the report object in the report canvas that you 
want to filter. The report object must have at least one data item assigned.

2 In the right pane, click the Filters tab.

3 Click  to select Advanced instead of a specific data item.
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Display 35.4 Advanced Selection on the Filters Tab

4 Click Add Filter. The Edit Advanced Filter window is displayed.

Display 35.5 Edit Advanced Filter Window

5 Create a condition for the filter:

a From the Data Items list, select the data item on which the condition is based.
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b From the Column Templates list, select a condition.

For information about the conditions that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

c Drag and drop the condition onto the expression.

d For any required parameters, enter a value or right-click on the parameter field, 
and select Replace with to select a data item for the parameter.

6 (Optional) Add an operator to the expression:

a From the Operators list, select an operator to join the conditions in your 
expression.

For information about the operators that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Drag and drop the operator onto the expression.

c From the Column Templates list, select another condition. Then, drag and drop 
the additional condition onto the expression. Complete any required parameters.

TIP Right-click the AND or OR operator in the expression, and then select 
Add  New Condition.

7 Click OK to apply the advanced filter.

Edit an Advanced Filter for a Report Object

To edit an advanced filter:

1 In the right pane, click the Filters tab.

2 Click  beside the advanced filter name. Then, select Edit Filter. The Edit 
Advanced Filter window is displayed.
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Display 35.6 Edit Advanced Filter Window

3 Edit or add a new condition for the filter:

a From the Data Items list, select the data item on which the condition is based.

b From the Column Templates list, select a condition. 

For information about the conditions that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

c Drag and drop the condition onto the expression.

d For any required parameters, enter a value or right-click on the parameter field, 
and select Replace with to select a data item for the parameter.

4 (Optional) Replace a condition by dragging and dropping a new column template 
onto the existing condition in the expression.

5 (Optional) Add an operator to the expression:
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a From the Operators list, select an operator to join the conditions in your 
expression.

For information about the operators that are available, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Drag and drop the operator onto the expression.

c (Optional) Add a condition.

TIP Right-click the AND or OR operator in the expression, and then select 
Add  New Condition.

6 (Optional) Delete part of an expression by highlighting the part of the expression that 
you want to delete, and then selecting Delete or Clear.

7 Click OK to apply the advanced filter.

Delete an Advanced Filter for a Report Object

To delete an advanced filter, click  on the filter on the Filters tab.

Working with Data Item Filters in a 
Report

About Data Item Filters

Data item filters are used to restrict the data that is returned from a query to a data 
source. The data item filters that you create in the designer are applied to every report 
object in the report that uses the data source containing the data item. Data item filters 
are not displayed on the Filters tab. They are identified by a special icon in the data 
source’s data items list.
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Note: Date data items and calculated data items do not have special icons when a data 
item filter is applied.

You can use either continuous values or discrete values to create a data item filter. 
Continuous value filters can be used only for measures. Discrete value filters can be 
used for any character; numeric; or date, datetime, or data item, as long as the total 
number of distinct values does not exceed a maximum number.

Create a Data Item Filter

Create a Data Item Filter That Uses Continuous Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
filter.

2 Right-click on the data item, and then select New Data Item Filter  Using 
Continuous Values. The New Data Item Filter window is displayed.

Display 35.7 New Data Item Filter Window for a Data Item That Uses Continuous Values

3 In the New Data Item Filter window, a slider shows you the maximum value and the 
minimum value that exist for the data item using the current data item format. Use 
the slider to select a range of target values.

4 (Optional) If you do not want to include missing values in the filter, then clear the 
Include missing values check box.

5 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.
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Display 35.8 Edit Filter Window

a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.

For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the New Data Item 
Filter window.

Display 35.9 New Data Item Filter Window with a Revised Filter

6 Click OK in the New Data Item Filter window. The  or  icon identifies the new 
data item filter on the Data tab.
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Create a Data Item Filter That Uses Discrete Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
filter.

2 Right-click on the data item, and then select New Data Item Filter  Using 
Discrete Values. The New Data Item Filter window is displayed.

Display 35.10 New Data Item Filter Window for a Data Item That Uses Discrete Values

For a data item filter that uses a check box list, a check box is displayed for each 
distinct value that uses the current format applied to the data item.

Note: The content in the New Data Item Filter window depends on the data type 
and the format of the data item. When you filter on discrete values, some data type 
and format combinations result in a New Data Item Filter window with a check box 
list. Or, the New Data Item Filter window has a slider.

3 In the New Data Item Filter window, select the data value (or data values) that you 
want to filter.

4 (Optional) Click  to search for a data item.

5 (Optional) If you do not want to include missing values in the filter, then clear the 
Include missing values check box.
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6 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.

Display 35.11 Edit Filter Window

a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.

For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the New Data Item 
Filter window.

Display 35.12 New Data Item Filter Window with a Revised Filter
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7 Click OK in the New Data Item Filter window. The  or  icon identifies the new 
data item filter on the Data tab.

Replace a Data Item Filter

Replace a Data Item Filter That Uses Continuous Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
replace.

2 Right-click on the data item, and then select Replace Data Item Filter  Using 
Continuous Values. Click Yes in the confirmation message that is displayed. The 
Replace Data Item Filter window is displayed.

Display 35.13 Replace Data Item Filter Window for a Data Item That Uses Continuous 
Values

3 In the Replace Data Item Filter window, a slider shows you the maximum value and 
the minimum value that exist for the data item using the current data item format. 
Use the slider to select a range of target values.

4 (Optional) If you do not want to include missing values in the filter, then clear the 
Include missing values check box.

5 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.

a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.
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For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the Replace Data Item 
Filter window.

6 Click OK in the Replace Data item Filter window. The report objects that use the 
replaced data item filter are updated.

Replace a Data Item Filter That Uses Discrete Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
replace.

2 Right-click on the data item, and then select Replace Data Item Filter  Using 
Discrete Values. Click Yes in the confirmation message that is displayed. The 
Replace Data Item Filter window is displayed.

Display 35.14 Replace Data Item Filter Window for a Data Item That Uses Discrete 
Values

3 If the Replace Data Item Filter window shows a check box list or slider, adjust those 
controls to modify the filter. Select the data value (or data values) that you want to 
filter.

4 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.
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a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.

For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the Replace Data Item 
Filter window.

5 Click OK in the Replace Data Item Filter window. The report objects that use the 
replaced data item filter are updated.

Edit a Data Item Filter

Edit a Data Item Filter That Uses Continuous Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
edit.

2 Right-click on the data item, and then select Edit Data Item Filter. The Edit Data 
Item Filter window is displayed.

Display 35.15 Edit Data Item Filter Window for a Data Item Filter That Uses Continuous 
Values

3 In the Edit Data Item Filter window, a slider shows you the maximum value and the 
minimum value that exist for the data item using the current data item format. Use 
the slider to select a range of target values.
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4 (Optional) If you do not want to include missing values in the filter, then clear the 
Include missing values check box.

5 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.

Display 35.16 Edit Filter Window

a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.

For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the Edit Data Item Filter 
window.
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Display 35.17 Edit Data Item Filter Window with a Revised Filter

6 Click OK in the Edit Data Item Filter window. The report objects that use the edited 
data item filter are updated.

Edit a Data Item Filter That Uses Discrete Values

1 In the left pane, click the Data tab, and then select the data item that you want to 
edit.

2 Right-click on the data item, and then select Edit Data Item Filter. The Edit Data 
Item Filter window is displayed.

Display 35.18 Edit Data Item Filter Window for a Data Item Filter That Uses Discrete 
Values

3 If the Edit Data Item Filter window shows a check box list or slider, adjust those 
controls to modify the filter. Select the data value (or data values) that you want to 
filter.

4 (Optional) Click Advanced to add more conditions to the data item filter. The Edit 
Filter window is displayed.
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Display 35.19 Edit Filter Window

a Edit the expression for your filter by dragging and dropping Conditions and 
Operators onto the expression.

For more information about conditions and operators, see Appendix 2, 
“Conditions and Operators for Filters,” on page 499.

b Click OK in the Edit Filter window. The filter is updated in the Edit Data Item Filter 
window.

Display 35.20 Edit Data Item Filter Window with a Revised Filter

5 Click OK in the Edit Data Item Filter window. The report objects that use the edited 
data item filter are updated.
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Delete a Data Item Filter

To delete a data item filter:

1 In the left pane, click the Data tab, and then select the data item that you want to 
delete.

2 Right-click on the data item, and then select Delete Data Item Filter. The data item 
filter is removed from the Data tab.
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Overview of Interactions

Interactions are used to direct a report viewer’s attention to specific results in a report. 
Interactions allow data to be subset to reduce the amount of data, and enables users to 
understand it within a particular context.

The interactions view in SAS Visual Analytics Designer (the designer) enables report 
authors to specify which interactions they would like to add to tables, graphs, gauges, 
and controls in a report.
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There are these types of interactions:

filter
is used to restrict the data that is returned from a query to a data source. Filters are 
simply a set of rules or conditions that you specify to subset the data that is 
displayed in a table or graph. The goal is to display only the data that you need to 
see to perform your analysis.

brush
is short for data brushing, which enables you to show the same data selected 
simultaneously in two or more tables, graphs, or controls. Brushing highlights a 
percentage that reflects the number of shared observations in the data set. Brushing 
does not highlight a percentage that corresponds to the aggregated value. The 
brushed data has the same appearance in each object, which makes the data easily 
apparent to report viewers.

Tables, graphs, and gauges can be the source of an interaction, with the exception of 
scatter plots and time series plots. Controls that are used on the report canvas can also 
be the source of an interaction. Controls that are used as section prompts are treated as 
automatic filters and are not displayed in the interactions view.

Some objects (for example, heat maps and box plots) that are imported from SAS 
Visual Analytics Explorer (the explorer) cannot participate in interactions.

The Interactions tab in the right pane enables you to create interactions and links.

Creating Interactions

Create a Filter Interaction

You can create interactions using the interactions view or the Interactions tab in the 
right pane.

Note: You cannot create interactions from list tables, bubble plots, and scatter plots 
that use detail data. However, a list table that uses detail data can be the target of an 
interaction.
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Note: Scatter plots cannot be the source of an interaction.

Note:  Bubble plots can be the source of an interaction only if they have a Grouping 
role assigned.

To create a filter interaction using the interactions view:

1 Add the report objects that you want to use to the report canvas. For example, you 
might have a bar chart, a line chart, and a list table.

2 Click Interactions View on the Interactions tab to switch to the interactions view. 
You can also select View  Show Interactions.

3 In the interactions view, draw a connection between the source and target report 
objects. When you have created an interaction, the  is displayed between the 
report objects. Here is an example of an interaction between a bar chart (the source) 
and a list table (the target):

Note: The source and target of an interaction must be based on the same data 
source.
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Display 36.1 Creating a Filter Interaction between a Bar Chart and a List Table

4 Right-click . Then, select Interaction Type  Filter.
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Display 36.2 Interaction Type Menu

5 (Optional) Add other filter interactions.

6 Click Close. The new interaction (or interactions) appears on the Interactions tab in 
the right pane.
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The following example shows the Interactions tab for the filtering example shown in 
Display 36.4 on page 438.

Display 36.3 Interactions Tab with Two Interactions Displayed

Select data in the source report object to filter data in the target report object (or 
objects). In the following example, the promotional product line was selected in the bar 
chart. Simultaneously, the line chart and the list table show the same filter.

Display 36.4 A Filtering Example with a Bar Chart, a Line Chart, and a List Table
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Clicking on another selection applies the filter based on your new selection. For 
example, in the report above, you can click on the game product line to change the 
filter. An icon is added to the report object that is filtered.

Here is the line chart that was used in the previous example. The incoming filter icon 
appears above the report object when it is selected in the canvas.

Display 36.5 Example of a Report Object with an Incoming Filter

To clear the selection and reset the filter (or filters), press Ctrl+click while viewing the 
original report object.

To create an interaction using the New button on the Interactions tab:

1 Select a report object in the canvas. For example, you might have a bar chart.

2 Select the Interactions tab.

3 Click New, and then select Interaction. The Edit Interaction window is displayed.
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Display 36.6 Edit Interaction Window

4 In the Edit Interaction window, select the report object that you want to use as the 
source of a filter or brush interaction. For example, if your report has a bar chart, and 
you want it to filter a line chart, the first line should read Bar Chart 1 filters List Table 
1.

The Edit Interaction window disables options for filter or brush interactions if they are 
not possible.

5 When you are finished working with interactions, click OK.

6 The new interaction is displayed in the Interactions tab.
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Create a Data Brushing Interaction

To create an interaction using data brushing:

1 Add the report objects that you want to use to the canvas. For example, you might 
have a bar chart, a line chart, and a list table.

2 Select the Interactions tab.

3 Click Interactions View on the Interactions tab to switch to the interactions view. 
You can also select View  Show Interactions.

4 In the interactions view, draw a connection between the source and target report 
objects. When you have created an interaction, the  is displayed between the 
report objects.

5 Right-click . Then, select Interaction Type  Brush.
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Display 36.7 Interaction Type Menu with Brush Selected

The filter icon changes to .

6 Click Close. The new interaction (or interactions) appears on Interactions tab in the 
right pane.

Select data in the source report object to brush data in the target report object (or 
objects). In the following example, the stuffed animal product line was selected in the 
bar chart. Simultaneously, the line chart and the crosstab highlight the same data.
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Display 36.8 A Data Brushing Example with a Bar Chart, a Line Chart, and a List Table

Note: If a graph contains a frequency measure, then a crosshatch pattern indicates 
when it is selected or brushed.

The brush interaction between controls behaves differently than a brush interaction 
between tables and graphs. When there is a brush interaction between controls, instead 
of highlighting or selecting the values in the other control, the values that match are 
moved to the top of the control, and the values that do not match are grayed out. If a 
frequency data item exists, then the frequency value is updated.
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Here is an example of a report on cars with three list controls:

Display 36.9 Three List Controls with Brush Interactions

The first list contains three countries listed as the Origin. The second list contains six 
types of vehicles. The third list contains 38 car manufacturing companies. There is a 
brush interaction between the first list and the second list. There is a second brush 
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interaction between the second list and the third list. Look at the values in the second 
list.

Display 36.10 Example: Three List Controls in a Report

In step 1, the user has selected Europe as the country of Origin in the first list. Notice 
the changes in the second list. Hybrid and Truck are grayed out, and their frequency 
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values have both changed to 0. In the third list, all of the car manufacturers that are not 
located in Europe are grayed out, and their frequency values have all changed to 0

Display 36.11 Example: Three List Controls in a Report with One Brush Interaction

446 Chapter 36 / Working with Interactions



In step 2, the user has selected Porsche as the car manufacturing company in the third 
list. Notice the changes in the second list. Hybrid, Sedan, Truck, and Wagon are 
grayed out, and their frequency values have all changed to 0.

Display 36.12 Example: Three List Controls in a Report with Two Brush Interactions

Deleting Interactions

You can delete interactions using the interactions view or the Interactions tab in the 
right pane.

To delete either a filter or data brushing interaction using the interactions view:

1 Select the Interactions tab.
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2 Click Interactions View to switch to the interactions view. You can also select View 
 Show Interactions.

3 Right-click  or the , depending on which type of interaction you want to delete. 
Then, select Delete Interaction.

Display 36.13 Interaction Type Menu for a Filter with Delete Selected

4 Click Yes in the confirmation message that is displayed.

5 (Optional) Remove other interactions.

To delete an interaction using the Interactions tab:

1 Click the Interactions tab.

2 Click  next to the interaction that you want to delete.
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3 Click Yes in the confirmation message that is displayed.

Creating Links
Using the Interactions tab, you can add a link from a report object, text, or image to 
another report; you can add a link to a specific section in the current report; or you can 
add a link from report objects (including text objects) to an external URL.

Create a Link to Another Report

To add a link from a report object or image to another report:

1 Click the Interactions tab.

2 Click New, and then select Report Link. The Select window is displayed.

Display 36.14 Select Window

3 Select a target report, and then click OK. The Create Report Link window is 
displayed.
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4 Verify the name of the target report. If you want to select a different target report, 
click Browse. 

If the target report contains more than one section, then select the report section that 
you want to open first.

Display 36.15 Create Report Link Window with Section 3 Selected

Click OK. The new report link is displayed on the Interactions tab in the right pane.

Double-click on an item in the report object (for example, a bar, a row in a table, a pie 
slice, and so on) to activate the report link. You are prompted to save changes to the 
report object before you can follow the link to the target report. To return to the source 
report object, use the button next to the target report name above the canvas.

Here is an example of the button that enables you to return to the source report object:

Display 36.16 Button to Return to the Source Report Object

To add a link from text to another report:

1 Double-click inside the text object on the canvas and enter the text. You can use the 
floating toolbar to change the font, font size, text color, and text background color. 
You can specify whether the text is bold, italic, or underlined, and whether it is left-
aligned, centered, or right-aligned.
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You can use the context menu to cut, copy, and delete text. However, you have to 
use the keyboard shortcut (Ctrl +V) to paste text.

2 (Optional) Add a hyperlink by selecting some text, and then clicking . Select 
Hyperlink. The Link Setup window is displayed. Select the Type of link. The options 
are External URL and Report Link. If your report has multiple sections, then the 
Section Link option is also displayed.

Enter a URL. The http:// part of the link is provided. The link can be relative to 
the current web application server.

Display 36.17 Link Setup Window

3 Click OK. The link appears in the text object.

Create a Link to One or More Sections in a 
Report

To add a link from a report object, text, or image to a specific section in the same report:

1 Click the Interactions tab.

2 Click New, and then select Section Link. The Create Section Link window is 
displayed.
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Display 36.18 Create Section Link Window

3 Select All to link to all of the sections in the report or select a specific section (or 
sections) in the report.

Click OK. The new section link is displayed on the Interactions tab in the right pane. 
If you selected multiple sections, those links are displayed on the Interactions tab.

Alternatively, you can create a section link using the interactions view.

Create a Link to an External URL

You can add a link from a report object, text, or image to an external URL. The 
http:// part of the link is provided. The link can be relative to the current web 
application server. For example, you can link to a stored process, which means that you 
would not need to specify http://servername:port because you are already logged on 
to that server.

To add a link to an external URL:

1 Click the Interactions tab.

2 Click New, and then select External Link. The Create External Link window is 
displayed.
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Display 36.19 Create External Link Window

3 Enter a Label and a Url for the link.

4 (Optional) Click  to specify additional parameters for the link. You can specify the 
Format value option, a Source, and a Target. The Format value option applies 
only to dates and numbers. You can add multiple parameters.

Display 36.20 Create External Link Window Expanded to Show Parameters

5 Press Enter or Tab to activate the OK button. Click OK. The new external link is 
displayed on the Interactions tab in the right pane.

Double-click on a report object to link to the external URL.

Deleting Links

To delete a link from a text object, select the linked text, and then click . Then, select 
Remove Link.

To delete a link using the Interactions tab:

1 Click the Interactions tab.
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2 Click  next to the link that you want to delete.

3 Click Yes in the confirmation message that is displayed.
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Overview of Ranking in Reports

Using SAS Visual Analytics Designer (the designer), you can rank the data in a report 
object to show the top (greatest) value or bottom (least) value for a category that is 
based on a measure. For a list table, you can also rank across a set of categories for 
the top value or bottom value in the set. A rank filters the values of a category based on 
the aggregated measure by the top or bottom of the values. A rank greatly reduces the 
visible categories to make it easier to focus on the top value or bottom value that 
interests a user.

For example, you might create a rank of the top 10 countries by frequency to select the 
10 countries that are most represented in your report. As another example, you might 
create a rank of the top 10 countries by population to select the 10 countries with the 
greatest populations.
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Adding a New Rank

You can use the Ranks tab to create ranks to subset the data in your reports. You can 
also right-click on your graphs and tables to add a rank to limit the number of bars, 
rows, and so on. Controls and gauges support ranks.

A single category rank ranks the top of a single category.

To add a rank:

1 Click the Ranks tab.

2 Select a data item. You can select any category or geography data item, regardless 
of whether it is assigned to the current report object.

For list tables only, you can select All visible categories. This rank ranks across 
the crossing. For example, you select the region and product data items. You rank 
on the crossing of these data items. In this case, the column is no longer considered 
a single column, it is considered the crossing of the columns.

The Detail rank option is available for list tables, bubble plots, and scatter plots that 
show detail data. If the report object has a detail rank, then it is the only rank that it 
can have. Otherwise, report objects can have multiple ranks.

3 Click Add Rank. The Ranks tab expands.

Display 37.1 Ranks Tab
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4 Select the type of rank from the drop-down list. Top specifies that the rank selects 
the greatest value. Bottom specifies that the rank selects the least value.

5 Specify the number of values for the rank. For example, if you specify 5, and you 
select Top as the rank type, then the rank selects the five greatest values.

6 From the By drop-down list, select the measure that is used to create the rank. You 
can select any measure.

7 (Optional) Select Ties to include ties in the rank.

If you select Ties, then the rank selects as many values as necessary to include all 
of the ties. If you do not select Ties, then the rank selects only the number of values 
that are specified by the rank parameters.

For example, if your rank selects the top three values, but there are five values tied 
for the greatest value, then the number of values that are selected by the rank 
depends on the Ties option. If you select Ties, then the rank includes all five of the 
tied values. If you do not select Ties, then the rank includes only three of the tied 
values.

8 (Optional) Select All Other to show the measurements for the categories that did not 
qualify as a top or bottom value.

Note: The All Other option is not available when there is a detail rank or when the 
data item is hidden. It is not available if the rank is on a prompt control, geo bubble 
map, or geo region map.

When the All Other option is specified for a report object, the total, subtotal, and 
percent of total show values with respect to all of the data, rather than data just 
relative to data qualifying under the rank. The data that does not fit into the top or 
bottom of the rank is aggregated in the All Other category.

You can use the All Other option with a top ranking to reduce the number of slices 
in a pie chart. However, this means that the “Other” slice is removed from the pie 
chart.

If you do not select All Other, then the rank shows only the data as filtered by the 
category values that qualify as the top or bottom value.
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Note: If All Other is selected, then any All Other value that appears in a table or 
graph cannot be selected. This means that the All Other value cannot be the source 
value for an interaction.

By default, your new rank is applied automatically to the report object.

You can add more than one rank to a report object, as long as the first rank is not a 
Detail rank or an All visible categories rank.

Here is an example of a pie chart that shows the profit for multiple product lines before a 
rank is applied:

Display 37.2 Pie Chart with Profits for Each Product Line Displayed
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Here is the same pie chart after a rank of the top five product lines is added. The All 
Other option was selected, so the “Other” slice is not displayed.

Display 37.3 Pie Chart with Profits for the Top Five Product Lines Displayed

Deleting a Rank

To delete a rank, click  on the rank on the Ranks tab.

You can also right-click on the report object and select Remove Rank as long as there 
is only one rank for the report object.
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Overview of Report Sections

Any report in SAS Visual Analytics Designer (the designer) can have multiple sections. 
Multiple sections can be used to present different views of the data to the person who 
views the report. Each section has one or more data sources. There is no limit to the 
number of sections in a report.

Adding a Section to a Report

You can add sections to any report, including reports that were created in SAS Visual 
Analytics Explorer (the explorer).
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Here is an example of what the first section tab looks like:

Display 38.1 First Section Tab

To add a new section to a report, click  in to the right of the first section tab in the 
report. The new tab appears to the right of the existing tab (or tabs).

Here is an example:

Display 38.2 Multiple Section Tabs

Renaming a Report Section

To rename a report section:

1 Right-click the section tab that you want to rename. A menu is displayed.

Display 38.3 The Menu Option for Renaming a Section

2 Select Rename.

3 Type a new name, and then press Enter. The new name also appears on the 
Properties tab in the right pane.

Alternatively, you can change the name on the Properties tab.
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Deleting a Section from a Report

To delete a section from a report, right-click the section tab that you want to remove. 
Select Delete.

Note: The Delete menu option is not available if the report has only one section.

Moving or Dragging a Report Object to 
Another Section

To move a report object from one section in a report to another section, right-click the 
report object, and select Move to. Then, select the name of the other section. You can 
drag an object from one section and drop it onto the tab for another section to move it to 
that section.

If you move an object to a section with precision layout, then you must manually move 
the object to its proper location. All objects are put in the top left corner by default.
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Overview of Exporting from the 
Designer

All users who have the Export Data capability can use the designer to export data from 
report objects to Microsoft Excel format for future viewing or printing. This exported 
output can be saved locally on disk, and then opened in Microsoft Excel.

When you export a graph from SAS Visual Analytics Designer (the designer), you are 
exporting the data, not the visual graph representation.

Not all report objects in the designer support the exporting feature. For example, you 
cannot export data from gauges. If the export feature is not available for a particular 
report object, the Export <reportObjectName> menu item does not appear when you 
right-click on the object.

465



Exporting Data from Report Objects

Export Data from a List Table

To export data from a list table:

1 If the list table that you want to export is not already selected, select it.

2 Right-click on the list table, and select Export <listTableName>, where 
<listTableName> is the name of the report object.

Here is an example of the Export menu option for a list table:

Display 39.1 Export Menu for List Tables

The Export or Save As window is displayed.

466 Chapter 39 / Exporting Data from Report Objects



Display 39.2 Export or Save As Window for List Tables

3 Choose one of the following export options for rows:

n Select All rows to export all rows.

n Select Rows to specify a range of rows to export. Enter a number in the From 
and To fields.

4 Choose one of the following export options for columns:

n Select All columns to export all columns.

n Select Selected columns to specify which columns to export. Then, select the 
check box (or check boxes) to the left of the column (or columns) that you want 
to export. At least one column is required. If you do not select a column, then a 
message is displayed, and the Export or Save As window cannot be closed.

5 (Optional) To choose whether the exported data is formatted, either select or clear 
the Formatted data check box. This check box is selected by default.
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6 If you select Export to, then the only option is Excel 2007 Workbook (*.xlsx) to 
create a Microsoft Excel spreadsheet.

7 If you select Save as, choose one of the following options:

n Select Tab-Separated Values (*.tsv) to create a data file.

n Select Comma-Separated Values (*.csv) to create a data file.

8 Click OK.

9 When you are prompted, choose either to open the file or to save it.

Export Data from a Crosstab

To export detail data from a crosstab:

1 If the crosstab that you want to export is not already selected, select it.

2 Right-click on the crosstab, and select Export <crosstabName>, where 
<crosstabName> is the name of the report object.

Here is an example of the Export menu option for a crosstab:

Display 39.3 Export Menu for Crosstabs
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The Export or Save As window is displayed.

Display 39.4 Export or Save As Window for Crosstabs

3 Choose one of the following export options for rows:

n Select All rows to export all rows.

n Select Rows to specify a range of rows to export. Enter a number in the From 
and To fields.

4 Choose one of the following export options for columns:

n Select All columns to export all columns.

n Select Selected columns to specify which columns to export. Then, select the 
check box (or check boxes) to the left of the column (or columns) that you want 
to export. At least one column is required. If you do not select a column, then a 
message is displayed, and the Export or Save As window cannot be closed.

5 (Optional) To choose whether the exported data is formatted, either select or clear 
the Formatted data check box. This check box is selected by default.
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6 If you select Export to, then the only option is Excel 2007 Workbook (*.xlsx) to 
create a Microsoft Excel spreadsheet.

7 If you select Save as, choose one of the following options:

n Select Tab-Separated Values (*.tsv) to create a data file.

n Select Comma-Separated Values (*.csv) to create a data file.

8 Click OK.

9 When you are prompted, choose either to open the file or to save it.

Export Data from a Graph

Note: You cannot export the actual visual graph. Only the data can be exported.

To export data from a graph:

1 If the graph that you want to export is not already selected, select it.

2 Right-click on the graph, and select Export <graphName>, where <graphName> is 
the name of the report object.

Here is an example of the Export menu option for a line chart:

Display 39.5 Export Menu for Graphs
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The Export or Save As window is displayed.

Display 39.6 Export or Save As Window for Graphs

3 Choose one of the following export options for rows:

n Select All rows to export all rows.

n Select Rows to specify a range of rows to export. Enter a number in the From 
and To fields.

4 Choose one of the following export options for columns:

n Select All columns to export all columns.

n Select Selected columns to specify which columns to export. Then, select the 
check box (or check boxes) to the left of the column (or columns) that you want 
to export. At least one column is required. If you do not select a column, then a 
message is displayed, and the Export or Save As window cannot be closed.

5 (Optional) To choose whether the exported data is formatted, either select or clear 
the Formatted data check box. This check box is selected by default.

Exporting Data from Report Objects 471



6 If you select Export to, then the only option is Excel 2007 Workbook (*.xlsx) to 
create a Microsoft Excel spreadsheet.

7 If you select Save as, choose one of the following options:

n Select Tab-Separated Values (*.tsv) to create a data file.

n Select Comma-Separated Values (*.csv) to create a data file.

8 Click OK.

9 When you are prompted, choose either to open the file or to save it.
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Viewing Reports on a Mobile Device
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Opening the App for the First Time

You can use the SAS Mobile BI for iPad or Android app to view SAS Visual Analytics 
reports on your mobile device. The SAS Mobile BI for iPad app is available in the 
iTunes App Store. The Android app is available from Google Play.

When you open either app for the first time, sample reports are available in My Portfolio. 
The app provides online Help for using SAS Mobile BI. You can view the online Help in 
My Portfolio. The online Help also provides access to tutorial videos about how to use 
the app.

Add a Server Connection for iPad

When you first open the SAS Mobile BI for iPad app, the only connection that is 
available is to the SAS Demo Server.
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To access your corporate library server, you must add a connection to that server. If 
your company has more than one server, you can add additional connections in the 
same way.

Note: Contact your SAS Visual Analytics system administrator for your user ID, 
password, and server information.

Here are the steps to connect to a server:

1 If you are in My Portfolio, tap Library.

2 Tap Connections in the library.

3 Tap Add Connections.

4 Tap the Server field, and enter the address of the new server.

Note: If the server requires a secure (SSL) connection, type https:// at the beginning 
of the server address.

5 Tap the User ID field, and enter your user ID.

6 Tap the Password field, and enter your password.

7 Tap the Description field, and enter a description for the new connection.

8 Tap Next to verify the connection.

9 Tap Save. The connection is saved, and the Connections window closes.

Note: If the connection fails, a message is displayed to help you correct the 
problem.

Information about available reports is automatically downloaded and appears in the 
library.
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Add a Server Connection for Android

When you first open the SAS Mobile BI for Android app, the only connection that is 
available is to the SAS Demo Server.

To access your corporate library server, you must add a connection to that server. If 
your company has more than one server, you can add additional connections in the 
same way.

Note: Contact your SAS Visual Analytics system administrator for your user ID, 
password, and server information.

Here are the steps to connect to a server:

1 If you are in My Portfolio, tap Library.

2 Tap the Connections icon in the library.

3 Tap Add Connections.

4 Tap the Server field, and enter the address of the new server. If the port is a 
nonstandard port, then you should enter the port number.

Note: If the server requires a secure (SSL) connection, type https:// at the beginning 
of the server address.

5 Tap the User ID field, and enter your user ID.

6 Tap the Password field, and enter your password.

7 Tap the Description field, and enter a description for the new connection.

8 On the keyboard, tap Done to verify the connection.

9 Tap OK. The connection is saved, the Connections window closes, and the library 
appears.
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Note: If the connection fails, the Extended Connection Properties window displays a 
message to help you correct the problem.
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Overview of Viewing Reports in SAS Visual Analytics Viewer 479

Opening a Report in the Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480
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Overview of Viewing Reports in SAS 
Visual Analytics Viewer

As an alternative to viewing reports on a mobile device, you can use the web viewer. 
For users with a Report Viewing role, the SAS Visual Analytics Viewer (the viewer) 
enables them to view report content.
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Opening a Report in the Viewer

To open a report in the viewer:

n Click on a report on the SAS Visual Analytics home page.

n Use the object inspector on the home page to view details about the report, and then 
click View. For more information about the object inspector, see “Discovering Details 
Using the Object Inspector on the Home Page” on page 21.

The layout of the tiles in the treemap is dependent on the size of the display area. This 
means that the same treemap might appear slightly different in the viewer than it does 
in SAS Visual Analytics Designer (the designer) or on a mobile device.
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Here is an example of a report in the viewer:

Display 41.1 A Report in the Viewer

If you have the Create Report capability, then you can select File  Edit Report in the 
current report. The designer is displayed, and then you can edit the report.
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Viewing Report Object Information

You can select a report object to display icons that provide more information about that 
report object. Depending on which type of report object you select, you might see the 
following icons:

Icon Description

Click to display the title of the report object.

Click to maximize the report object. This icon is displayed only if there is more 
than one report object being displayed.

Click to restore the report object to its original size. This icon is displayed only if 
you previously maximized the report object.

Click to display incoming filter information for a report object. This icon is displayed 
only if the data for the report object has been filtered as a result of selecting data 
in another report object.

Click to display the prompt dialog box for a stored process. This icon is displayed 
only for prompted stored processes. You can use the prompt dialog box to change 
prompt values for a stored process and to re-execute the stored process.

Adding Comments to a Report in the 
Viewer

If you have the Add Comments capability, then you can add or view comments. 
Comments can be added to a report or to an object within a report. The comments that 
you add are automatically saved with the report.

482 Chapter 41 / Viewing Reports in SAS Visual Analytics Viewer



To add a comment to a report or to an object within a report:

1 Expand the right pane. Click the Comments tab. (If you are adding a comment to a 
report object, then select the report object.)

2 Enter a topic name and a comment.

Here is an example:

Display 41.2 Adding Comments in SAS Visual Analytics Viewer

3 (Optional) Click  to attach a file or an image to your comment. There is no 
restriction on the file type or the size of the attachment.

4 Click Post to add your comment. Your comment is added to the Comments tab in 
the right pane.

To respond to an existing comment:

1 Expand the right pane. Click the Comments tab. Select an existing comment, and 
then enter a reply.

2 (Optional) Click  to attach a file or image to your reply.

3 Click Post. Your reply is added to the Comments tab in the right pane.

Note: To edit another user's comments or to delete comments, you must have the 
Comments:Administrator predefined role.
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To search for a comment:

1 Expand the right pane. Click the Comments tab. Enter the word or phrase that you 
want to search for in the Search within comments field on the Comments tab. 

2 (Optional) To clear the Search within comments field, click .

Interacting with Reports in the Viewer

Filtering, Brushing, and Drilling in Reports

Depending on the interactions that were defined by the report author, you might be able 
to interact with your report in the following ways:

filter
restricts the data that is returned from a query to a data source. Click on data in the 
source report object to filter data in the target report object (or objects). Clicking on 
different data applies the filter based on the new data. To clear the selection, click in 
the white space that surrounds the source report object.

brush
enables you to show the same data selected simultaneously in two or more tables, 
graphs, or both. Click on data in the source report object to brush data in the target 
report object (or objects). To clear the selection, click in the white space that 
surrounds the source report object.

drill down
enables you to move from summary information to more detailed data. If the data 
contains hierarchies, you can double-click on the data to drill down the hierarchy into 
detailed information. When you drill down the hierarchy, breadcrumbs at the top of 
the report object enable you to drill back up the hierarchy.
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Viewing Links in Reports

Report objects can link to other report objects, sections, or whole reports, or they can 
link to external links. To view a link from a report object, double-click on the report 
object. If there are multiple links from a report object, then a list appears that enables 
you to select a link. When you are viewing a link, the following buttons are displayed in 

the top left corner: .

If a report object that you are linking to shares a data source with the current report 
object, then the target report object is filtered based on the data value that you double-

clicked. If you do not want the target report object to be filtered, you can click , and 
deselect Apply link filters. If the data source is not shared between the two report 
objects, then no additional filtering takes place in the target report object.

To go back to the original report object, click  .
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Overview of Operators for Calculated 
Data Items

In the explorer and the designer, you can calculate data items by using expressions that 
contain operators. The operators that you can use are grouped into the following 
categories:

Numeric (simple) operators
perform basic mathematical operations such as addition and multiplication. See 
“Numeric (Simple) Operators” on page 490.
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Numeric (advanced) operators
perform advanced mathematical functions such as evaluating logarithms and 
truncating decimals. See “Numeric (Advanced) Operators” on page 493.

Boolean operators
evaluate whether a set of logical conditions is true. See “Boolean Operators” on 
page 492.

Comparison operators
evaluate how the values of your data items compare. See “Comparison Operators” 
on page 491.

Date and Time operators
convert values to, from, or between date and time formats. See “Date and Time 
Operators” on page 495.

Text operators
evaluate text values. See “Text Operators” on page 498.

Aggregated operators (aggregated measures only)
calculate aggregations for aggregated measures. See “Aggregated Operators” on 
page 497.

Numeric (Simple) Operators

-x
returns a value with the opposite sign of the input value.

For example, -1 returns 1 and 1 returns -1.

x - y
subtracts the second value from the first value.

For example, (2,1) returns 1.

x * y
multiplies the first and second values together.

490 Appendix 1 / Operators for Calculated Data Items



For example, (2,3) returns 6.

x / y
divides the first value by the second value.

For example, (6,2) returns 3.

x + y
adds the first and second values together.

For example, (1,2) returns 3.

Comparison Operators

Between
returns true if the first value is between the second and third values (inclusive).

For example, (X, 50, 100) returns true if X is between 50 and 100.

In
returns true if the first value is in the list specified by the second parameter. To 
select your list, assign a data item to the first parameter, and then choose the values 
from the drop-down list.

For example, X In (1,2,3) returns true when the value of X is either 1, 2, or 3.

Note: This operator cannot be used to compare measures.

Missing
returns true if the value is a missing value.

NotIn
returns true if the first value is not in the list specified by the second parameter. To 
select your list, assign a data item to the first parameter, and then choose the values 
from the drop-down list.

For example, X NotIn (1,2,3) returns true when the value of X is not 1, 2, or 3.

Note: This operator cannot be used to compare measures.
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NotMissing
returns true if the value is not a missing value.

x < y
returns true if the first value is less than the second value.

x <= y
returns true if the first value is less than or equal to the second value.

x <> y
returns true if the first value is not equal to the second value.

x = y
returns true if the first value is equal to the second value.

x > y
returns true if the first value is greater than the second value.

x >= y
returns true if the first value is greater than or equal to the second value.

Boolean Operators

AND
joins two conditions and returns true if both conditions are true.

For example,

(1 = 1) AND (2 = 2)

returns true, and

(1 = 1) AND (2 = 1)

returns false.

IF... ELSE
returns different values, depending on whether the condition is true. The first 
parameter specifies the condition. The second parameter specifies the value to 
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return if the condition is true. The third parameter specifies the value to return if the 
condition is false.

For example,

if (X > Y) return X else Y

returns the value of X if X is greater than Y, but returns the value of Y otherwise.

NOT
returns true if the condition is false.

For example, not (1 = 2) returns true.

OR
joins two conditions and returns true if either condition is true.

For example,

(1 = 1) OR (2 = 2)

returns true, and

(1 = 1) OR (2 = 1)

returns true.

Numeric (Advanced) Operators

|x|
returns the absolute value of the input value.

For example, -3 returns 3.

Ceil
rounds the input value up to the nearest integer.

For example, 4.2 returns 5 and -4.8 returns -4.

Exp
raises the constant e to the power specified by the input value.
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For example, 5 returns e to the 5th power (148.41).

Floor
rounds the input value down to the nearest integer.

For example, 4.8 returns 4 and -4.2 returns -5.

Ln
returns the natural logarithm (base e) of the input value.

For example, 10 returns the eth root of 10 (2.30...).

Log
returns the logarithm of the first value, where the second value specifies the base.

For example, (64, 8) returns the base 8 logarithm of 64 (2).

Mod
returns the remainder after dividing the first value by the second value.

For example, (5,2) returns 1.

Power
raises the first value to the power of the second value.

For example, (5,2) returns 5 to the 2nd power (25).

Root
returns the nth root of the first value, where the second value specifies n (the base of 
the root).

For example, (27,3) returns the 3rd (cube) root of 27 (3).

Round
rounds the first value to the number of decimal places that is specified by the second 
value. Selects the second value from the drop-down list.

For example, (7.354, 2) returns 7.35.

Note: If you select 0 decimal places, then the values are rounded to the nearest 
integer.
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Trunc
truncates the input value to an integer.

For example, 8.9 returns 8 and -8.9 returns -8.

Date and Time Operators

DateFromMDY
creates a date value from separate month, day, and year values. The first value 
specifies the month as a number between 1–12. The second value specifies the day 
as a number between 1–31. The third value specifies the year as a four-digit 
number.

For example, (1,15,2013) returns 15JAN2013.

DateFromYQ
creates a date value from separate year and quarter values. The first value specifies 
the year as a four-digit number. The second value specifies the quarter as a number 
between 1–4.

For example, (2013,1) returns 01JAN2013.

Note: The date is generated using the first day of each quarter.

DatePart
converts a datetime value to a date value.

For example, January 15, 2013 05:15 PM returns 15JAN2013.

DateTimeFromDateHMS
creates a datetime value from a date value and separate hour, minute, and second 
values. The first value specifies the date. The second value specifies the hour as a 
number between 0–23. The third value specifies the minute as a number between 
0–59. The fourth value specifies the second as a number between 0–59.

For example, (15JAN2013, 17, 15, 23) returns January 15, 2013 05:15:23 PM
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DateTimeFromTimeMDY
creates a datetime value from a time value and separate month, day, and year 
values. The first value specifies the time. The second value specifies the month as a 
number between 1–12. The third value specifies the day as a number between 1–
31. The fourth value specifies the year as a four-digit number.

For example, (05:15:23 PM, 1, 15, 2013) returns January 15, 2013 05:15:23 PM.

DayOfMonth
returns the day of the month from a date value as a number between 1–31.

For example, 15JAN2013 returns 15.

DayOfWeek
returns the day of the week from a date value as a number between 1–7 (1 is 
Sunday.)

For example, 15JAN2013 returns 3 (Tuesday.)

DayOfYear
returns the day of the year from a date value as a number between 1–366.

For example, 15FEB2013 returns 46.

Hour
returns the hour from a time or datetime value as a number between 0–23.

For example, 05:15:23 PM returns 17.

Minute
returns the minute from a time or datetime value as a number between 0–59.

For example, 05:15:23 PM returns 15.

Month
returns the month from a date value as a number between 1–12.

For example, 15JAN2013 returns 1.

Now
creates a datetime value from the current date and time.
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Quarter
returns the quarter from a date value as a number between 1–4.

For example, 15AUG2013 returns 3.

Second
returns the second from a time or datetime value as a number between 0–59.

For example, 05:15:23 PM returns 23.

TimeFromHMS
creates a time value from separate hour, minute, and second values. The first value 
specifies the hour as a number between 0–23. The second value specifies the 
minute as a number between 0–59. The third value specifies the second as a 
number between 0–59.

For example, (17,15,23) returns 05:15:23 PM.

TimePart
converts a datetime value to a time value.

For example, January 15, 2013 05:15:23 PM returns 05:15:23 PM.

WeekNumber
returns the week of the year as a number between 1–53, where week 2 begins on 
the second Sunday of the year.

For example, 04AUG2013 returns 31.

Year
returns the year from a date value as a four-digit number.

For example, 15JAN2013 returns 2013.

Aggregated Operators

Avg
calculates the average value for a measure.
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Count
calculates the total number of values for a category.

Distinct
calculates the number of distinct values for a category.

Max
calculates the greatest value for a measure.

Min
calculates the least value for a measure.

Sum
calculates the sum of the values for a measure.

Text Operators

Note: Text operators are not case sensitive.

Contains
specifies that a matching value must contain the filter value.

EndsWith
specifies that a matching value must contain the filter value at the end of the value.

NotContains
specifies that a matching value must not contain the filter value.

StartsWith
specifies that a matching value must contain the filter value at the start of the value.
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Appendix 2
Conditions and Operators for Filters

In SAS Visual Analytics, filters are based on expressions that contain conditions and 
operators. Depending on the type of data that is used by the filter, you can select from 
the following categories of filter conditions and operators:

Table A2.1 Conditions for Character Data

= Specifies that a matching value must match one of the filter 
values exactly.
Note: The match for this condition is case sensitive.

Contains Specifies that a matching value must contain the filter value.

EndsWith Specifies that a matching value must contain the filter value at 
the end of the value.

In Specifies that a matching value is in the list that you select. To 
select your list, choose the values from the drop-down list.

Missing Specifies that a missing value matches the filter.

NotContains Specifies that a matching value must not contain the filter value.

NotIn Specifies that a matching value is not in the list that you select. 
To select your list, choose the values from the drop-down list.

NotMissing Specifies that a nonmissing value matches the filter.

StartsWith Specifies that a matching value must contain the filter value at 
the start of the value.
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Table A2.2 Conditions for Continuous Numeric Data and Date and Time Data

<> Specifies that a matching value must not be equal to the filter 
value.

= Specifies that a matching value must be equal to the filter value.

< Specifies that a matching value must be less than the filter value.

<= Specifies that a matching value must be less than or equal to the 
filter value.

> Specifies that a matching value must be greater than the filter 
value.

>= Specifies that a matching value must be greater than or equal to 
the filter value.

Between Specifies that a matching value must be greater than or equal to 
the first filter value and less than or equal to the second filter 
value.

Missing Specifies that a missing value matches the filter.

NotMissing Specifies that a nonmissing value matches the filter.

Table A2.3 Conditions for Discrete Numeric Data and Date and Time Data

<> Specifies that a matching value must not be equal to the filter 
value.

= Specifies that a matching value must be equal to the filter value.

< Specifies that a matching value must be less than the filter value.

<= Specifies that a matching value must be less than or equal to the 
filter value.

> Specifies that a matching value must be greater than the filter 
value.
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>= Specifies that a matching value must be greater than or equal to 
the filter value.

Between Specifies that a matching value must be greater than or equal to 
the first filter value and less than or equal to the second filter 
value.

In Specifies that a matching value is in the list that you select. To 
select your list, choose the values from the drop-down list.

NotIn Specifies that a matching value is not in the list that you select. 
To select your list, choose the values from the drop-down list.

Missing Specifies that a missing value matches the filter.

NotMissing Specifies that a nonmissing value matches the filter.

Table A2.4 Operators for All Data Types

AND Joins two or more conditions and specifies that a matching value 
must match all of the conditions.

NOT Specifies that a matching value must not match the expression 
that follows NOT.

OR Joins two or more conditions and specifies that a matching value 
must match at least one of the conditions.
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Appendix 3
Data Limits

Data Limits for SAS Visual Analytics Explorer . . . . . . . . . . . . . . . . . . . . 503

High-Cardinality Thresholds for Report Objects . . . . . . . . . . . . . . . . . 507

Data Limits for SAS Visual Analytics 
Explorer

Some of the visualizations in SAS Visual Analytics Explorer (the explorer) have limits to 
the number of data values that they can display. The limit values are affected by the 
Visualization data threshold setting in the Preferences window. For more information 
about the Preferences window, see “Specify Preferences That Are Specific to SAS 
Visual Analytics Explorer” on page 127.

The following table displays the data limits for visualizations in the explorer:

Table A3.1 Data Limits for the Explorer

Visualization 
Type Variation

Behavior 
when Limit 
Is Exceeded

Default 
Threshold

Minimum 
Threshold

Maximum 
Threshold

Table — For sorted 
tables only, 
paging is 
applied to the 
table.

10,000 1,000 100,000
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Visualization 
Type Variation

Behavior 
when Limit 
Is Exceeded

Default 
Threshold

Minimum 
Threshold

Maximum 
Threshold

Crosstab — An error 
message 
appears.

41,000 9,500 50,000

Bar Chart Not grouped 
or latticed.

The bar chart 
shows a 
subset that 
contains the 
first or last 
ranked 
values.

3,000 810 3,625

Grouped or 
latticed.

An error 
message 
appears.

3,000 810 3,625

Line Chart Single 
numeric or 
datetime 
category in 
the Category 
role.

The line chart 
shows a 
subset that 
contains the 
first or last 
ranked value.

10,000 5,630 11,250

Single string 
category in 
the Category 
role.

4,000 1,380 4,750

No string 
categories in 
the Category 
role, grouped 
or latticed.

An error 
message 
appears.

10,000 5,630 11,250

One or more 
string 
categories in 
the Category 
role, grouped 
or latticed.

4,000 1,380 4,750
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Visualization 
Type Variation

Behavior 
when Limit 
Is Exceeded

Default 
Threshold

Minimum 
Threshold

Maximum 
Threshold

Scatter Plot Two 
measures, 
not grouped.

The scatter 
plot is 
converted to 
a heat map.

40,000 9,375 48,750

Two 
measures, 
grouped.

An error 
message 
appears.

40,000 9,375 48,750

Three or 
more 
measures, 
not grouped.

The scatter 
plot is 
converted to 
a correlation 
matrix.

80,000 / 
number of 
measures

18,750 / 
number of 
measures

97,500 / 
number of 
measures

Three or 
more 
measures, 
grouped.

An error 
message 
appears.

80,000 / 
number of 
measures

18,750 / 
number of 
measures

97,500 / 
number of 
measures

Bubble Plot No 
categories.

An error 
message 
appears.

25,000 7,500 30,000

Grouped. The bubble 
plot shows 
the top or 
bottom value 
by size.

500 150 600

Latticed. An error 
message 
appears.

1,050 4,900 50,000

Grouped and 
latticed.

500 150 600

Animated. 50,000 15,000 60,000

Histogram — — None None None

Box Plot — An error 
message 
appears.

2,900 boxes 800 boxes 3,500 boxes
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Visualization 
Type Variation

Behavior 
when Limit 
Is Exceeded

Default 
Threshold

Minimum 
Threshold

Maximum 
Threshold

Heat Map No 
categories.

— None None None

One or more 
categories.

An error 
message 
appears.

3,000 1,250 3,500

Geo Map — An error 
message 
appears.

5,000 1,500 6,000

Treemap No additional 
levels.

The treemap 
shows a 
subset that 
contains the 
first or last 
ranked value.

4,900 1,050 6,000

One or more 
additional 
levels.

The number 
of additional 
levels is 
reduced to 0. 
If the 
threshold is 
still 
exceeded, 
then the 
treemap 
shows a 
subset that 
contains the 
first or last 
ranked value.

4,900 1,050 6,000

Correlation 
Matrix

— 60 measures
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Visualization 
Type Variation

Behavior 
when Limit 
Is Exceeded

Default 
Threshold

Minimum 
Threshold

Maximum 
Threshold

Decision 
Tree

Number of 
nodes.

An error 
message 
appears.

180 75 200

Number of 
target values.

The decision 
tree displays 
truncated 
data.

50 30 50

Number of 
predictor 
values.

An error 
message 
appears.

4300 1500 5000

In addition to the data thresholds that are set by the Preferences window, there are 
server data limits that can be set by the system administrator. For information about the 
server data limits, see the topic “Manage High-Cardinality Data” in the SAS Visual 
Analytics: Administration Guide.

High-Cardinality Thresholds for Report 
Objects

Client-side thresholds for report objects are documented in the following table. These 
thresholds affect the designer and all of the viewers. The second column indicates the 
maximum number of unique values.

Table A3.2 Client-Side Thresholds for Report Objects

Report Object Rows

Gauges (bullets, sliders, thermometers, dials, and speedometers) 10

Bubble plots 1,500

Bar charts (regular, targeted, dual axis, and dual axis bar-line) 3,000
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Report Object Rows

Waterfall charts 3,000

Scatter plots 3,000

Line charts (regular and dual axis line) 4,000

Time series plots (regular and dual axis) 10,000

Treemaps 25,000

Pie charts 40,000

Tables (list tables and crosstabs) 40,000

In general, requests that exceed a client-side report object threshold cause an error 
message to be displayed. An exception is that for detail data, excess rows are 
truncated.

Note: Scatter plots always show detail data. List tables show details if the user selects 
the Show detail data check box. Bubble plots show details unless a category is 
assigned to the group role.

Note: If a data source contains more than a million records, queries are blocked for 
data items whose cardinality is greater than 10,000 unique items in any particular 
category.
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Appendix 4
Troubleshooting in SAS Visual 
Analytics Designer

Issue: The Repair Report window is displayed.

Resolution:

When you open a report in the designer, you might be prompted to repair the report. For 
example, this can happen when one or more columns have been removed from the 
data source. You might be prompted to repair the report when you refresh a report or 
change a data source. You might be prompted to repair a report if your system 
administrator is still deciding which data items should be in a table.

To repair a report:

1 Decide whether you want to fix individual data items or all of the data items in the 
report.

Fixes can be made at the individual data item level. For example, if two data items 
are removed from a report, then the Repair Report window displays separate entries 
for each data item. The report objects that are impacted by each data item appear 
below each of the data items.
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Here is an example of the Repair Report window that is displayed when a missing 
column affects two report objects:

Display A4.1 Repair Report Window

2 Select the report objects that you want to fix, and then click Fix All.

3 Click Close in the confirmation message that is displayed.
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Glossary

Apache Hadoop
a framework that allows for the distributed processing of large data sets across 
clusters of computers using a simple programming model.

bar chart
a chart that consists of a grid and some vertical or horizontal columns (bars). Each 
column represents quantitative data.

bar-line chart
a bar chart with an overlaid line graph.

box plot
a graphical display of five statistics (the minimum, lower quartile, median, upper 
quartile, and maximum) that summarize the distribution of a set of data. The lower 
quartile (25th percentile) is represented by the lower edge of the box, and the upper 
quartile (75th percentile) is represented by the upper edge of the box. The median 
(50th percentile) is represented by a central line that divides the box into sections. 
The extreme values are represented by whiskers that extend out from the edges of 
the box.

calculated column
a column that does not exist in any of the tables that are accessed, but which is 
created as a result of a column expression.

capability
an application feature that is under role-based management. Typically, a capability 
corresponds to a menu item or button. For example, a Report Creation capability 
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might correspond to a New Report menu item in a reporting application. Capabilities 
are assigned to roles.

choropleth map
a two-dimensional map that uses color and fill pattern combinations to represent 
different categories or levels of magnitude.

co-located data provider
a distributed data source, such as SAS Visual Analytics Hadoop or a third-party 
vendor database, that has SAS High-Performance Analytics software installed on 
the same machines. The SAS software on each machine processes the data that is 
local to the machine or that the data source makes available as the result of a query.

crosstab
a two-dimensional table that shows frequency distributions or other aggregate 
statistics for the intersections of two or more category data items. In a 
crosstabulation table, categories are displayed on both the columns and rows, and 
each cell value represents the data result from the intersection of the categories on 
the specific row and column.

data item
an item in a data source that is either a logical view of a data field or a calculation. 
The author of a report decides which data items to use in a particular section of a 
report. There are three types of data items: hierarchies, categories, and measures.

data source
a table, view, or file from which you will extract information. Sources can be in any 
format that SAS can access, on any supported hardware platform. The metadata for 
a source is typically an input to a job.

dependency
a trigger condition that must be met before a job can run in a scheduled flow.

deployed job
a job that has been saved in a deployment directory and can be scheduled.
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deployment directory
the location for generated SAS DATA step programs that will be executed by the 
batch server as part of a scheduled flow.

file event
a file-related occurrence that is used as a trigger in a scheduled flow. For example, a 
file event occurs when a scheduling server determines that a specified file exists.

filter
specified criteria that are applied to data in order to identify the subset of data for a 
subsequent operation, such as continued processing.

flow
a set of jobs and associated dependencies that is scheduled in the Schedule 
Manager plug-in in SAS Management Console.

heat map
a graphical representation of data where the values taken by a variable in a two-
dimensional map are represented as colors.

job
a collection of SAS tasks that can create output.

job event
a job-related occurrence that is used as a trigger in a scheduled flow. For example, a 
job event occurs when the scheduling server issues a command to determine 
whether a job ran successfully.

job flow
a group of jobs and their dependencies, including dependencies on other jobs, on 
files, or on specified dates and times.

join condition
a combination of join keys and a comparison operator.
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list table
a two-dimensional representation of data, in which the data values are arranged in 
rows and columns.

local data
data that is accessible through the file systems on a computer. This includes data on 
hard drives or available through network file systems.

pie chart
a circular chart that is divided into slices by radial lines. Each slice represents the 
relative contribution of each part to the whole.

query
a set of instructions that requests particular information from one or more data 
sources.

remote data
data that is not accessible through the file systems available to a computer. To use 
remote data, you must direct a SAS server to access the data that is available 
through file systems on the remote machine.

report
output that is generated by running custom SAS code against the data in your 
project.

role
a set of capabilities within an application that are targeted to a particular group of 
users.

SAS Management Console
a Java application that provides a single user interface for performing SAS 
administrative tasks.
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scatter plot
a two- or three-dimensional plot that shows the joint variation of two (or three) 
variables from a group of table rows. The coordinates of each point in the plot 
correspond to the data values for a single table row (observation).

scatter plot matrix
a grid of scatter plots showing pairwise combinations of multiple numeric variables.

scheduling server
a server that runs deployed jobs in a scheduled flow. Before running a job, the 
scheduling server determines when the schedule for the deployed job as well as all 
of the dependencies for the job have been met.

source
See data source

subquery
a query-expression that is nested as part of another query-expression. Depending 
on the clause that contains it, a subquery can return a single value or multiple 
values.

time series
an ordered sequence of values of a variable that are observed at equally spaced 
time intervals.

user role
See role

visual exploration
a metadata object that contains visualizations and data settings that are saved from 
a session of SAS Visual Analytics Explorer.

visualization
an interactive visual representation of data. A visualization can be a table, a chart, or 
a geographic map.

Repairing Reports 515



waterfall chart
a form of data visualization that is used to understand or explain the cumulative 
effect on an initial value of sequentially introduced positive or negative values. 
Usually, the initial and the final values are represented by whole columns, and the 
intermediate values are denoted by floating columns.
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Index

A

adding columns
SAS Visual Data Builder 47, 

62
adding comments

in the designer 345
advanced report filters 417
aggregate measure data items

355
aggregated measures 144

adding 382
distinct count 364
percentage of total 365

aggregations 135, 370
adding to multiple columns 67
SAS Visual Data Builder 66

alphanumeric categories 356
autocharting 186
automatic charts 186

B

bar charts 187, 310
basic report filters 412
box plots 204
brush 484
bubble plots 199, 315

bullet gauges 321
button bar control 328

C

calculated column
SAS Visual Data Builder 65

calculated data items 142, 356, 
379, 489

adding 379
deleting 374
duplicating 362
editing 384

capabilities 7, 15
category data items 356

distinct counts 364
sort options 373

changing data sources 353
charts

See also bar charts
dual axis bar charts 316
dual axis bar-line charts 317
dual axis line charts 316
line charts 312
pie charts 313
targeted bar 311
waterfall charts 311

collections 23
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color gradients 181
column expression

SAS Visual Data Builder 65
comments

for explorations 130, 482
for reports 345, 482
for visualizations 175

connecting to library server
Android 477
iPad 475

controls 327
button bar 328
creating section prompts 330
drop-down list 327
inserting 329
list 328
properties 330
range slider 328
styles 331
text input 328

correlation matrix 214
creating reports 288
crosstabs 195, 303

exporting data from 468
percentage of subtotals 308
percentage of total 308
sorting data in 392

CSV files 91
custom geography data items

366

D

data

exporting from crosstabs 468
self-service 91

data brushing 183
data formats 135
data item filter 421

creating 422
deleting 432
editing 428
replacing 426

data items
aggregate measures 355
calculated 356, 379
category 356
date time 357
deleting 374
distinct count 364
duplicating 362
filtering 421
geography 357, 366
grouping 362
hiding 385
hierarchy 357, 376
in a report 355
measure data items 357
modifying format 369
modifying role 368
queries based on 350
renaming 360, 368
searching for 361
selecting 358
showing 385

data properties 135
data roles

modifying in report objects
386
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removing from report objects
388

data source filters 239
data sources

changing 353
measure details 385
modifying measure 

aggregation 370
refreshing 352
removing 353
SAS Visual Data Builder 48
selecting 351

date category data items 357
datetime category data items

357
decision tree 216
default view for reports

preference 282
deleting

data item filter 432
data items 374
data source 353
hierarchies 378
interactions 447
report sections 463

derived data items 148
dial gauges 323
display rules 395

gauges 408
graph level 406
report level 396
table level 398

distinct counts 148, 364
drill 484
drop-down list control 327

dual axis bar chart 316
dual axis bar-line charts 317
dual axis line chart 316
dual axis time series plot 317
duplicate data items 154, 362
duplicate report objects 344

E

e-mailing
a report 295
a visual exploration 253

exporting 465
data from crosstabs 468
data from visualizations 252
graph data 470
list table data 466
PDF output 250
report data 466
report objects 466

F

filter 484
filter controls 327
filtering

continuous data 228
discrete data 227

filters 224, 411, 433
filters, advanced 231, 417

creating 232, 417
deleting 421
editing 234, 419
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filters, basic 225, 412
creating 226, 413
deleting 416
editing 229
editting 415
visual filter controls 227

filters, data item 421
creating 422
deleting 432
editing 428
replacing 426

filters, data source 239
creating 240
editing 242

formats
modifying for data items 369
modifying user-defined 370

full-screen view 288

G

gauges
bullet 321
dial 323
display rules 408
inserting into a report 324
properties 325
slider 322
speedometer 324
styles 326
thermometer 323

general preferences 17
geo bubble maps 332

displaying in reports 332

inserting into a report 337
properties 342
styles 343

geo maps 210
geo region maps 333

inserting into a report 337
properties 342
styles 343

geography data items 154, 
357, 366

global preferences 16
graph types 310
graph-level display rules 406
graphs

See also charts
bubble plots 315
displaying results 310
exporting data from 470
inserting into a report 318
pie charts 313
properties 319
scatter plots 314
styles 321
time series plots 314
treemaps 315

group by variables
SAS Visual Data Builder 69

grouping
data items on Data tab 362

H

heat maps 207
hiding data items 385
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hierarchies 376
creating 256, 376
deleting 378
editing 377
from date and time items 257

hierarchy data items 357
histograms 203
home page

adding comments 25
collections 23
first look 12
managing content 20
object inspector 21
refining search results 31
searching 29
thumbnails 14

horizontal containers 332
displaying 332
inserting 337
properties 341

I

image files, exporting as 251
images 332

displaying in reports 332
inserting into a report 334
properties 338

import data
SAS Visual Data Builder 91

importing
report objects 292
reports 292

information maps

about 97
limitations and restrictions 98

initial screen preference 18
interactions 433, 434

data brushing 433, 441
deleting 447
filter 433
filters 434

interface 12
designer 271
home page 12

J

jobs
SAS Data Integration Studio

112
joins 49, 80

automatic 78
automatic join feature 78
explicit 78
maximum number of tables

77
sequence 82

K

KPI chart
See gauges

L

layouts
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See report layouts
libraries 49
line charts 190, 312
links 449

deleting 453
to a section 451
to an external URL 452
to another report 449
viewing 485

list control 328
list tables 303

exporting data from 466
sorting data in 392
sparklines 307

logging off 9
logging on 8

M

managing
collections 23
content 20

measure data items 357
measures

details 385
modifying aggregation of 370
percentage of total 365

metadata view for stored 
process 340

Microsoft Excel
exporting data 465
import spreadsheets 91

missing values, excluding 228
mobile devices

connecting to library server
475, 477

opening the app 475
mobile viewer 475
modifying data item role 368

O

object inspector 21
adding comments 25
using 21

object inventory list 290
opening

mobile viewer 475
reports 283

operators
for calculated items 489

P

partitioning tables
ORDERBY= option 87

passwords 9
PDF, exporting as 250
percentage of subtotals

for reports 308
percentage of total 365

for reports 308
pie charts 313
pivot by 70
plots

bubble plots 315
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dual axis time series plots
317

scatter plots 314
time series plots 314

precision layout 291
preferences 16, 43, 281

default view for reports 282
for the designer 281
general 17
global 16
home page 18
initial screen 18
report theme 282
SAS Visual Data Builder 43

printing reports 296
properties

controls 330
gauges 325
geo bubble maps 342
geo region maps 342
graphs 319
horizontal containers 341
images 338
reports 290
stored process 339
tables 305
text 338
vertical containers 341

Q

queries
based on data items 350

R

range slider control 328
ranks

adding to reports 456
deleting from reports 459
for reports 455
for visualizations 179

redo history 46
refreshing data sources 352
removing columns

SAS Visual Data Builder 64
removing data sources 353
renaming

data items 360, 368
report sections 462

report data
exporting 466

report filters 411
report layouts

precision 291
tiled 291

report objects 300
controls 327
duplicating 344
exporting 466
gauges 321
graphs 310
other 332
tables 303
viewing information about 482

report sections 461
adding 461
deleting 463
renaming 462
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report themes 279
preference 282
selecting 279

report views 288
full screen 288
tablet 288
wide-screen tablet 288

report-level display rules 396
reports 287

adding comments 25
adding sections 461
basing on existing report 292
creating 288
creating a new hierarchy 376
deleting sections 463
display rules 395
e-mailing 295
hierarchies 376
horizontal containers 337
importing 292
inserting gauges 324
inserting geo maps 337
inserting geo region maps

337
inserting graphs 318
inserting images 334
inserting stored processes

336
inserting tables 304
inserting text 334
layout 291
modifying data roles 386
naming 294
opening 276, 283
printing 296

properties 290
removing data roles 388
saving 294
searching for 278
specify description 290
vertical containers 337
view title 290
viewing 480
views 288

results
displaying in gauges 321
displaying in graphs 310
displaying in tables 303

roles 7
data 386
data item, modifying 368
user 15

S

SAS data sets 91
SAS Visual Analytics 3

benefits of 4
capabilities 7
home page 12
how it works 4
logging off 9
logging on 8
preferences 17
roles 7

SAS Visual Data Builder
preferences 43

saved reports 283
saving reports 294
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scatter plots 197, 314
scheduling

queries 105
searching 29

for data items 361
from the home page 29
in the designer 278
refining search results 31

selecting
data items 358
data sources 351

showing data items 385
slider gauges 322
sorting 391

data in crosstabs 392
data in graphs 393
data in list tables 392
data items on Data tab 362

sparkline 307
speedometer gauges 324
stored processes 332

displaying in reports 332
inserting into a report 336
metadata view 340
properties 339

styles
controls 331
gauges 326
geo bubble maps 343
geo region maps 343
graphs 321
tables 307

subquery
joining 49

T

table types 303
table-level display rules 398

using a color-mapped value
404

using a gauge 401
using an expression 399

tables 194
See also crosstabs
inserting into a report 304
joining 49
list tables 303
properties 305
styles 307

tablet view 288
targeted bar chart 311
text 332

displaying in reports 332
inserting into a report 334
properties 338

text input control 328
thermometer gauges 323
thumbnails 14
tiled layout 291
time category data items 357
time series plot 314
totals

See percentage of total
treemaps 212, 315

U

undo history 46
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user interface 12
designer 271
home page 12

user-defined formats
modifying 370

V

vertical containers 332
displaying 332
inserting 337
properties 341

viewer
adding comments 482
brushing 484
drilling 484
filtering 484
opening reports 480

overview 479
viewing links 485

views
full-screen 288
tablet 288
wide-screen tablet 288

visualizations 160
arranging 169
creating 168
data limits 503
managing 168
overview 160
types of 160

W

waterfall charts 311
wide-screen tablet view 288
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